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1 Welcome 

MAXQDA 11 is a high-performance program for professional social science-oriented data 

analysis, ideal for researchers from social sciences, education, economics, and many others, 

who work with and analyze text in their professional capacities. 

MAXQDA 11 is the result of more than 20 years of continuous development: MAX for DOS 

was released in 1989, winMAX for Windows came out in 1994, and the first version of 

MAXQDA was released in 2001. The current version, MAXQDA 11, builds on this tradition. 

When MAXQDA 1 came out in 2001, it was a completely new program that didn’t adopt a 

single line of code from the previous version winMAX. The new version was immediately 

accessible to users of the former version, though, because it was based on the same basic 

ideas, concepts, and handling as the older version. 

MAXQDA 11 is a further developed version of MAXQDA 10 – it contains many changes, 

both small and large. An overview of these changes and improvements can be found on 

the website at www.maxqda.com. 

This handbook gives a detailed overview of all functions of MAXQDA. The short introduc-

tion, also available in the MAXQDA help menu, is a good way to get a more general intro-

duction to the program. 

This handbook is not designed as a quick introduction, but rather systematically explains all 

functions and features of the program. It is also not set up to follow the logic of learning 

the program. 

MAXQDA conferences, titled “CAQD – Conference on Computer-Aided Qualitative Data 

Analysis,” are held annually in Marburg, Germany. More information on past and upcom-

ing conferences can be found on the website www.caqd.org. 

Attached to this handbook, you will find tips for troubleshooting possible problems that 

arise. There you will find information about the technical details and limits of MAXQDA. 

There is also an internet support available to all registered users that have questions regard-

ing the use of the software: www.maxqda.com. 

If you find any bugs or experience other problems with specific functions of the software, 

please don’t hesitate to contact support. We are dedicated to constantly improving and 

updating the software, which is partially dependent on feedback from our users. If you are 

interested in staying abreast of the newest developments and program updates, keep 

checking back on the MAXQDA website: www.maxqda.com. 

http://m22.maxqda.de/
http://www.caqd.org/
http://m22.maxqda.de/
http://m22.maxqda.de/
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2 MAXQDA Screens and Menus 

2.1 Starting the Program  

After opening MAXQDA, a window will appear with the MAXQDA logo and then the fol-

lowing welcome dialogue: 

 

The quick introduction to MAXQDA: direct access to online tutorials, help, sample projects 

MAXQDA Online tutorials – opens the overview of the online tutorials on the MAXQDA 

website (Internet connection required!). 

MAXQDA Video tutorials – opens the overview of the video tutorials on the MAXQDA 

website (Internet connection required!). 

MAXQDA Introduction – opens a PDF file that clearly explains all the basic functions of 

MAXQDA. 

MAXQDA Help – opens the Help file that you can browse and use as a reference for indi-

vidual functions. 

Open Examples – lists the example projects included in the installation of MAXQDA, al-

lowing you to explore the features of MAXQDA in detail. First click on a project from the 

list, and then click OK to open the selected sample project. 
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The MAXQDA start window: choose user name and projects 

You can enter your name or initials in the user field, so that all of your actions, whether 

they be importing documents, coding segments, or writing memos, are marked with your 

user signature. This user system is especially helpful when you are working in a team. You 

can then look to see who in the team did each action. 

To create and open a new project, click OK. Otherwise select Open Existing Project. In 

the bottom pane select a recent project, or click on OK to open another project. 

Important: It is strongly recommended that you regularly create project backups and save 

them on external hard drives or flash drives, in order to minimize losses in case of computer 

problems. 

Project files from MAXQDA 11 have the extension MX5. If your computer system hides file 

extensions, you can identify data by the MAXQDA symbol and by the file type “MAXQDA 

11 – files.” You can now enter your data including interview transcripts, reports as PDF files 

or video clips, as well as import documents into the created or opened project. 

Note: MAXQDA 11 is reverse compatible and partially forward compatible, meaning pro-

jects can be imported and saved from previous versions and MAXQDA 11 projects can be 

saved as MAXQDA 10 projects. 
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2.2 The MAXQDA Interface and the Four Main Windows 

After opening or creating a new project, you will see the MAXQDA interface, which is de-

signed similar to many other Windows programs: 

 At the very top of the screen, you will see the project document name including the 

location where it is saved. 

 Underneath the file name, you will see the drop-down menus and various toolbars with 

buttons that offer quick access to frequently-used functions. 

 A status bar is found at the bottom of the screen. 

MAXQDA's four main windows occupy the main part of the workspace: 

 

The four main MAXQDA windows 

The four windows have the following functions: 

 The “Document System” provides an overview of all the texts, pictures and media files 

of your project. You also have the option of organizing these documents in document 

groups, which act as folders. 

 The “Code System” displays all the codes and subcodes and code memos that you have 

created along with the number of times each of the codes has been used. 

 The “Document Browser” displays one of the documents from the “Document Sys-

tem,” where it can then be worked on. You can highlight, edit, code, create links, or at-

tach memos in this window. Geo-Links are also displayed in the Document Browser. 

 The “Retrieved Segments” window is a results window. Here you can display a selection 

of coded segments (Retrieval). 

Small Toolbars in the Windows 

Each window has a toolbar, which gives you quick access to frequently-used functions. By 

hovering over each symbol, you can see what each symbol does. Symbols that are found in 

more than one toolbar always have the same function, such as: 
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  prints out the content of the window 

  exports the content of the window 

  allows for context search in associated window 

  undocks the window 

  maximizes the window to the largest possible size 

  closes the window 

 

Small toolbar within a window 

Hide and Show Main Windows 

All four windows can be shown or hidden in various ways so that you can control the ar-

rangement of windows on your screen and optimize your work space. 

1. You can hide or show the windows through the drop-down menu. 

 

Hide and show four main windows in the menu 

2. You can hide or show the windows by clicking on the appropriate icons in the 

“MAXQDA standard” toolbar: . 

3. You can close the windows by clicking on the appropriate icon  in the upper-right 

hand corner of each window. Next to the close icon, you also have the option of clicking 

to maximize the window to its largest possible size. 

Note: You can hide or show all windows, but at least one window must be shown at all 

times, which means it isn’t possible to close all four windows. 
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Optimize interface: Customize Window Width 

The optimal setup of your windows in MAXQDA 11 depends largely on the size of your 

monitor and the set resolution. It is not recommended that you use a resolution smaller 

than 1024 x 768. 

The size of each window in comparison to the others can be adjusted as you wish by click-

ing with the left mouse button on a border and dragging it in the appropriate direction. 

 

Window height and width can be adjusted by clicking and dragging borders with the mouse  

Optimize Interface: Customize Coding Columns 

The “Document Browser” window includes the coding column, a gray area left (or right) of 

the text document in which codes are displayed. To adjust the width of the coding column, 

move the mouse pointer to the top of the line separating it from the document, press the 

left mouse button, and drag the column to the left (or right) side of the text. 

 

Adjusting the width of the coding column 

You can choose whether or not to display the names of each code by clicking on an empty 

spot in the coding column and right-clicking. A window will then appear that allows you to 

change this setting. 
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Optimize Interface: The Two-Column and Three-Column Layout 

By default, MAXQDA 11 uses a three-column layout that takes advantage of the wide-

screen format of modern monitors better than the traditional four-window layout, which 

has long been a characteristic of MAXQDA. You can easily change back to the traditional 

four-window view with the help of the “Screen Layout Manager.” This is appropriate for 

screens with normal formats. 

To call up the Screen-Layout-Manager, select: 

1. In the opening window > Screen-Layout-Manager; or 

2. The  icon in the main toolbar. 

The Screen-Layout-Manager allows you to select from among four options: 

 

The Screen-Layout-Manager 

Top left: The new default layout in three columns. The “Document Browser” is found in 

the middle and “Retrieved Segments” in the third column on the far right. 

Top right: Alternative three-column layout with the “Document System” and the “Code 

System” on the right side. 

Bottom left: The classic two-column layout with the “Document System” and the “Code 

System” on the left side. 

Bottom right: Alternate two-column layout with the “Document System” and the “Code 

System” on the right side 

Note: For screens less than 1,280 pixels wide, MAXQDA defaults to the two-column layout. 

Optimize Interface: Small Screens 

When coding a document, it is sometimes helpful to close the “Document System” and 

“Retrieved Segments” window, so the “Code System” and “Document Browser” are larg-
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er. The “Document Browser” can then be made even bigger by dragging the border in the 

direction of the “Code System.” 

 

Optimal window setup when coding 

It is similarly helpful to close the “Document Browser” when you are doing retrievals (Cod-

ing Query), so you have access to the three necessary screens while maximizing the size of 

your “Retrieved Segments” window. Whenever you now click on the text information box 

in the “Retrieved Segments” window, the corresponding text will be open in the “Docu-

ment Browser” window. 

2.3 The Main Menu  

The main MAXQDA menu includes the following menus: 

 

The main MAXQDA menu 

The drop-down menus offer the following functions: 

Project Menu 

In the Project menu, you can choose to create a new project, open an existing project, or 

complete other project management functions like printing, exporting, and importing. This 

makes it possible, for example, to print out the “Document System,” the “Code System,” 

the “Retrieved Segments” window, and the currently opened document in the “Document 

Browser.” You can also change the user name or access the options menu to change your 

settings. 
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Edit Menu 

Here you will find, as in all Windows programs, options to cut, copy, and paste text into 

the Windows clipboard. In MAXQDA, these options are possible only when the “Document 

Browser” is active. Moreover, you’ll find options like undo and undo all. 

Document Menu 

In this menu, you can create a new document group or a new document or import docu-

ments. A special function also allows you to import structured document forms. 

The document shown in the “Document Browser” can also be printed or exported, and the 

“Overview of links” in the project can be called up. 

Codes Menu  

This menu offers functions that connect to your codes, and some of the functions can also 

be accessed by right-clicking in the “Code System” window. 

The available functions allow you to create a new code, view an overview of code frequen-

cies, or create a complete index of all codes assigned to all document segments. 

You also have the option of printing the “Code System,” importing or exporting the “Code 

System.” The list of all coded segments can be printed or exported. 

Summaries Menu 

This new menu item in MAXQDA 11 allows you to create summaries of coded segments 

and insert them into Grid Tables for a clear overview. The summaries represent, to a certain 

extent, a new level of data analysis. 

Memo Menu 

The Memo Manager is the most important function in this menu and gives you a table with 

an overview of all the memos in the project. This includes all memos including document 

memos, document group memos, code memos, and free memos. You can view and edit 

each memo in this table as well as sort the memos according to any of the column head-

ings. 

The menu also offers various selection functions: only memos of open documents, only 

memos from certain users, etc. 

Variables Menu  

The variables menu allows you to create, edit, and set values for document variables, as 

well as switch between the various variable views. You can also import or export variables 

from this menu and call up code variables. 

You will also have access to MAXQDA 11's new Statistics and Graphics functions, which 

can be called up for both document and code variabes. 
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Analysis Menu 

This menu offers many different options related to the lexical search and retrieval functions. 

The lexical search option allows you to search within documents (or just the activated doc-

uments), memos, and retrieved segments. The search function can be used to search for 

certain words, phrases, or character combinations. The documents to be searched can be 

chosen in various ways. You can search for keywords in context and automatically code the 

hits that are found. 

Most of this menu’s functions relate to retrieval. You can select various criteria for the seg-

ments to be found (e.g. OR, AND, logical combinations, NEAR, etc.). 

The retrieved segments can also be filtered according to various criteria in the “Retrieved 

Segments” window, based on a weight filter and/or the inclusion/exclusion of subcodes. 

Mixed Methods Menu 

This menu includes various functions for the combination of qualitative and quantitative 

data using documents and variables. The logical activation allows you to activate docu-

ments or document groups based on their assigned variables, thereby limiting the retrievals 

to certain document segments. The Quote Matrix and Crosstabs functions are different vis-

ualizations that show connections between coded segments and selected variables or vari-

able categories. The Typology Table is similar and shows percentages and/or mean values 

and standard deviations for qualitatively-designed typologies. 

Visual Tools Menu 

This menu offers seven different visualization function options. MAXMaps, the tool for 

qualitative modeling; the Code Matrix Browser; the Code Relations Browser; and the Doc-

ument Comparison Chart are all for numerous or all of your documents; and the Document 

Portrait and Codeline visualizations apply only to one document at a time, which means 

that they can only be selected when a document is activated in the “Document System.” 

Windows Menu 

This menu allows you to hide or view each of the four main MAXQDA work area windows. 

MAXDictio Menu (optional) 

This menu is only available if you the MAXDictio module is installed. It is an add-on, which 

offers a number of functions for quantitative content analysis, e.g. coding according to cre-

ated dictionaries and viewing word frequencies. 

Toolbars Menu 

The eight MAXQDA toolbars can be turned on or off in this menu. After turning on a 

toolbar, you can move the toolbar around, freely placing it anywhere on your screen. If a 

toolbar is closed and then opened again, it will reappear where it had last been placed. 
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Help Menu (?) 

Here you will find the Introduction to MAXQDA in PDF format, which may be helpful to 

print out. You will also find detailed help and links to the online tutorials, which give you a 

quick introduction to the program. You can also search for an update and download the 

update if you don’t have the most recent version. The Tips and tricks option opens a win-

dow with a number of helpful hints for working with the software. 

2.4 The Toolbars  

MAXQDA's main toolbar is called “MAXQDA standard” and should always be visible. It 

contains icons that provide quick access to frequently used program functions. By default, 

the toolbar is located directly below the main menu: 

 

“MAXQDA standard” toolbar 

The icons represent the following: 

 

 

Overview of the buttons in the “MAXQDA standard” toolbar 

In addition to the main toolbar (”MAXQDA standard”), there are seven other toolbars that 

can be shown or hidden as necessary. These toolbars can be hidden or displayed in the 

Toolbars menu. 
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The “Toolbars” menu 

The “Code” toolbar offers quick access to functions for coding, linking text segments, and 

turning on/off Edit Mode. 

 

“Code” toolbar 

The “Document navigation” toolbar makes it easy to navigate within PDF documents 

and zoom in and out in the “Document Browser.” 

 

“Document navigation” toolbar 

The “Media player” toolbar makes it possible to play audio and video files connected to 

texts and insert time stamps. 

 

“Media player” toolbar 

The “Highlight coding” toolbar has five icons, which allow you to highlight/color code 

segments of text in a document. 

 

“Highlight coding” toolbar 

The “Visual tools” toolbar has seven symbols, giving you quick access to the mapping 

tool MAXMaps as well as the visualization functions “Code Matrix Browser,” “Code Rela-

tions Browser,” “Document Comparison Chart,” “Document Portrait,” “Codeline,” and 

“Crosstabs.” 

 

“Visual tools” toolbar 
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The “MAXDictio” toolbar makes it easy to access six of the most common functions in 

the add-on module MAXDictio for quantitative, dictionary-based content analysis. 

 

“MAXDictio” toolbar 

The last toolbar “Language selection” allows you to switch interface languages with a 

single click. 

 

“Language selection” toolbar 

Position Toolbars on the Screen 

All toolbars can be positioned anywhere on the screen, as per usual in Windows programs. 

Simply click on the four points on the left edge of a toolbar or the title of a free-floating 

toolbar and place the toolbar at the desired position. 

 

Position toolbars 

2.5 The Context Menus and Toolbars in the “Document 

System”  

In addition to the various menus accessible from the menu bar, MAXQDA can be controlled 

using the toolbars and context menus in their respective windows. The functions that relate 

to the handling of documents are concentrated in the “Document System” window. 

2.5.1 Toolbar 

The toolbar at the top of the “Document System” window offers quick access to the fol-

lowing frequently-used functions: 

  Reset activations – resets current activations 

  Import documents – allows you to insert text, PDF files, spreadsheets, images and 

media files into the project. 

  New group – creates a new document group directly above the document group, 

displayed in the highest position. 
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 Activation by document variables – allows activation of documents subject to their 

variable values. 

  Activation by color – allows activation of documents subject to their color attribu-

tion. 

  Context search – allowing for searches for a specific document name. 

  Undock window 

  Maximize window 

  Hide window 

2.5.2 Documents and Document Groups 

In order to better organize your documents, it is possible to create document groups, which 

documents can then be moved to. In MAXQDA, it is not, however, absolutely necessary 

that each document be put in a document group. Documents can simply be left in the main 

“folder.” 

Documents can also be temporarily grouped together from various document groups for 

certain aspects of your analysis. In MAXQDA, these are called document sets. 

Example: In an interview-based study on Kindergarten where teachers, administrators, and 

parents are interviewed, it makes sense to make three folders, one for each category of 

interviewees. All interview transcripts would be imported into the project (perhaps called 

“KindergartenStudy”) and then assigned to one of the three created document groups, 

named “Administrator,” “Teachers,” and “Parents.” 

In the “Document System,” it is possible to differentiate between three levels, each level 

offering a different context menu: 

 the project level 

 the document group(s) level 

 the document level 

 

Three levels in the “Document System” window 
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2.5.3 The Upper Level 

The upper level in the “Document System” hierarchy is the project level. After creating a 

new project, the “Document System” is empty except for the Documents icon. By right-

clicking on this icon, you will call up the following context menu: 

 

Context menu for the upper level in the Document System 

The menu contains the following functions: 

Activate all documents – activates all documents in the entire project file. 

Deactivate all documents – deactivates all documents in the entire project. 

Activate by variable – allows you to activate documents based on their document varia-

bles (e.g. to activate GENDER = Male, AGE > 29, Education = High School). 

Invert activation – activates all documents that are not currently activated and deactivates 

all those documents that are currently activated. This is especially helpful when do-

ing logical activations; you can then very quickly call up segments from documents 

with the contrasting document variables. 

----------------------------- 
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Memo – creates a memo that can hold information about the entire project. 

----------------------------- 

Overview of coded segments – list all coded segments from the entire project in table 

form. 

Overview of memos – lists all memos in the entire project in table form. 

Overview of variables – shows a matrix with all variables in the entire project. 

Overview of links – lists all links in the entire project in table form. 

Tag cloud – creates a visualization of the 50 most frequently-used words in the entire pro-

ject. 

----------------------------- 

New document group – creates a new document group. 

Sort document groups – sorts all document groups alphabetically from A to Z. 

Sort document groups – sorts all document groups in reverse alphabetical order. 

----------------------------- 

Create document – inserts a new, empty document with a default name into the “Docu-

ment System.” The document is also automatically opened and put in Edit Mode, allowing 

you to immediately type content into the document. 

Import document(s) – allows you to import document(s) into the project. They will be in-

serted at the highest hierarchical level of the “Document System.” After clicking on this 

function, a standard Windows screen will appear, which allows you to navigate to the doc-

ument(s) you wish to import. These documents can be in TXT, RTF, DOC/X, PDF, JPG, GIF, 

TIF and PNG format. Media files can be also be selected here; however, due to their size, 

they are not imported into the project file but stored externally and assigned to a text doc-

ument. 

Import structured documents (Preprocessor) – facilitates the import of documents al-

ready coded with the help of MAXQDA’s Preprocessor. 

Import documents from spreadsheet – allows previously-coded text in spreadsheet for-

mat (e.g. from an Excel document) to be imported into the project. 

Import bibliographical data – this option is used to import bibliographic data in RIS for-

mat. 

Transcribe audio/video – facilitates the import of an audio or video file to be transcribed 

within MAXQDA. The new document name will be that of the chosen audio/video file. 

----------------------------- 

Teamwork export – allows for the export of all coded segments, memos, and project vari-

ables. 
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Teamwork import – allows for the import of all coded segments, memos, and project var-

iables. 

----------------------------- 

MAXDictio Coder – opens the MAXDictio Coder (will be displayed only if the MAXDictio 

add-on is installed). 

2.5.4 The Middle Level: Document Groups 

A project can contain as may different document groups as you wish to create. A context 

menu is also available at the document group level, which offers functions that only affect 

that specific document group that was right-clicked on. 

 

Context menu for the middle (document group) level in the Document System 

These are the following options available in the document group context menu: 

Activate all documents – activates all documents in the document group. 

Deactivate all documents – deactivates all documents in the document group. 

Sort documents (ascending) – sorts all documents in the document group alphabetically, 

from A to Z. 
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Sort documents (descending) – sorts all documents in the document group reverse al-

phabetically, from Z to A. 

----------------------------- 

Memo – creates a memo that can hold information about the document group. 

----------------------------- 

Create document – inserts a new, empty document with a default name into the docu-

ment group. The document is also automatically opened and put in Edit Mode, allowing 

you to immediately type content into the document. 

Import document(s) – allows you to import document(s) into the document group. After 

clicking on this function, a standard Windows screen will appear, which allows you to navi-

gate to the document(s) you wish to import. These documents can be in TXT, RTF, DOC/X, 

PDF, JPG, GIF, TIF or PNG format. Media files can also be selected here; however, due to 

their size, they are not imported into the project file, but stored externally and assigned to a 

text document. 

Import structured documents (Preprocessor) – facilitates the import of documents al-

ready coded with the help of MAXQDA’s Preprocessor into the document group. 

Import documents from spreadsheet – allows previously-coded text in spreadsheet for-

mat (e.g. from an Excel document) to be imported into the document group. 

Transcribe audio/video – facilitates the import of an audio or video file to be transcribed 

within MAXQDA into the document group. The new document name will be that of the 

chosen audio/video file. 

----------------------------- 

Delete document group – deletes the document group, including all documents, coded 

segments, memos, and variables that are associated with it. MAXQDA only completes the 

deletion after confirming that you do indeed wish to carry out the action. 

Rename document group – lets you give a new name to the document group. 

----------------------------- 

Overview of coded segments – list all coded segments from the document group in table 

form. 

Overview of memos – lists all memos in the document group in table form. 

Overview of variables – shows a matrix with all document variables from the document 

group. 

Overview of links – lists all links in the document group in table form. 

Tag cloud – creates a visualization of the 50 most frequently-used words in the document 

group. 

----------------------------- 
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Teamwork export – allows for the export of all coded segments, memos, and variables 

from the document group. 

Teamwork import – allows for the import of all coded segments, memos, and variables 

from the document group. 

----------------------------- 

MAXDictio Coder – opens the coding tool MAXDictio (will be displayed only if the 

MAXDictio add-on is installed). 

----------------------------- 

Document sets are handled similarly to document groups. They are a temporary grouping 

of documents, but only contain links to the documents instead of the documents them-

selves. The context menu that appears when you right-click on a document set are similar 

to the document group context menu, but they do not contain the options to import doc-

uments. 

2.5.5 The Lower Level: The Document 

A context menu is also available at the individual document level and contains a variety of 

functions connected to the document you have right-clicked on. 

 

Context menu for the lowest (document) level 
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The menu contains the following functions: 

Activate – activates the document; if the document is already activated, the option will be 

to deactivate it. 

Open document – opens the document in the “Document Browser.” The document 

opened in the “Document Browser” is always visualized in the “Document System” with a 

pen symbol. 

Open document in a new tab – opens the document in a new tab in the “Document 

Browser.” In the “Document System” the document which is currently displayed is indicat-

ed with a symbol (document with pen). 

Document memo – creates a memo for the document. 

Color – opens a window that allows you to select a color for the document. 

----------------------------- 

Delete document – deletes the document including all connected information, including 

memos, coded segments, variables, etc. 

Rename document – allows you to give the document a new name. 

Export document – The selected document will be exported and saved in alocation of 

your choice. 

----------------------------- 

Overview of coded segments – list all coded segments from the document in table form. 

Overview of memos – lists all memos in the document in table form. 

Overview of variables – shows a matrix with all variables in the document. 

Overview of links – lists all links in the document in table form. 

Document Portrait – opens a visualization of the document that uses the code colors of 

the coded segments in the document to create a picture of the document. The size of the 

coded segment acts as the weighting factor, meaning that the longer the coded segment, 

the more space that color takes up in the visualization. 

Codeline – opens a visualization of the coded segments of the document. A matrix is cre-

ated with the codes on the y-axis and the paragraph numbers on the x-axis. It is then possi-

ble to see which codes were used in each paragraph of the document. 

Tag cloud – creates a visualization of the 50 most frequently-used words in the document. 

----------------------------- 

Teamwork export – allows for the export of all coded segments, memos, and variables for 

the document. 

Teamwork import – allows for the import of all coded segments, memos, and variables 

for the document 
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----------------------------- 

MAXDictio Coder – opens the MAXDictio Coder (will be displayed only if the MAXDICTIO 

add-on is installed). 

Properties – opens a window with all the properties of the document, which you can then 

edit (e.g. whether or not the document should be read only). Here a media file can also be 

linked with the corresponding document (ex. an audio file with the corresponding tran-

scribed interview) or encoded directly. 

2.6 Context Menus and Toolbar in the “Document Browser”  

2.6.1 Toolbar 

The “Document Browser” is MAXQDA's main work window: Here you can encode text and 

images, write memos, link text and images together, add external links and more.The ma-

jority of the functions you will carry out in the “Document Browser” are available in the 

context menu, which you can access by simply right-clicking in the window. The most 

commonly-used functions are also available in the toolbar at the top of the “Document 

Browser.” It contains the following functions: 

  Print document – allows you to print the document displayed in the window, along 

with memos and codes 

  Export document – saves the open document in a location of your choice 

  Filter visualized coding stripes – allows you to choose which coded segments should 

be visualized in the coding column based on their color 

  Context search – allowing for searches within the open document 

  Undock window 

  Maximize window 

  Hide window 

2.6.2 Tabs 

MAXQDA includes the option of opening more than one document in the “Document 

Browser” at once, each opened in a separate tab. This allows you to switch quickly back 

and forth between documents. Once you have opened documents in tabs, you can switch 

to any of them by clicking on the appropriate tab at the top of the “Document Browser.” 

Documents can be opened in tabs by holding the Shift key and double-clicking on the doc-

ument or by right-clicking on the document and selecting Open in a new tab. 
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Once a document has been opened in this way, tabs will appear at the top of the “Docu-

ment Browser” with the names of each of the documents open. You can switch between 

the documents by clicking once on the appropriate tab. The tabs can be closed individually. 

If tabs are already open, a document opened in the normal fashion from the “Document 

System” will appear in the currently selected tab in the “Document Browser.” 

2.6.3 Context Menu 

If you highlight a segment of text or select a section of a picture opened in the “Document 

Browser,” a context menu will appear with a large selection of various functions. 

 

Context menu of a highlighted segment of text in the Document Browser 

Most of the available functions are self-explanatory, but they will still be explained quickly 

in the following section. 

Note: For PDF and image documents, some functions such as cut and paste are not availa-

ble because the file formats do not permit modification. Some functions are also unavaila-

ble for spreadsheets. 

Undo text changes – undoes the most recent change to the text (only works when in Edit 

Mode). 

Undo all text changes – undoes all changes to the text that have been done since Edit 

Mode was turned on (only works when in Edit Mode). 

----------------------------- 
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Cut – cuts the highlighted text out of the document as in Microsoft Word. 

Copy – copies the highlighted text as in Microsoft Word. 

Paste – same functionality as, for example, in Word: Pastes the contents of the clipboard. 

----------------------------- 

Search for highlighted text – opens the lexical search, with which you can search for the 

selected text in all or part of the project. 

----------------------------- 

Display assigned codes – displays the codes assigned to the selected segment. 

----------------------------- 

Insert paragraph after x chars – sets the number of characters that should make up each 

line and sets each line to be handled as a paragraph. Since this function changes the text, it 

is necessary to turn on Edit Mode to use this function. Read-only documents can also not 

be edited in this way unless you change the permission settings to make the document ed-

itable. 

----------------------------- 

Code with a new code – codes the highlighted text or section of a picture with a new 

code that you will be able to create after clicking on this option. 

Code in-vivo – codes the highlighted text with a new code created and named with the 

highlighted text. 

Code with “xyz” – codes highlighted text or section of a picture with the most recent 

code used. 

Code with selection – codes highlighted text or section of a picture with all activated 

codes in the “Code System.” 

----------------------------- 

Insert document link – sets an anchor for a text link, which is a connection between two 

sections of a text or image. 

Insert external link – opens a window to allow you to choose a document to be linked to 

the highlighted section of the text or image. 

Insert weblink – allows insertion of link to a website. 

Insert geolink – opens a window where you can select a KML file, which will be the refer-

ence for your geolink inserted in the highlighted text or section of picture. 

Remove link – deletes the link at the section where you right-clicked. 

----------------------------- 



Context Menus and Toolbar in the “Code System” 32 

Show geolink bar – displays the geolink column next to the memo and code visualization 

column next to the text in the “Document Browser.” All geolinks are visualized with a sym-

bol in this column. 

Show emoticodes – opens emoticode window, from which you can code selected seg-

ments. 

----------------------------- 

Insert memo – creates a memo next to the section of text where you right-clicked. 

2.7 Context Menus and Toolbar in the “Code System”  

2.7.1 Toolbar 

The toolbar at the top of the “Code System” window offers quick access to the most 

commonly-used functions in this window. These functions are: 

  Reset activations – resets current code activations. 

  Create new code –adds new code into the code system. 

  emoticode view on/off – hides or shows regular codes in the “Code System.” 

  Code Browser – this is an alternative view of the “Code System” and the code mem-

os. It can be especially helpful if you want to create many codes at one time. 

  Change to table view – switches between tree view (as in Windows Explorer), and 

table view of the code system. 

  Activation by code variable – allows the activation of codes depending on their vari-

able values. 

  Activation by color – allowing codes to be activated based on their assigned colors. 

  Context search – allowing for searches for codes within the “Code System.” 

  Undock window 

  Maximize window 

  Hide window 

2.7.2 The Upper Level in the “Code System” 

When you create a new project, the “Code System” is empty except for the “Code Sys-

tem” icon and label. This represents the root directory or folder, the upper level of the 

“Code System” hierarchy. If you right-click on the symbol or the label next to it, you will 
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see a context menu. Since most selectable functions only apply to a non-empty Code Sys-

tem, some codes have already been inserted into the following illustration. 

 

Context menu for the upper level of the Code System 

This menu offers access to the following functions: 

Activate all codes – activates all codes in the entire “Code System.” 

Deactivate all codes – deactivates all codes in the entire “Code System.” 

Activate by code variable – allows for activation based on code variable values (e.g. by 

speaker in a group discussion). 

Invert activation – activates all currently deactivated codes and deactivates all currently 

activated codes in the entire “Code System.” 

Activate codes together with subcodes – sets preference that all subcodes automatically 

be activated when top level codes are activated. 

----------------------------- 

Overview of coded segments – opens a table with all coded segments coded with any 

code in the entire “Code System.” 

Overview of linked memos – opens a list of all memos that are linked to any code in the 

“Code System.” 

Statistic of subcodes – calls up the Statistics and Graphics functions which generate fre-

quency tables and charts with the number of encodings. 

Code Alias table – all memos that are linked to a code will be displayed. 
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----------------------------- 

New code – creates a new code. The shortcut keys Alt+N can also be used for this func-

tion. 

Sort codes – sorts all codes in the upper level of the “Code System” hierarchy. 

----------------------------- 

Export Code System – exports and saves the “Code System” as a MAX exchange file 

(.mtr). 

Import Code System – import a “Code System” from a MAX exchange file (.mtr). 

----------------------------- 

Load activation – code activation status will be imported from a file previously created in 

MAXQDA. 

Save activation – the current activation status of the code is stored in a file that can be 

called up at a later time in order to establish this specific activation status. 

----------------------------- 

Code with selection – the currently highlighted text or image segment, or video or audio 

clip, is encoded simultaneously with all activated codes. 

2.7.3 The Lower Level: Individual Codes and Subcodes 

There is also a context menu for the single code/subcode level, which offer functions that 

affect the code you right-clicked on. 
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Context menu on the code/subcode level 

The following functions are shown in the context menu: 

Activate/Deactivate – activates or deactivates the code, depending on whether it is cur-

rently activated or not. If this code has subcodes, they too will be activated (or deactivated) 

if the option in the following context menu row is selected. If you do not wish to activate 

all subcodes, they can be individually deactivated by right-clicking on them and selecting 

the appropriate option in the context menu that appears. 

Activate codes together with subcodes – automatically activates subcodes of the current 

code when it is activated. 

----------------------------- 

Code – codes the currently highlighted text or image segment in the “Document Browser” 

with the current code. 

Color – opens a window where you can set a color for the code. 

Code memo – creates a memo for the current code. 

Transform into a d-variable – creates a numerical document variable with the name of 

the current code in the variable list. The number of times the code appears in each docu-

ment is entered as the variable value for each document. 
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Transform into a categorical d-variable – creates a new string variable whose value for 

each document is the subcode that appears most often in that document (only works for 

codes that have subcodes). 

Intersections – shows a list of all codes that intersect with the current code. The code that 

intersects most often is listed first. Clicking on an entry in the list displays the corresponding 

intersecting segments in the “Retrieved Segments” Window. 

----------------------------- 

Delete code(s) – the selected code is deleted after confirmation. In the alternative view of 

the “Code System” as Table, several codes can be deleted simultaneously. When a code is 

deleted, every association to coded segements will be deleted. Subcodes, where assigned, 

will also be deleted. The removal of codes from a code system can be visualized as the cut-

ting of branches from a tree: when a branch (code) is cut, all attached subcodes and sub-

codes of subcodes are also cut. 

Rename code – allows you to create a new name for the code. 

Code Alias for Smart Publisher – here you can assign an alternate name for a code that 

will be used if the coded segments are exported with Smart Publisher. The Smart Publisher 

generates a complete formatted report of selected coded segments. 

Copy subcodes – copies all subcodes so that they can be pasted into another code. 

Copy coded segments – copies all coded segments for the code, so that they can be cop-

ied into a different code. After choosing this option, right-click on the code that you would 

like to paste these coded segments into and select Insert coded segments from … 

Move coded segments – cuts the coded segments from the current code, so you can in-

sert them in a different code. After selecting this option, right-click on the code where you 

want to move the coded segments to and select Move coded segments from … A win-

dow will appear confirming that you really wish to move the codes, and after you confirm 

this, the coded segments are moved. 

----------------------------- 

Overview of coded segments – opens a table with all coded segments coded with the 

current code, offering an overview of the text and image segments assigned with the code. 

Overview of linked memos – opens a list of all memos that are linked to the current 

code. 

Overview of code variables – opens a table with all code variables of the code and its 

subcodes. 

Overview of documents – opens a table with all of the documents in which the code was 

used. 

Import code variables – allows import of code variables for subcodes of the code. 

----------------------------- 



MAXQDA Screens and Menus 

 

37 

New code – creates a new subcode for the current code. 

Sort codes – sorts all subcodes of the current code in alphabetical order. 

----------------------------- 

Add code to code favorites – adds the current code to the list of code favorites. 

2.8 Context Menus and Toolbars in “Retrieved Segments”  

2.8.1 Toolbar 

The following commonly-used functions are available in the toolbar at the top of the “Re-

trieved Segments” window: 

  Change to table view – switches from list view to table view and back. 

  Print retrieved segments – prints segments along with indications of their origins. 

  Show as Excel table – opens the retrieved segments in an Excel document in XLS/X. 

  Show as HTML table – opens the retrieved segments in your standard browser. 

  Export retrieved segments – The segments can be exported in RTF (text format), or 

as tables in XLS or HTML format. Memos attached to coded segments, as well as tooltip 

variables, can be included in the exported material. 

  Overview of retrieved segments – shows overview of all retrieved segments in table 

form. Overview will be displayed in a new window. 

  Code retrieved segments – all coded segments that are currently in the “Retrieved 

Segments” can be coded additionally with an existing code. 

  Code retrieved segments with a new code – all coded segments that are currently 

in the “Retrieved Segments” can be coded additionally with a new code. 

  Context search – allowing for searches within the retrieved segments. 

  Undock window 

  Maximize window 

  Hide window 

2.8.2 Context Menu 

All coded segments in the activated documents that were coded with the activated codes 

are shown in the “Retrieved Segments” window. 
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To the left of each of these segments is a yellow info box with information about that seg-

ment. The info boxes tell you in which document group, document, and paragraph the 

segment is found and which code was assigned to it. 

 

Clicking on the yellow info box opens the original document in the “Document Browser” and highlights the 

document segment 

If you right-click in the gray area on the left side of the “Retrieved Segments” window 

(not on an info box), a context menu appears. 

This menu offers access to a number of different features that affect the way segments are 

received in this window. You can, for example, set how retrieved segments should be sort-

ed or how activated codes are linked to each other. 

The retrieved segments can be sorted according to the document in which they are found 

(according to the order of documents in the “Document System”), according to the code 

they are coded with (according to the order of codes in the “Code System”), or according 

to the weight assigned to each coded segment. 

 

Context menu in the gray area of the “Retrieved Segments” window 

Here are all the available functions in the context menu: 

Coding Query – opens the Coding Query tool, which proposes numerous retrieval options. 

----------------------------- 

Ordered by Document System – the segments in the “Retrieved Segments” window will 

be sorted in order of the “Document System.” 
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Ordered by Code System – the segments in the “Retrieved Segments” window will be 

sorted in order of the “Code System.” 

Ordered by weight score – sorts retrieved segments according to the weight assigned to 

them. 

----------------------------- 

Include subcodes – automatically includes all subcodes in the retrieval for each code acti-

vated in the “Code System.” 

Use weight filter – displays only those retrieved segments that are within a certain weight 

range. 

Edit weight filter – opens a window where you can change the range of weight scores 

included in the “Retrieved Segments” window. The default weight assigned to each coded 

segment can be set by clicking on Options in the Project drop-down menu. 

----------------------------- 

Overview of retrieved segments – calls up a table view of retrieved segments, which is 

displayed in a new window. 

Code retrieved segments – all coded segments that currently appear in the “Retrieved 

Segments” window can be additionally coded with an existing code. 

2.9 The Status Bar 

At the bottom of the MAXQDA screen, you will see a status bar that includes information 

about various aspects of your current workspace (e.g. the number of activated documents 

and codes, the number of retrieved segments, the current retrieval option, etc.) 

 

Status bar at the bottom of the MAXQDA screen 

  Activated Documents – number of currently activated documents 

  Active codes – number of currently activated codes 

  Coded segments – number of coded segments, which are displayed in the “Retrieved 

Segments” window based on the current retrieval. 
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  Default weight – displays the current standard weight, with which each new coded 

segment is provided. The icon is interactive! Double-click the icon to customize the 

standard weight. 

  Subcodes – displays the current status of the retrieval: If an X is displayed on the icon, 

the subcodes are not included in the retrieval; if the X is not displayed, the subcodes are 

included. The icon is interactive! Double-click the icon in order to determine whether 

subcodes will be included or not. 

  Weight – displays the current status of the weight filter: If an X is displayed on the 

icon, the weight filter is switched off and all segments will appear in the “Retrieved Seg-

ments” window, regardless of their weight. If no X appears on the icon, the weight filter is 

active and only the segments which satisfy the conditions of the filter will appear. The icon 

is interactive! Double-click the icon to turn the weight filter on and off. 

  Sort sequence – shows the sequence of the coded segments in the “Retrieved Seg-

ments” window, which can be sorted by Document System, Code System, or weight. The 

icon is interactive! Double-click the icon to toggle between the various sorting options. 

  Coding Query – displays the selected mode of retrieval, such as “Simple Query” or 

“Overlapping.” The icon is interactive! Double-click the icon to call up the Query Tool for 

coding. 

  Current page – PDF documents: Displays the page number of the current view in the 

“Document Browser” along with the total number of pages. Other document types: Page 

number is set to “1.” The icon is interactive! Double-click the icon to jump to a selected 

page number. 
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3 Use of Tables in MAXQDA  

3.1 The Toolbar in Tables 

There are many situations in MAXQDA where tables are used to display information, and 

they are similar in how they can be worked with, which is similar to the handling of tables 

in Excel. All table overviews have a toolbar offering quick access to frequently-used func-

tions. 

The overviews include various icons depending on their function and purpose. The follow-

ing icons are found in some of these toolbars: 

  Excel table – shows the current table in an Excel document. This does not happen 

within MAXQDA, but can be printed out or saved as a separate file. 

  HTML table – shows the current table in an HTML document. This can also be saved 

or printed out, but is no longer connected to your MAXQDA project. 

  Export – saves the content of the table in XLS/X, HTML or TXT (tab delimited) format 

in a specified location on your computer and opens the file. This exported file is also no 

longer connected to your project file. 

  Close window 

3.2 Customizing Tables 

Tables in MAXQDA can be customized as in Excel or other similar spreadsheet programs. 

For the following example, we’ll use the table view of the document variables in MAXQDA: 
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Table view of an example project’s document variables 

The heading of each column has the name of each variable, although the standard 

MAXQDA system fields are written in a different font color: 

 Document group – the name of the Document group in which the document is found 

 Document name – the name of the document 

 Creation date – the date on which the document was imported 

 Author – the user that was logged in when the document was imported 

 Bytes – the size of the document in bytes 

 Number of coded segments – the number of coded segments in the document 

 Number of memos – the number of memos in the document 

The width of each column can be changed by clicking and dragging the border between 

the columns. Double-clicking on the column header border to the right of the column 

resizes the column to its optimal size, so that the contents of each row can be fully seen. 

 

Adjust column width and position 

It is also very easy to change the order of the columns. You just need to click on a column 

header and drag it to the place you wish to have it. 
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By right-clicking on a column header, the context menu appears for that particular col-

umn. This includes various options, including the option to hide the column or search with-

in the column. The Select field option opens a window where you can select which of the 

columns should be viewed in the standard view. 

Tables can be sorted very easily. Just click on the column header of the column that you 

want to sort the rows by. 

 

Sorting a table 

Tables can be sorted alphabetically or in reverse alphabetical order. Clicking once on the 

column header sorts it alphabetically; clicking a second time sorts it in reverse. A small tri-

angle appears in the column header of the column that is currently being used to sort the 

table and whether it is sorted alphabetically or in reverse alphabetical order. 

Tables in MAXQDA contain both editable (blue) and un-editable (black) columns. The sys-

tem variables, for example, cannot be edited. You would therefore need to change the 

document name in the “Document System” and change the document group of a docu-

ment by dragging it to a different document group in the “Document System.” 

In the editable cells of the table, you can enter or change a value by double-clicking on the 

cell and then typing the value. 

The table contents can also be selected and copied into the Windows clipboard. Selection is 

done as in Excel or Windows Explorer – a single cell can be selected by simply clicking on it, 

and additional cells can be added to the selection by holding the Ctrl or Shift key and click-

ing on the cells. The selected sections of the tables in MAXQDA are colored differently than 

the sections not selected (usually yellow). 

You can also search for certain values within each column of tables in MAXQDA. You only 

need to right-click on the column in which you want to search and select Search. In 

string fields, the search will start with the initial character. If you wish to search for a certain 

word or phrase that does not have to appear at the beginning of the value, you can use the 

asterisk (*) at the beginning of your search. 
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All overviews in MAXQDA have context menus that can be called up by using the right 

mouse button. The number of options that appear in the context menu depends on the 

overview. It is usually possible to delete a selection (e.g. a coded segment or memo). In the 

“Overview of coded segments,” you also have the option to change the weight score of 

each segment. The most options are available in the document variables table. 

 

Context menu in the document variables table 

3.3 The split “Overview of coded segments” Table 

The “Overview of coded segments” is different from other tables in that it is split into two 

sections. The lower section is just like other tables, while the upper section serves as a de-

tailed view. The upper section displays the coded segment that is selected in the lower sec-

tion. 
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4 Documents and the “Document Browser” 

4.1 General Information about Documents in MAXQDA 

With MAXQDA you can 

 import all types of DOC/X, RTF and TXT files without using any special formatting op-

tions unless you want to use certain MAXQDA functions or achieve a specific document 

appearance, 

 import all DOC/X and RTF documents with a certain structure (e.g. forms), 

 import PDF documents, 

 import XLS/X table documents, 

 import pictures and graphics in JPG, GIF, TIF and PNG format, 

 manage audio and video files in order to analyze them and the transcripts at the same 

time or to code them yourself, 

 create new text or table documents and input the data yourself, 

 create new blank documents that are freely editable by typing or pasting content from 

the Windows clipboard. 

Important: DOC/X documents can only be imported in MAXQDA if you have Microsoft 

Office (for Windows!) 2003 or later installed on your computer. Otherwise, the documents 

can be saved in RTF format and then be imported into MAXQDA. 

All text and table documents imported into MAXQDA can be edited in the “Document 

Browser.” This means you have the option of fixing typos, deleting or adding text, etc. This 

is also possible once you have done some coding and/or memoing. This means you don’t 

have to have a completed document to start your coding. PDFs, images, and audio/video 

files cannot be edited in MAXQDA. 

Usually the documents in MAXQDA have been imported, which means the original docu-

ment remains at its original location. You can edit, move, or delete this original document 

without affecting the imported version. MAXQDA has complete control over the imported 

document. This is a significant advantage over many other QDA programs, which only link 

to external documents that could be changed or deleted, thereby causing problems for 

your research project. 

4.2 External Files  

In general, all documents will be imported into the MAXQDA project file, meaning the ori-

ginal file remains in place. You can modify or delete the original file without affecting the 
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imported document in MAXQDA. This concept holds a great advantage over other QDA 

software, in which the primary files are constantly at risk of being modified “from the outs-

ide.” In MAXQDA it is possible for you to connect audio or video files to their transcriptions 

and import PDF and image files, which means that the “one project = one file” concept is 

not always optimal. If you were working with many audio/video, image, or PDF files, for 

example, your project file would quickly become very large, which would slow down pro-

cesses in MAXQDA and make it almost impossible to move the file from one computer to 

another. 

For this reason, MAXQDA does not save imported PDF and image files that are larger than 

a certain size (default 5 MB) in the project file. Instead it is saved in an external folder. You 

won’t notice any difference in the way you work with the documents in MAXQDA; the 

icons in the “Document Browser” look just like they would if the documents were saved in 

the project file. 

The default maximum size for PDFs and image files can be changed under Options in the 

Project drop-down menu. You can also set the location where external files are to be 

saved. If you do not change it, the default location for all external files will be as follows: 

 for portable license installations: [installed folder]\MAXQDA_Externals 

 for normal license installations: [My documents]\MAXQDA_Externals 

Note: All your external documents will be saved in a global external folder. If you wish to 

save externals in a project-specific folder, you should create a folder for the designated pro-

ject. However, it can be useful to work with a global external folder from which external 

files can be accessed by multiple MAXQDA project files. For this reason, when you delete a 

document, the associated media file will not be deleted (without prompting), as the file 

could still be linked to other documents. 

What actually happens when a PDF or image file larger than the set maximum size is im-

ported into the “Document System”? 

1. The document is added to the list in the “Document System” just as it would be if it 

were a smaller file. 

2. The document is visualized with the PDF or image icon as is the case with smaller files. 

3. The document is copied into the “MAXQDA_Externals” folder unless you have chosen to 

have external files saved elsewhere. The original document remains in its original loca-

tion. 

It is import to remember that unless you change the default folder for external files, this 

folder will hold externals for all projects. You will only have a separate folder for the exter-

nals of a certain project if you change the external folder in the Options window. It often 

makes sense to use the same folder for all of your projects, so that several projects can ac-

cess the same external file. It is for this reason that audio/video files are not deleted from 

the external files folder when the linked document is deleted; this audio/video file could 

also be linked to other documents. 
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What happens to a document in the “Code System” when it is linked to a media (au-

dio/video) file? 

1. The location of the original file is saved in the Properties menu of the document. 

2. The original media file is never saved as part of MAXQDA project file, even if it is smaller 

than the maximum file size. 

3. The media file is copied into the “MAXQDA_Externals” folder or whatever folder you 

have chosen for this purpose. The original document remains in its original location. 

4. When importing a text file with timestamps, MAXQDA also looks through the file for 

timestamps, creates a List of timestamps synchronizes the text with the audio/video file. 

Which file is actually used – the original or the copy? 

MAXQDA always looks for the original first – it looks for the file based on the path that is 

saved in the properties menu of the document. If the original is not found, the copy of the 

file in the external files folder is used. This file is then loaded. In other words, the original 

file can be moved or deleted without it affecting the proper functioning of MAXQDA. 

Be careful when using the same file name for different files! 

It is possible to import several documents with the same name into the “Document Sys-

tem” (e.g. three files named “Interview 1”). This is only a problem if the file is larger than 

the set maximum and must be saved in the external files folder. When the most recently-

imported file is saved, it automatically replaces the older file with the same exact name. 

What happens when you change the external files folder for a project that already has ex-

ternal files saved in the default external files folder? 

In this case, MAXQDA will ask you if you would like to move the documents from the pre-

vious location to the new external files folder. The documents are only moved once you 

confirm this. Since this action changes the global setting for all projects, all files are moved 

from the former external files folder to the new. 

What happens if a project with external files is passed on to a different computer/MAXQDA 

installation? 

In order to send the entire project, including the external files, follow these steps 

1. Send the MAXQDA (MX5) project file. 

2. Bundle all external files with the appropriate function in the Project drop-down menu. 

MAXQDA then compresses all external files associated with the current project into a Zip 

archive, which is named after your project (e.g. “Projectname.mx5.zip”) and saved in the 

same place as your project file. 

3. Send this newly created Zip file. 
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Procedure on receiving end: 

4. Open the MX5 project file. 

5. Choose Unpack bundle files from the Project drop-down menu and select the Zip 

archive in the Windows dialog box that appears. MAXQDA then unpacks the archive 

and moves the linked files to your external files folder. 

If a document is linked to an audio or video file, the original location of the audio/video file 

will be listed in the document properties. If a document with this name isn’t found in the 

appropriate folder, the copy in the external files folder will be used. 

Careful! 

The changes you make in the options menu in the Project drop-down menu are global, 

meaning they change the settings for all of your projects. If you want to use a different ex-

ternal file folder for each of your projects, you have to always remember to change the op-

tions every time you work on a different project. 
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Global options for MAXQDA 

4.3 Unicode 

MAXQDA was the first QDA software that completely supported Unicode, meaning you 

can not only import and analyze documents in any language (from Japanese to Arabic), but 

you can also create your codes, variables, document names, etc. in these languages. This 

Unicode functionality is available in every MAXQDA function 

Different countries, different languages, different alphabets – this is no problem as long as 

one does research in the Americas or Europe. But what happens if you want to analyze 

Russian or Mandarin? With the import of RTF files in MAXQDA 1, it was already possible to 

analyze texts in other languages, but that was only the case in the “Document Browser,” 

meaning the imported text could be in any language, but the codes could only be created 

using Western characters. This meant text searches and in-vivo coding were not possible. 

MAXQDA 2 was then released with additional support for certain languages, so that codes 
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and searches could include Arabic, Greek, and Cyrillic languages. The “Code System” could 

then handle characters from these languages. 

Then with MAXQDA 2007, the software was able to handle Unicode. Unicode is an inter-

national standard with the goal of standardizing all known languages and characters. This 

makes it possible to work with various languages in the same document. One sentence can 

be in English, the next in Mandarin, and the next in Arabic. This is possible because Unicode 

(unlike more common computer character systems like ASCII or ISO Latin) can deal with 

more than 128 or 256 different characters. In MAXQDA, even codes and variable names 

can be created with “foreign” characters, and searches and in-vivo coding are possible with 

any language. 

4.4 General Information about RTF and DOC/X Formats 

Documents can also be created within MAXQDA, but usually it is easier to work with a 

document in a word processor or text editor and then import it. It does not matter which 

word processor you use as long as you can save the document in RTF or DOC/X format, 

which is almost always the case. 

There are almost no limits to the options available in RTF and DOC/X format when creating 

a document. When transcribing an audio or video file or typing up field notes, it is neces-

sary to develop a transcription system or set of transcription rules. 

One option is the simple Hoffman-Riem system, which can be used by anyone looking for 

any easy set of rules. It’s translated version is below. 

Characters Meaning 

.. short pause 

... medium pause 

.... long pause 

...... omission 

/uh/ filler word 

/eh/  

((action)) nonverbal communication, e.g. ((shakes head)) 

((smiling)) nonverbal cues in combination with speech 

very noticeable emphasis or rise in volume 

v e r y drawn out speech 

( ) indecipherable 

(terrifying?) not clear, but best guess 
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RTF and DOC/X formats allow for all sorts of transcription rules so that it isn’t necessary to 

preformat things for import into MAXQDA. If you wish to handle certain sections of text as 

a single unit, though, it makes sense to have them together in the same paragraph. A new 

paragraph number is inserted automatically in MAXQDA after each hard return. It is also 

easier then to automatically code these paragraphs in MAXQDA. 

Here are the things to remember when importing a text document:  

 All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA. 

 All fonts and text sizes are carried over. 

 Paragraph formatting (e.g. right-justified) is also carried over although the spacing be-

tween paragraphs does not necessarily stay the same. 

 The text can contain tables, pictures, graphics, etc. 

 MAXQDA supports Windows OLE, which means that audio file, PowerPoint slides, hy-

perlinks, and video files can be embedded in the file. Double-clicking on these objects in 

MAXQDA will open the appropriate program to view or play the file, assuming the pro-

gram is installed on the computer. If certain objects are imported or simply linked to de-

pends on your settings in the Options window in the Project drop-down menu. 

The editing of tables within text documents is worth mentioning, as tables with more than 

two columns were difficult to work with in older versions of MAXQDA. Since version 10, 

though, this is no longer a problem; you can now easily edit and even code cells in tables 

that are embedded in text documents. The only limitation is that the size of the table can 

no longer be changed once it has been imported. 

4.5 Objects Embedded in Text 

MAXQDA supports Windows OLE (Object Linking and Embedding), which means that audio 

file, PowerPoint slides, hyperlinks, and video files can be embedded in an RTF or DOC/X file. 

The connection between the text document and these objects remains in effect even after 

import into MAXQDA. 

There are two ways to deal with these embedded objects, which will be explained with the 

example of a PowerPoint slide: 

The first variation works as follows: 

Highlight a PowerPoint slide (e.g. from the sort view) and copy it into the Windows clip-

board. You can then paste it into a MAXQDA document by pressing Ctrl+V; the slide can 

then be viewed in the document in the “Document Browser.” By double-clicking on the 

slide, you will open it in PowerPoint, where you have the option of editing the slide. You 

can also code the slide, but MAXQDA handles it as a single object, so lines of text in the 

slide cannot be coded separately. Depending on the type and size of the object, it may take 

up quite a bit of memory to code it, so only code such objects if it is important for your 

analysis. 

Second variation: 
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Here there is only a link created for the embedded objection. These work like hyperlinks in 

a web browser; you will be able to tell that a link exists, because the text will be blue and 

underlined. By hovering the mouse over the link, you can see the name of file linked to that 

spot. Clicking on the link opens the file in the appropriate program, assuming that program 

is installed on the program you are working with (e.g. PPT files are opened in PowerPoint, 

audio files in a media player, etc.). The program that will be opened depends on the com-

puter’s settings. 

With the second variation, it makes absolutely no difference how big the linked file is. With 

the first variation, though, it is important to be aware of the object size, so the project file 

doesn’t become too large. MAXQDA is first and foremost designed for analyzing text doc-

uments, so it is not recommended that you use it as a photo archive or as a multimedia 

program. 

4.6 Hyperlinks Embedded in Texts 

Thanks to the expansion of the internet, everyone knows what a link and what happens 

when you click on one. Documents imported into MAXQDA can also have hyperlinks in 

them. Clicking on the link in MAXQDA brings up the webpage or HTML file in the default 

browser. 

Hyperlinks are always made up of two parts: the visualization (whether it be a button, pic-

ture, or text) and the URL, which is the information about the location of the file, which 

may be a WWW address. By hovering over the link, you can see the location/URL in the 

tooltip that appears. Usually, this is not otherwise visible. 

 

Hyperlink in a text 

If you want to work in MAXQDA with pictures or other objects that require a lot of 

memory, it is recommended that you don’t import the pictures into the project file, but just 

link to them. The links can still be code and called up in the “Retrieved Segments” window, 

but they don’t affect the size of the project file. Starting with MAXQDA, it is now possible 

to import pictures into the “Document System” and save them either in the project file or 

externally as external files. Limits for the file size of imported objects are set under Projects 

> Options. 
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4.7 Importing Documents into MAXQDA 

Importing files into MAXQDA is simple and intuitive: you can simply highlight the docu-

ments in Windows Explorer and drag them with the mouse into the “Document System.” 

They will then be inserted on the upper level of the “Document System” hierarchy, directly 

under the “Documents” icon. In the following screenshot, you can see that eight docu-

ments (Teresa, Joanna, Jon, etc.) have been imported. 

 

Visualization of eight imported documents in the “Document System” 

By moving the mouse over a document name, you will see a tooltip that gives you infor-

mation about the document, including its size, the author (user logged in at the time of 

import), the date of import, and the number of coded segments and memos in the docu-

ment. 

Careful: If a file is open in another program (e.g. Word), it will not be possible to import it 

into MAXQDA. Instead, a box will appear informing you that the import was unsuccessful. 

Simply close the document in the other program and try the import again. 

Ordering the documents in document groups 

All you have to do is drag documents into the “Document System,” and you’re ready to 

start your analysis of those documents. Most people don’t start with the analysis immedi-

ately, though, and prefer to organize the documents in folders, as they might do on their 

computer’s hard drive. Rather than using folders, MAXQDA uses document groups. They 

work just like folders do in Windows Explorer – you can name them and drag documents 

into them. The number of document groups is not limited in MAXQDA; you can make as 

many of them as you want. When you create a new document group, it will automatically 

be named “Group 2,” “Group 3,” etc. 
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Newly-created document groups are automatically named “Group 1,” “Group 2,” etc. 

Import of documents into document groups can also be done via drag and drop. You just 

need to highlight the documents in Windows Explorer and drag them onto the document 

group name. You’ll see that the documents are imported into the document group when 

the file names appear under the document group icon and name. 

Tip: To import an entire document folder into MAXQDA, drag the folder from Windows 

Explorer into the “Document System” window. MAXQDA will then create a new document 

group with the same name as the Windows folder, into which it will import all MAXQDA 

importable documents. 

In addition to Drag & Drop, documents can be imported into MAXQDA in the following 

ways: 

 Select a Document Group, then click the Import document(s) button . 

 or you can also import documents by using the keyboard shortcuts Shift+Ctrl+T (im-

port to the upper level) or Alt+T (import to the selected document group). 

 or you can right-click on the document group that you want to hold the imported 

documents and select Import document(s) from the context menu that appears. 
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Importing a document via the context menu 

A Windows dialog box will appear that allows you to select the documents that you would 

like to import. 

Newly-imported documents are put at the top of the list of documents in the document 

group. They are given the same name as the original file, but you have the option of re-

naming them at any point. If you want to import several files at once into the same docu-

ment group, you can select more than one document by holding the Ctrl button while 

clicking on the documents to import. 

The order of document groups in the “Document System” can also be changed at any 

time. You simply need to click on the document group icon and drag it to the location 

you would like to have it. In other words, it is not necessary to know how you will organize 

all of your documents when you import them. 

Note: In MAXQDA, it is not absolutely necessary that you create at least one document 

group. MAXQDA works with document groups similar to the way Windows Explorer works 

with folders. You can create document groups/folders to better organize your documents, 

but each document doesn’t have to be put in one. Documents can be moved freely from 

one document group to another without having it affect the document in any way. 

4.8 Opening and Editing Documents 

You will know that a document has been imported when its name appears in the “Docu-

ment System.” To view that document, you can either: 

 double-click on the document in the “Document System,” or 

 right-click on the document in the “Document System” and choose Open document. 

The document is then opened in the “Document Browser,” and the icon next to the name 

of the document in the “Document System” changes from a sheet of paper to a sheet of 

paper with a pencil on it. 
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Symbol in the “Document System” for a document open in the “Document Browser” 

You can now begin to work with the document in the “Document Browser.” You can code 

document or picture segments, attach memos, link segments, insert external links, edit text, 

or add new text. There are two different modes for working on a document: 

 ”Code Mode” – allows you to code segments of texts or images, create internal or ex-

ternal links, and write memos. 

 ”Edit Mode” – allows you to edit text in documents imported from RTF or DOC/X for-

mat. You can type new content, fix typos, and delete text. 

Code Mode is active by default when a document t is opened in the “Document Browser.” 

Click the Edit Mode button to switch to Edit Mode. When working in Edit Mode, many fea-

tures you will be familiar with from word processing programs are available. You can 

choose the font type, size, and color as well as formatting characteristics such as bold, ital-

ics, or underline. 

 

Button for turning Edit Mode on and off 

Note: Documents that are opened in Edit mode are automatically cached on demand. You 

can set the time interval under Project > Options (by default, the open document will be 

saved every 15 minutes). The edited text will be saved automatically when you switch back 

to coding mode or close MAXQDA. 

 

Set interval at which project will be automatically saved in Edit Mode. 

When working in Edit Mode, you can undo action by either clicking the Undo button  or 

selecting the command Undo from the Edit drop-down menu. If you, for instance, have 

deleted a word or a paragraph, simply click the Undo button and the deleted text will ap-

pear again. If you click the Undo All option from the Edit menu, all changes that have 

been made since starting in Edit Mode are canceled, and the text looks exactly the same as 

when you switched into Edit Mode. 
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Important: The undo function is only available when you are working in Edit Mode. As 

soon as you go back to Code Mode or open another document, all changes that you have 

made in the current document are saved and can’t be undone. 

When importing a document, MAXQDA automatically creates a number of internal varia-

bles (formerly known as attributes) that are attached to the document. To see these varia-

bles, right-click the document and select Overview of variables from the context menu. 

These internal variables include the size of the document (in bytes), the date and time it 

was imported, and the user logged in at the time of import (author). The number of memos 

and coded segments in each document is also kept track of as a variable, although new 

documents obviously start with zero. 

 

“Overview of variables” for a newly-imported document 

This information will also appear as a tooltip when you move the cursor over a document 

name and hold it there for a moment. 

4.9 Creating a New Document in MAXQDA  

To create a new document without the help of a word processor, you should start by decid-

ing where you want the document to be placed. You can then right-click on the document 

group where you want the document to be created and select Create document. Alterna-

tively, you can call up this function from the menu Documents > Create document, or 

from the “Document System” with the keyboard shortcut Ctrl+Shift. 
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Creating a new document via the context menu of a document group 

The following dialog window will appear. Click OK to confirm. The option “Text 

document” is set by default. 

 

Creating a text document in MAXQDA 

The new document automatically starts with a name like “Document nn,” where nn is a 

consecutive number. Of course you can change the name later on. After creating a new 

document, it is automatically opened in the “Document Browser” and put in Edit Mode, so 

you can start to type or paste text from another program into it. 

There is no need to save your new document. As is the case when editing an imported 

document, everything is saved in the new document once you leave Edit Mode, view a dif-

ferent document in the “Document Browser,” or close MAXQDA. 

4.10 Assigning Colors to Documents  

You have the option of assigning a color to each of your documents. This color is then used 

in all tables and visualizations, including in MAXMaps. 
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To assign a color, right-click on the document and select Color from the context menu that 

appears. A dialog window appears which lists the colors used in the project. Standard col-

ors, (i.e. for color coding) are indicated by name ("GREEN"). 

 

 

Selecting a color 

There is an almost endless number of colors that you can pick from for your documents, 

and you can theoretically mix your own by entering values into the fields on the right side 

of the window, although it makes sense to limit the number of colors you use in a single 

project. 

The document colors are usually listed in the first column of tables in MAXQDA, which 

means you can then use them as sort criteria. By clicking on the column header, you will 

sort that column, grouping together those documents with the same assigned color. 
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4.11 Creating Document Sets  

MAXQDA makes it possible for you to create and save a temporary grouping of documents. 

While each document can only be in one document group, it can be in as many document 

sets as you wish, because document sets are only made up of shortcuts to the documents. 

In other words, a document set can be deleted without it having any effect on the docu-

ment. If that same document were deleted from a document group, however, it would be 

deleted from the project along with all of its memos, coded segments, links, etc. 

Document sets are created via activation. You can activate a document by right-clicking 

on it and selecting Activate from the context menu. You can tell that a document has 

been activated, because it turns red and a red arrow appear just to the left of the docu-

ment icon. 

Tip: For quick, easy activation, hold the down Ctrl key and left-click on the selected docu-

ments. In this way, you can also activate an entire document set. 

After activating all the documents that you want to create a set out of, you can create that 

set as follows: 

1. Right-click on the word Document sets at the bottom of the “Document System.” 

2. Select New set. 

MAXQDA then creates a new set with the name “Set 1” and adds all activated documents 

to this set. You can click on the name with the right mouse button and choose another 

that is more appropriate. Document sets are manipulated like document groups; you can 

activate all the documents in a document set at the same time and use all the options for 

working with document groups (Codes, Memos, Variables, etc.). 

Individual documents can be deleted from a document set or placed in another document 

set; the easiest way is by using the drag-and-drop function. 

When you want to analyze a certain selection of documents, using a document set is a very 

practical method, allowing you to avoid a more complicated selection procedure. Forming a 

document set is also an easy way to save the result of a complex activation process. 

4.12 Renaming and Deleting Documents 

Document groups, document sets, and individual documents can be renamed at any point. 

Simply right-click on any of these objects and select Rename from the context menu. It is 

not recommended that you have more than one document with the same name. It is possi-

ble, but it can be very confusing. 

Right-clicking on documents opens the context menu, giving you the option Delete 

document, which also deletes the coded segments, memos, and links associated with it. It 
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is not possible to undo such a deletion, which is why you must always confirm the action. 

You can also delete document groups and document sets. Be aware, however, that delet-

ing a document group also deletes all documents that are in it. 

4.13 Move and Sort Documents 

You can change the order of the documents in the “Document System” as desired. To do 

so, click and drag the document into the desired position. To change the order of multiple 

documents at the same time, click on the selected documents while holding down the Ctrl 

key to activate them. Next, right-click on the document group and select Move activated 

documents here. 

 

Move all activated documents at once to a document group 

To sort documents in a document group, right-click on the document group and select Sort 

documents. There are two options with the same text, but the icons next to them are dif-

ferent. The first indicates that the sorting will be done alphabetically (A to Z), and the sec-

ond indicates the sorting will be done in reverse alphabetical order (Z to A). 

To sort the document groups by name, simply right-click on the word Documents at the 

top of your “Document System” and select the appropriate Sort document groups op-

tion. 

Tip: Researchers often work with document names that include numbers (e.g. Interview 1, 

Interview 2, etc.). If you are going to have more than 10 documents, it is recommended 

that you make each single digit number into a two-digit number (Interview 01, Interview 

02, etc.). When sorting the documents, you will then have them in the correct order. Oth-

erwise Interview 20 would come before Interview 3. If you are working with more than 100 

documents, all numbers should be written with three digits (e.g. Interview 001, Interview 

002, etc.). 
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4.14 Text Formatting: Paragraph after x chars  

In some cases, you may wish to analyze documents based on line number rather than para-

graphs. There is a MAXQDA function that allows you to set the number of characters that 

should make up each line, which will then be treated as a paragraph. To do so, open the 

document in the “Document Browser” and switch to Edit Mode. Then right-click in the 

document and select Insert paragraph after x chars. You can then enter the number of 

characters that should make up each line (normally a range of 50-70 characters is appropri-

ate). This option is only available for text documents that do not contain photos, tables, or 

external links. The result of the procedure is a line-numbered text with a fixed number of 

characters per line. 

Careful: This action can only be undone while you are in Edit Mode. Once you have left 

Edit Mode, opened a different document in the “Document Browser,” or closed MAXQDA, 

the changes are automatically saved and irreversible. 

4.15 Document Properties  

If you right-click on a document in the “Document System” and select Properties, the fol-

lowing window will appear, which lets you view and change certain settings for that docu-

ment: 

 

Document properties window 

Read-only – if this box is checked, the document will no longer be editable, even in Edit 

Mode. This is the default setting for PDFs. 

External Document – If this box is checked, it means that the document is not actually 

part of the MAXQDA MX5 project file. Instead it has been copied into the folder for exter-

nally-linked files. In this case, the location of the original document will be listed. If you de-
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cide at a later time that you want to import the document into the project file after all, you 

can do so with the Embed external document button. 

Media file – If you want to link a document to an audio or video file, you can insert the 

path to that document in this field. 

External link 1/2/3 – Click in this field to link to another document that can be accessed 

on your computer and has pertinent information, for example, about the interviewee or the 

project in general. 
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5 Importing Structured Documents  

5.1 What are Structured Documents? 

Often you may wish to import documents that are structured and pre-coded. Examples for 

this kind of document include: 

 Forms – in this case, text passages should be pre-coded according to the heading field 

of the form. 

 Results from database retrievals, such as a list of references, should be pre-coded with 

author, title, abstract, etc. 

 Answers to open-ended questions in survey research – here you may wish to code the 

answers with a question number or an abbreviation of the question. 

It is often clear even before you start your analysis that certain sections of text are going to 

pertain to a certain subject. So, to save the work of manually coding them, you can have 

them automatically coded during the import process. 

As an example of this type of document, consider the answers to open-ended questions in 

questionnaires. Unlike narrative interviews, a document of this kind does not contain thirty 

or fifty pages but rather only a few lines, perhaps 10 to 15. Often there will be a large 

number of documents, maybe a few hundred or more. Another characteristic of such a 

document is that it is pre-structured: certain answers correspond to certain questions. The 

normal method of transcription and import into MAXQDA would make importing the doc-

uments a very time-consuming job. Every questionnaire would have to be transcribed with 

a word processing program and saved as a separate file. Attaching a question to its answer 

as a code to its corresponding text passage would not be possible when importing the text. 

Also when working with focus groups, it saves a lot of time to code the text passages with 

their speakers before importing the text into MAXQDA. The MAXQDA Preprocessor offers a 

solution for this type of data. 

There are three options for coding during import: you can use the Preprocessor, the Excel 

table import option or you can import bibliographical data in RIS format. 

5.2 Importing Structured Documents with the Preprocessor  

The Preprocessor allows you to enter a large number of documents into a single file and 

have them separated out into different documents when imported into MAXQDA. The syn-

tax rules are as follows: 
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#TEXTtextname 

this is the content of the 1st text 

... 

#TEXTtextname 

this is the content of the 2nd text 

... 

#TEXTtextname 

... 

Formatting documents for the Preprocessor 

Every document must start with the “#TEXT” without a space between “#” and “TEXT,” 

and “TEXT” must be written in capital letters. 

The name that you want to give to the document should come immediately after the 

“#TEXT” without a space in between. If you do not enter a name, MAXQDA will automati-

cally assign one when the document is imported. The first imported document will be called 

“Document 1,” followed by “Document 2,” etc. in the “Document System.” This automat-

ic numbering is useful when, for example, you enter the answers to open questions in a 

partly standardized survey. The answers must then simply be entered in the order of the 

standardized data in the SPSS file. It is not necessary to enter a name for each text. Both 

texts will have the same name. 

Document names are handled by MAXQDA as follows. You can enter any kind of string (up 

to 32 characters) as a document name – spaces are also allowed. If you enter a document 

name with more than 32 characters, MAXQDA will truncate it automatically. Once the 

document has been imported into MAXQDA, you can change the name to include up to 64 

characters. 

And what happens if you accidentally import a document with the same name as a docu-

ment that already exists in the “Document System”? This is not a problem for MAXQDA – 

it will simply import the second document with the same name while retaining the first in-

stance as well. It is not problematic for MAXQDA if there are several documents with the 

same name. It is still recommended, however, that you change the name of one of the 

documents, so that you don’t get confused as you continue your analysis. As is the case 

when importing files without the Preprocessor, the most recently imported document ap-

pears at the top of the list of documents in the “Document System.” This means that if you 

are using the Preprocessor to import several documents from the same file, the documents 

at the bottom of the file will be listed first in the “Document System.” 

An Example 

In the example project, various interviewees were asked about their level of satisfaction 

with various aspects of their life. The following is a Word file formatted for import into 

MAXQDA with the Preprocessor.  
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#TEXT 4(26,f,0k,sin) 

I've gained too much weight over the last several years and I don't seem to be doing anything to get 

rid of it. I have high cholesterol levels, but I don't attempt to change my eating habits. I'd like to jolt 

myself into becoming more physically active, so I can lose the weight and feel more energetic. I keep 

saying I'm going to do something about it, soon. 

 

#TEXT 3(34,f,2k,mar) 

Overall I am pretty happy with my mental, social and physical health. I would like to improve my dedi-

cation to working out. I am the type of person who will work out 5 times a week for a month straight 

and then is slowly turns into less days a week until it is none. I get distracted by school work, my job or 

just being tired. 

 

… 

Section of a Word file formatted for import with the Preprocessor 

After each #TEXT entry is the name being given to the document. For the purposes of this 

project, it made sense to assign a number for each of the interviewees in addition to some 

basic information about that person, including age, gender, number of kids, and marriage 

status. 

The Word file was then saved in RTF or DOC/X format with the name “HealthSatisfaction.” 

It could then be imported by using the menu option Documents > Import structured 

document (Preprocessor). Alternatively, you can select to import a structured document 

from the context menu of a document group or the document system root. 

 

Starting the function “Import structured document (Preprocessor)” for a document group 

Pre-Coding text segments during import 

The document is then imported, separating out each individual document and assigning the 

given name for each in the “Document System” from the original RTF document. 
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Documents after being imported with the Preprocessor 

In this way, it is possible to very quickly import and separate out many different documents 

formerly contained in a single file. The Preprocessor is able to do significantly more than 

this simple action, however. In many cases, you will already be able to code aspects of the 

document, and the Preprocessor can do that automatically during the import. To do so, you 

simply need to use additional syntax words. 

For each section of the document that is to be coded, you simply need to type “#CODE” 

before and “#ENDCODE” after. In the case of a standardized survey or questionnaire, you 

could, for example, code each answer with the question number that it connects to. The 

answer to the first question, then, could be coded with the code “Question1” as is shown 

below: 

#TEXTinterviewee1 

#CODEquestion1 

answer to question 1 

#ENDCODE 

#CODEquestion2 

answer to question 2 

#ENDCODE 

 

#TEXTinterviewee 2 

#CODEquestion1 

answer to question 1 

#ENDCODE 

#CODEquestion2 

answer to question 2 

#ENDCODE 

 

… 

Using syntax rules to prepare for import with the Preprocessor 

It is important to remember that there should be no space between “#” and “CODE” and 

that the word is written in capital letters. 

To avoid typos when entering “CODEquestion1,” it is possible to simply use a place holder, 

such as “§1” for the first question, “§2” for the second, etc. You can then later do an au-
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tomatic search and replace, finding all instances of “§” and automatically replacing it with 

“CODEquestion.” This can save you a lot of time in addition to helping you avoid typos. 

It is also possible to define and code with a subcode in a document prepared for the Pre-

processor. To do so, use the following syntax: 

#CODEcodename\subcodename 

You are giving the complete information about the subcode, including its name and the 

code it is a subcode of. The code and subcode are separated by a “\” symbol, but no spac-

es. As with any codes used in a document imported with the Preprocessor, MAXQDA will 

first check whether the code already exists, and if it does not, it will be created. 

Important: it is not possible with the Preprocessor to code the same segment of text with 

more than one code. As soon as “#CODE” appears, the new code will be used, automati-

cally ending the coded segment of the previous code. 

Text excerpts, as well as full paragraphs, can be pre-coded with the help of the preproces-

sor during import, as shown by the following example: 

#TEXTtextname 

Here is a text. Encoding begins here with #CODECode 1\Subcode. In the next sentence it ends with 

#ENDCODE# in the middle 

#CODECode 2 

Here is another text. The encoding ends here #ENDCODE# in the middle of the text.… 

Using keywords to code various text excerpts 

For a preliminary encoding of keywords from various text excerpts, the following rules ap-

ply: 

 When the keywords #CODE or #ENDCODE appear alone in a row, it is not necessary to 

insert # at the end. If these keywords appear within a text, or at the end of a line of 

text, they must be enclosed with #. 

 It is not possible to “layer” encodings. When a new #CODE# command comes before 

an #ENDCODE# command, the previous code is automatically closed. 

Note: Before importing a text with the Preprocessor, MAXQDA will ask whether the line 

containing a #CODE command should be retained. Usually this should be denied. 

5.3 Importing Structured Text from a Table/Spreadsheet  

In the Document drop-down menu, you will also find the option to Import document 

from a spreadsheet. With this function, you can import a number of documents at one 

time, with each cell content coded automatically. You can also include variables in these 

tables. This function is especially helpful if you are working with standardized online surveys 

with open-ended questions. 
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The table to be imported can be in either XLS/X or TXT (tab delimited) format. 

Every row in the table must represent a document, every column represents a code, and 

each cell holds a coded segment. The first row contains all the key words, like “Document 

group,” “Document name,” and then the names of the codes or variables. Variable names 

must begin with the “#” symbol. 

Example 

Document group Document name Question 1 Question 1 $Variable 

Group 1 T1 Text Text variable value 

Group 1 T2 Text Text variable value 

 

If you were to import the table above, you would get the following results: 

1. The documents “T1” and “T2” would be created in the “Document System” under 

document group “Group 1.” If any of the documents or document groups already exist, 

they will be ignored. 

2. The text segments in the column labeled “Question 1” are automatically coded with a 

newly-created code called “Question 1,” unless a code with that name already exists, in 

which case that code will be used. 

3. If the variable “Variable” did not yet exist, it will be created, and each document (”T1” 

and “T2”) will be assigned the variable value in its row. If the document already existed 

and already had a value assigned to the variable, this value will be updated with the val-

ue in the table. 

5.4 Import Bibliographical Data from Endnote, etc.  

MAXQDA 11 allows you to import bibliographical data from reference management soft-

ware such as Endnote, Citavi and Zotero.These programs are used mainly in the scientific 

fields to manage references and create bibliographies in the objective of supporting the 

creation of scientific texts. Reference management programs are similar to MAXQDA in 

that they work with projects and contain collected bibliographical information. The units of 

the project include Title, Author, etc., and may also include links to websites and related 

information. 

MAXQDA is compatible with all reference management programs that can export their 

databases in RIS format, which is the standard format for bibliographical data. RIS format 

bliographical reference entries will be subsequently listed one after the other as TXT data. 

RIS files contain two-letter “tags” which are followed by the relevant information. The most 

important tags include: 

TY – Type of reference, always marks the beginning of a new entry 



Import Bibliographical Data from Endnote, etc. 70 

ID – Unique identification number for each entry 

AU – Author 

TI – Title 

PY – Publication date 

ER – Closes entry, always located at end of entry 

A detailed description of all RIS format tags can be found on Wikipedia under 

http://en.wikipedia.org/wiki/RIS_(file_format). An example of RIS source data is listed below: 

TY  - BOOK 

AU  - McLuhan, Marshall 

AU  - Fiore, Quentin 

TI  - The medium is the message 

PY  - 1967 

CY  - New York 

PB  - Bantam Books 

ER  - 

Calling up the Function 

To import RIS data, select Documents > Import bibliographical data. A dialog window 

will appear which lists only file types ending in RIS or TXT. Select the desired file and click 

OK. 

Importing and Automatically Pre-Coding Data 

Data is imported in the following steps: 

 A new document group is created, which is named “RIS_” followed by the name of the 

imported file. 

 All bibliographic entries in RIS format are added to the new document group as single 

documents; entries remain in their original order. The imported documents are indicated 

with a book icon in the Document System. 

 The document name appears as follows: <First Author> - <Year> - <ID>. Blank fields 

will be marked with a “?" 

 The newly created documents contain the information listed to the right of the tags. 

The tags themselves will not be imported. 

 A new top-level “RIS” code will be created in the Code System. The top-level code con-

tains the tags in RIS format as subcodes (e.g. “TY - Type of Reference"). 

 When imported, all documents will be automatically pre-coded, during which each pa-

ragraph will be coded with the corresponding tag code. 

http://en.wikipedia.org/wiki/RIS_(file_format)
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 A display will appear which indicates the progress of the import. 

 

RIS data after being imported into MAXQDA 

Adapting Selected Information as Variables 

The following variables will be automatically adapted as follows upon import of bibliogra-

phical data, for each newly created document: 

 TY (Type of Reference) – String 

 AU (First Author) – String 

 TI (Title) – String 

 ID (Identification number) – Integer 

 PY (Year of Publication) – Integer 

These variables are created by the system and cannot be modified by the user. 
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Adapted variable values for each document 

Working with Bibliographical Data in MAXQDA 

After import and automatic pre-coding, a normal text view of the bibliographical data is 

available in MAXQDA. This means that the data can be searched, coded, linked, and edited, 

and that memos can be attached. All Visual Tools and other functions (e.g. Statistics and 

Graphics) can also be employed. Automatic pre-coding makes it is possible to isolate spe-

cific document types for analysis, e.g. journal articles only or anthology entries only. 

Export Bibliographical Data in RIS-Format 

Bibliographical data in RIS format can be exported from MAXQDA, i.e. for import into a 

reference management program. The export function is located under Project > Reports & 

export > Bibliographical data as RIS file. 

After selecting an export location, all documents in the project which contain bibliographi-

cal data (indicated with a book symbol) will be exported as RIS data (UTF-8 coding). 
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6 Links: Document Links, External Links, Web Links, 

and Geolinks 

6.1 Links in MAXQDA 

MAXQDA distinguishes between four types of links: 

1. Document links represent a connection between two text or image segments (e.g. to 

show the contrast between two interviewees’ responses to the same question, you could 

link them with each other). 

2. External links create a connection between a text or image segment and an external 

document (e.g. a picture, document, audio/video file, etc.) that is not part of the 

MAXQDA project. 

3. Web links are connections between a text or image segment and a webpage. By clicking 

on this link, you can open the website in your standard browser. 

4. Geolinks create a connection between a text or image segment and a place on the 

globe. This place is based on GPS coordinates and is shown in Google Earth or other 

similar programs. 

You can create or delete links in MAXQDA’s “Document Browser” or in MAXMaps, the 

modeling add-on that allows you to create visualizations of your data and concepts and 

show connections between them. 

The four types of links are visualized with various symbols in the “Overview of links.” 

6.2 Document Links  

It is possible to link documents or positions in documents with the help of document links. 

Document links are used in the same way as hyperlinks in the Internet; they link two docu-

ment or positions in document together. Clicking a document link causes the correspond-

ing document link to be loaded. 

In MAXQDA, document segments that are in the same document or in different document 

can be linked. To link document, select at least a single character from a document in the 

“Document Browser” – normally a word or more is suitable. 

Document segments are linked as follows: 

1. Select the first document segment (the anchor) and click the blue Document Link symbol 

in the coding toolbar (or choose the option Insert Document link from the context 

menu). The selected document segment now appears blue and underlined. 
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Toolbar button for creating a document link 

2. You can now choose the document or document segment that the anchor should be 

linked to. This second segment can be in the same document or in a different one. Simp-

ly go to the document or document segment and highlight a section of text. 

3. To complete the link, simply click again on the Insert link symbol in the toolbar or 

right-click on the highlighted text and choose Insert link. 

If, after the first step, the user decides against creating the link or wants to change the text 

that had been selected, clicking the Remove last link symbol removes it. 

 

Toolbar button for removing a document link 

Document links appear underlined and in blue in the “Document Browser.” Holding the 

mouse cursor over the text causes a screen tip to appear with information about the linked 

document segment: the name of the document and the actual text selected when the link 

was made. 

 

Blue underlined document link with tooltip 

For this reason, it is sometimes a good idea to select not only a word, but a whole sentence 

or paragraph as the link. 

Simply clicking a document link allows one to jump from the link in the “Document Brows-

er” to the other linked segment. The document containing the link appears at the position 

of the linked segment. 

To delete a document link, click the link with the right mouse button and choose Delete 

Link from the context menu. 
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6.3 External Links  

External links are links between a segment of a text or image in MAXQDA and a document 

outside of the project (e.g. to link part of an interview transcript in MAXQDA with a picture 

of the person saved elsewhere on your computer). 

To insert an external link, simply highlight a section of text or image, right-click on it, and 

select Insert external link. A window will then appear where you can select the appropri-

ate external document to be linked. This can be on your internal hard drive, an external 

medium like a flash drive, or a network location. 

External links are also blue and underlined like the document links. When you hover the 

mouse over the link, a tooltip appears with the name and location of the linked document. 

Clicking on the link opens the document in the appropriate program. If the segment is 

linked to a Power Point slide, for example, it will be opened in Power Point. 

6.4 Web Links  

Web links in MAXQDA are links between a text or image segment and a website. A web 

link can be created as follows: 

1. Highlight the text or image segment to be linked with the web address. 

2. Right-click on the highlighted segment and select Insert web link. 

A window will appear and you will be able to enter a web address. 

 

Window to insert Web link 

Note: If a link was saved to the Windows clipboard, it will be automatically displayed in the 

input field. 

As is the case with the external links, you can hover over the web link and see the linked 

website in the tooltip. Double-clicking on the link brings up the website in your standard 

internet browser. 
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6.5 Geolinks  

With the creation of programs like Google Earth and Google Maps, it has become possible 

to view any point on the globe with the appropriate coordinates. Geolinks or Georefer-

ences are links between elements in MAXQDA and a selected place on the globe. You 

could, for example, choose to link each interview transcript in MAXQDA with the place the 

interviewee lives. 

With the help of these geolinks you can also show geographic aspects of sociological re-

search data. The use of georeferencing tools, especially Google Earth™, in combination 

with software for qualitative data analysis is fairly new. Cesar Cisneros, professor of sociol-

ogy at Universitaria Autonoma Metropolitan Iztapalapa in Mexico, was one of the first to 

use this technique. In 2006, he used geolinks in MAXQDA for a research project in South 

America. MAXQDA includes a column in the “Document Browser” specifically for these 

geolinks. To create one, follow these steps: 

1. Go to the location in Google Earth™ that you would like to link to. You can then save 

the location by right-clicking on it and selecting Save Place As … 

2. Choose a location to save the file and make sure to save it as a “KML” file instead of a 

“KMZ” file, which is the default. 

3. Highlight the text or image segment to be linked in MAXQDA, right-click on it, and se-

lect Insert geolink. Simply select the saved KML file in the window that appears, and 

the geolink has been created. 

The KML file contains the coordinates to the saved place and everything else that Google 

Earth™ needs to take you directly to that location. When you click on the geolink in 

MAXQDA, Google Earth™ is opened, and you are taken directly to that location. 

Geolinks are visualized similar to other links (blue and underlined), but they also have their 

own visualization column next to the opened document. If the column is not shown, right-

click somewhere in the document in the “Document Browser” and select Show geolink 

bar. This bar makes it easy to differentiate between regular document links and the geo-

links. 

By hovering your mouse over the geolink visualization, you will see the coordinates that are 

saved for that location. The screenshot below shows you this below. It is a geolink in the 

interview transcript “Teresa,” linking to the place that she lives in “New York, NY, USA” at 

the exact coordinates. 



Links: Document Links, External Links, Web Links, and Geolinks 

 

77 

 

The green ball symbol to the left of the paragraph number visualizes a geolink 

A copy of the KML file is automatically saved in the MAXQDA folder for externals, which 

means that the file does not become part of the project file. Having all external files saved 

in this specific folder makes it easy to move your project file and all associated external files 

from one computer to another. Be careful not to delete these KML files from the externals 

folder – doing so will cause the geolinks to stop working. In the case that geolinks are 

placed in an external folder where a KLM file of the same name already exists, MAXQDA 

will ask if the file should be overwritten. 

The KML file is in XML format. It can be viewed in Windows Internet Explorer or any other 

software that can open XML-formatted documents. 

Segments that contain geolinks can be coded just as any other segment can. 

To view all of your geolinks in a project, document group, or document, right-click on that 

document or document group and select Overview of links. You can then sort the links 

according to type by clicking on the first column header. The rows with a green ball sym-

bolizing the geolinks will be grouped together. 

 

“Overview of links” showing the green ball in the far left column indicating a geolink in the third row 

Inserting Geolinks as Stand-alone Objects in MAXMaps 

Geolinks can also be inserted in MAXMaps by right-clicking in a map and selecting Insert 

geolink. You will then be able to select the appropriate KML file from the window that 

appears. 

The MAXMaps screen then looks as follows: 
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A geolink inserted in MAXMaps 

The name of the location in Google Earth is automatically inserted as the label for the geo-

link in the map. This label is usually long and can be easily changed. 

The inserted geolink can then be set up, visualized, linked to other objects, and moved 

around just like any other object in MAXMaps. You can, for example, insert a picture to 

replace the blue circle, change its size, etc. 

 

A geolink along with other elements in a MAXMaps map 
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Inserting Free Objects with Geolink Attributes in MAXMaps 

You can also insert a free object into a map and link it to a geolink. The following screen-

shot shows such an object. If you click on this object, a border appears with a blue ball in 

the top right corner, which indicates that it is linked to a geolink location. 

Hovering with the mouse over the blue ball brings up the tooltip with information about 

the location. By double-clicking on the symbol, you open Google Earth and go directly to 

that location. 

 

A free object in MAXMaps with a geolink  

Geolinking for Codes, Documents, Memos and Coded Segments in MAXMaps 

All MAXQDA objects inserted in MAXMaps can be connected to a geolink. As with the free 

objects mentioned above, a blue ball appears in the top right of object’s frame when it is 

clicked on. Double-clicking on the ball opens Google Earth™ and takes you to the assigned 

location. 

Geo-Links as Hot Spots in MAXMaps 

It is also possible to insert a geolink in MAXMaps as an invisible hotspot. You can insert this 

hotspot by right-clicking on a white section of a map and selecting Insert geolink. You can 

then get rid of the label and change it to invisible by unchecking the box next to Visible in 

the object properties window. The hotspot is then invisible, but it still works; a double-click 

opens Google Earth™ and takes you directly to the assigned location. 

These hotspots are especially helpful when you have a map as a background and want to 

be able to click on different parts of the map to take you to that spot in Google Earth™. 
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Making a geolink invisible, so it can act as a hotspot 

Using a Background Image with Geolinks in MAXMaps 

Google Earth™ allows you to save any view as a JPG file. You simply go to the File drop-

down menu and select Save > Save Image. The view is then saved as a JPG file, which can 

be inserted in MAXMaps as the background. 

Invisible hotspots as well as all aspects of your MAXQDA project can then be inserted and 

placed on the newly-imported background. 

6.6 “Overview of links”  

Document links, the most common form of link, are easily seen in the “Document Brows-

er,” but if you have created many links, it is difficult to get an overview of them. For this 

reason, MAXQDA makes it possible to view all links in an overview table. This overview ta-

ble is similar to the one used for the “Overview of coded segments.” 

To view the “Overview of links,” right-click on a document, document group or the “Doc-

uments” icon (representing the entire project) in the “Document System” and select 

“Overview of links.” When right-clicking on a document or document group, only those 

links from that document or group will be shown. 

The overview contains the following information: 

Anchor point (Document 1), paragraph 1, preview 1, second location (Document 2), para-

graph 2, preview 2. 



Links: Document Links, External Links, Web Links, and Geolinks 

 

81 

In other words, you see the document name, paragraph number, and a preview of each 

side of a link. Document links are not hierarchical, meaning they don’t have a specific direc-

tion. A link from Point A to Point B is also a link from Point B to Point A. If you view all links 

from the whole paragraph, you will therefore see each link listed twice: once as Point A to 

Point B, and once as Point B to Point A. 

 

“Overview of links” for a project 

In the “Overview of links,” each type of link can be distinguished by the symbol that ap-

pears in the column on the far left: 

  Document links have a blue, two-directional arrow. 

  External links and web links have a red arrow pointing up and to the right. 

  Geolinks have a green ball. 

The “Overview of links” table works like other MAXQDA tables. You can choose to sort it 

alphabetically or reverse alphabetically by clicking on the column headers. Clicking once on 

a link opens the linked document segment in the “Document Browser,” showing you 

where the link is located. You can also access several functions in the table toolbar: 

  Excel table – a table with the selected links is created and saved in XLS/X format and 

opened in the program (usually Excel) that handles this type of files. 

  HTML table – a table with the selected links is created and saved in HTML format 

and opened in the standard web browser. 

  Export – allows you to export the table in XLS/X, HTML, or TXT (tab delimited) for-

mat. 
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7 Codes and How to Code 

7.1 Information on Codes and Coding in MAXQDA 

One of the main functions of MAXQDA is the “coding” of document segments, that is, the 

assignment of a code to particular document segments, e.g. enabling a systematic content 

analysis of a text. 

The codes themselves are simply strings containing up to 64 characters, which are attached 

to segments of a document (text or picture sections). Codes are like drawers containing 

index cards with text and image sections and keywords. The name of the code is like the 

label attached to the front of a drawer. What you will find in the drawer is indicated here. 

The label itself has no effect on the contents, so you can attach another label without con-

sequences. Codes can be ordered into a hierarchical structure, a main code having several 

subcodes, for example. As you add codes, they can be organized in this window. By right-

clicking on either of the icons in the “Code System” window, you will see a variety of func-

tions that are possible there. 

7.2 The “Code System” 

All of the codes are shown in the “Code System” window. At the beginning of a project, 

this window is empty except for the “Code System” and “Sets” icons MAXQDA’s “Code 

System” has the following characteristics: 

 A code is a string with a maximum of 64 characters consisting of one or more words. A 

code can contain any character except a backslash “\.” 

 The number of codes in unlimited. 

 The hierarchical structure can contain up to ten levels. 

 Codes can be assigned a color. 

 Codes are assigned an identification number. 

 The so-called color codes play a special role. They are like text markers and change the 

background color of the marked text. 

 emoticodes also play a specific role. An emoticon symbol appears in the “Code System” 

in the place of the code symbol, with pre-defined names which can be changed. 

Working with coded segments (of text and images) and the “Code System” is a central 

aspect of computer-supported text and content analysis. This work is usually not done au-

tomatically by the software, but rather is controlled by the researcher, although this often 

requires a significant amount of time. The “Code System” is shown as a tree structure on 

the screen. It looks like the file/folder system in Windows Explorer with which you are likely 
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familiar. A plus or minus sign before the code name indicates whether or not a code con-

tains subcodes. You can expand or close the sub-categories by clicking this button. 

 

Hide subcodes 

Note: In MAXQDA, the codes in the “Code System” can be moved or grouped together 

using Drag & Drop (by holding down the left mouse button). To transform a code into a 

subcode of another code, drag the selected code to the destination code by holding down 

the left mouse button, then “drop” it into place. To move a code in between two other 

codes, “drop” it between the two codes. 

It is easy to rearrange the “Code System” in a way that is useful for your work. It is often 

the case that you will find it helpful to arrange your codes in an order that follows your re-

search process or argumentation. The possibility to arrange codes in a specific sequence 

makes it easy to minimize the need to move around within the category system during the 

coding process. 

Tip: Using MAXMaps you can build a network structure of codes to be used during the 

coding process, meaning you can code selected segments within a document and code 

them by draggin them onto a code in the network map. 

The “Code System” Toolbar 

Like the other main windows of MAXQDA, the “Code System” has a toolbar where you 

can find the following icons: 

  Reset activations – resets current code activations 

  Create new code – adds a new code into the code system 
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  emoticode view on/off – hides or displays emoticodes in the “Code System” 

  Code Browser – alternative view of the “Code System” and the code memos. It can 

be especially helpful if you want to create many codes at one time 

  Change to table view – changes from tree view (as in Windows Explorer) to table 

view of code system and back 

  Activation by code variable – allows the activation of codes, based on variable val-

ues 

  Activation by color – allows the activation of codes, based on their assigned colors 

  Context search – search for codes within the “Code System” 

  Undock window 

  Maximize window 

  Hide window 

In addition to using the toolbar to access functions in the “Code System,” you can also use 

the context menus that appear when you right-click on various icons in the window (e.g. 

on a code or the “Code System” icon, etc.). 

7.3 Creating a New Code  

The word “Code System” at the top of the list represents the root of the “Code System” 

that you will build from this point. All codes can be created in this way. 

In order to create a new code at the highest level, we can do one of three things: 

1. The easiest option is to click on the New code  symbol in the “Code System” toolbar. 

 

Toolbar icon for inserting a new code 

2. Another option is to right-click on the Code System icon and select New code from the 

menu that appears. 
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Creating a new code with the context menu 

3. The third option is to create a new code by using the keyboard shortcut Alt+N. For this 

to work, however, the “Code System” window must be selected. 

No matter which way you choose to create a new code, the following window will appear: 

 

The window that appears when creating a new code 

Type the name of the new code in the upper dialog field of the window. You can select a 

color attribute for the new code below. There is an almost unlimited number of colors that 

you can pick from or design on your own. The dialog field in the lower part of the window 
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enables you to write a code memo, for instance a definition of the characteristics of the 

new code. 

Creating Subcodes 

If you would like to define subcodes, just right-click the parent code and choose the option 

New code. Again the same dialog window as mentioned above will pop up. If you want 

the subcode to have the same color attribute as the main code, just click the checkbox “In-

herit.” 

Creating subcodes can also be completed using the Alt+N keyboard shortcut or the New 

code  icon from the toolbar. 

If you have entered text into the memo field of the dialog box, a memo icon is displayed 

beside the new code in the “Code System” as soon as you close the dialog window. 

Note: Newly-created codes are always added at the top of the “Code System” unless cre-

ated as a subcode, in which case it will appear as the top subcode. 

7.4 Using the Code Browser to Create Codes   

The Code Browser offers a fast way to define a set of codes or an entire “Code System.” 

The function is started by clicking the appropriate icon from the toolbar. 

 

Opening the Code Browser 
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In the left part of the window shown below, the already existing codes are displayed. The 

dialog field in the upper right corner is used to type in new codes. You may do this step-by-

step, one after the other. At the end of each code click Insert or press the Return key. 

 

Code Browser window for code creation 

Defining subcodes is as easy as defining the codes. Click a code in the list on the left side. 

This brings the code into the dialog field. Type in a slash (”\”), then the name of the sub-

code, and press enter. The Backslash is not always present on Apple keyboards. In this case, 

select Alt+Shift+7. 

Confirm each code definition by clicking Insert or Return/Enter. 

You also have the option of creating a code memo by typing in the field in the bottom right 

of the Code Browser. 

7.5 Coding Text and Images  

Assigning codes to segments of texts or images in MAXQDA is known as “coding.” 
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The “Code” toolbar 

A document or document segment can be coded with as many codes as you want. There is 

practically no limit to the number of codes that you can create and assign. Coded segments 

can also overlap, intersect, or be completely contained within other coded segments. 

Select the Segment to be Coded 

The action of coding can be done in many different ways, but you must always start by 

highlighting a section of a text or a picture to be coded in the Document Browser.” An ex-

ample of highlighted text within the “Document Browser” is shown below: 

 

A highlighted segment of text 

The smallest segment of text that can be coded is a single character. In most cases, you 

would want to code at least an entire word. The “Code” toolbar is especially helpful when 

going through the coding process. If it is not currently visible, you can activate it by clicking 

on it in the Toolbars drop-down menu. 

In PDF files, both text and image segments can be coded: 
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Highlighted text (above) and highlighted image segment (below) in a PDF 

Different Ways to Code 

MAXQDA offers several ways to code segments: 

1. Classic coding using Drag & Drop: A selected text segment or image segment can be 

dragged and dropped into a code (or vice versa) using the mouse. 

2. Classic coding using context menu: A selected text segment or image segment can be 

coded by using the context menu in the “Document Browser” window. 

3. Free coding using keyboard shortcuts: As in Grounded Theory, a segment can be assig-

ned a new (free) code. 

4. In-Vivo coding: Select and highlight meaningful terms in the texts and automatically add 

them as codes in your code system while coding the text segment with the code. 
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5. Coding with selected codes from the Quick List: Documents are targeted based on the 

occurrence of one or more pre-selected codes, and coded where applicable. 

6. Highlight coding: This works like highlighting a text passage in a book with a colored 

text marker. In MAXQDA, five different colors can be used for color coding: red, green, 

yellow, blue or magenta. 

7. Simultaneous coding with multiple codes: A segment is coded withthe activated codes. 

8. Coding with code favorites: Selected codes are displayed in a separate window, from 

which they can be easily applied to segments to be coded. 

9. Coding with MAXMaps: Selected segments are dragged to codes on a map. 

10. Coding with symbols and emoticons: Selected segments are coded with a emoti-

codes, i.e. an emoticon or a symbol. 

Note on coding: Regardless of the function selected, MAXQDA ensures that the same 

code is not assigned more than once to the same passage. The overlapping of segments 

with the same code is not possible. When segment size is modified - made larger or smaller 

- and coded with the same code, MAXQDA will automatically correct the segment size to 

correspond to the new selection. 

The following section describes in detail how these techniques are used. The different op-

tions can be chosen from the context menu that pops up when you select a document 

segment and click the right mouse button. 

1. Classic Coding via Drag & Drop 

Left-click and hold on the selected text and move the mouse pointer to the name of the 

code in the “Code System.” Release the mouse button to assign the segment to this code, 

as you can see in the gray column next to the document in the “Document Browser” win-

dow. The reverse also works, i.e. you can drag the code to the selected document segment. 

Tip: The same segment can be assigned multiple codes in a row. 

2. Classic Coding Using the Context Menu in the “Code System” 

Right-click on the code in the “Code System” that you would like to use to code the high-

lighted document segment in the “Document Browser.” Select Code from the context 

menu. 
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Using the context menu in the “Code System” 

3. Free Coding with Keyboard Shortcuts 

An easy way to create a new code, i.e. a code that is not yet listed in the “Code System,” is 

to use the shortcut Ctrl+W. A dialog window will open, and you can type in the name of 

the new code. The code will be added to the “Code System” at the highest level of the 

hierarchy. If necessary, you can later move the code to another level in the “Code System.” 

4. Focused Coding with the Quick List Coding Button 

The “Code” toolbar provides quick access to frequently used coding functions. The “Quick 

List” is located on the toolbar to the right of the Edit button. Whenever you click on a code 

in the Code System, or when coding is in process, the corresponding code appears at the 

top of the Quick List. Click on the Coding  button immediately to the right of the Quick 

List button to assign the code in the window to the selected segment. In this way, multiple 

areas of a document can be coded without having to select the code each time. 

You can also use the keyboard shortcut Ctrl+Q. 

5. Coding with Multiple Codes Simultaneously 

First, activate the codes in the “Code System” that you want to use to code the selected 

segment in the “Document Browser.” Then right-click on the segment and choose the op-

tion to Code with selection. 

6. Coding with the In-vivo Coding Button 

Another way of coding is with the so-called in-vivo coding. If you, for example, select the 

word “global village” and then click on the in-vivo coding button in the toolbar, the word 

“global village” is added to the “Code System” as the code for this short text segment. The 

shortcut Ctrl+I has the same effect. 

 

Coding with the Quick List or the in-vivo button 
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When you want to code a whole segment of text with the in-vivo coding function, and not 

only one or two words, code the one or two words with this function first. Next, select the 

entire text segment (including the word) and click the coding button (not the in-vivo coding 

button!). MAXQDA expands the coded segment automatically. 

Note: Other coding methods including color-coding, MAXMaps, code favorites and emoti-

codes are explained in separate sections. 

7.6 Highlight Coding / Color Coding 

Color coding text is a technique that is especially useful at the beginning of the analysis 

process. It is similar to the marking of text in a book with a highlighter. It allows you to 

mark the passages you find particularly interesting when reading through the text for the 

first time. Before you decide which codes to use and before you start analyzing your text in 

categories, this technique lets you keep track of what simply seems important. There are 

five colors with which you can color code: green, blue, yellow, red, and magenta. 

The purpose of this highlighting function is not simply to change the text’s color– you could 

do this in Edit Mode by selecting a different font color for a text passage. Not only does the 

text change background color, but it is also coded with the name of the color. Thus, all the 

code functions are available to you when you are working with these segments later on. 

When going through the text a second time, it will be easier to develop your codes and 

categories from this basis. 

To activate the toolbar, select Highlight coding from the Toolbars drop-down menu. You 

will then see the following toolbar with the five available colors: 

 

“Highlight coding” toolbar with five color options 

To highlight code a segment of text, you follow a similar process as with standard coding: 

highlight the text segment with your mouse and click on one of the five colors in the 

toolbar. The text segment will now be highlighted in that color, and it will be coded with a 

new code called green, blue, red, magenta, or yellow. You will see the new code in the 

“Code System” as well as in the coding column to the left of your document in the “Doc-

ument Browser.” 
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A section of text coded with “GREEN” 

In practice, then, the highlight coding does much more than just change the color of the 

text – it is also a coding action. This means that you can later call up all of the green-

highlighted segments and work with those that are most important. This lets you code 

more specifically once the first general coding run is complete. Retrieving all codes with a 

specific color coding can be done by activating all documents in the “Document System” 

and activating the appropriate color code in the “Code System.” 

If at a later point, you delete the color code in the “Code System,” you are not only delet-

ing the code. All coded segments for that code will also be deleted. In other words, all 

highlights of that color will be deleted from your documents. 

Color codes are marked with a specific symbol in the Code System: 

 

Symbol for a color code in the “Code System" 

Note: Color codes cannot be renamed. 

7.7 Coding with MAXMaps 

The “Code System” is organized in a hierarchical tree structure, which does not allow for 

multiple cross relationships between subcodes. In some cases, it may be necessary to create 

a non-hierarchical structure to form network relationships and organize codes in a different 

structure. 

This is possible with MAXMaps, the mapping tool that is part of MAXQDA. Open Visual 

Tools > MAXMaps to start the tool and create a new map. Use Drag & Drop or 

Alt+double-click to copy codes from your code system to the map. Codes can be freely 
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arranged on the map, linked to each other with arrows or lines, and free symbols or images 

can be added to the map. 

Coding is simple: Drag a selected segment from the “Document Browser” to a code in the 

map. 

 

Coding using Drag & Drop on a code in a map 

7.8 Coding with the Code Favorites  

If you are working with an extensive “Code System,” it can be difficult to work efficiently, 

since it is hard to find each code quickly in the large list. The coding Quick List offers on 

way of working around this, but there is another option that can be helpful in certain cir-

cumstances. It allows you to also code with more than one code at once. The function is 

called the code favorites. 

And how does it work? Simply right-click on a code and select Add code to code favor-

ites. After you have added the first code, the code favorites window will appear. You can 

then continue to add more codes to the list in the same fashion: right-click on the code and 

select Add code to code favorites. 
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The list of code favorites 

You can now begin to code. Simply highlight the section of the document in the “Docu-

ment Browser” and click on the codes in the code favorites window that you want to as-

sign to it. You can now see in the coding column on the left side of the “Document Brows-

er” that the segments have been coded. 

If you want to delete a code from the list, simply click on the checkbox in front of it and 

click on the x at the top of the window. 

When you are finished using the code favorite window, simply close it by clicking on the x 

in the top-right corner. To re-open the window, you can either add another code (via the 

context menu) or select Code favorites from the Codes drop-down menu. 

7.9 Emoticode: Code with Emoticons and Symbols  

The “emoticode” function allows you to assign symbols and emoticons to text and image 

segments, as well as audio and video clips. It can generally be employed with the same 

functionality as “normal coding:” All the functions of conventional coding are supported, 

meaning emoticons and icons will be displayed in the overview tables of coded segments 

and in visualizations such as the Document Portrait. 

Emoticons and Symbols 

MAXQDA includes 310 emoticons and symbols, which are organized into different themat-

ic groups. Emoji icons are widely known due to smartphone use. They include different 

types of smileys as well as many other symbols. Each emoticon symbol has a name, which 

serves as code name. 

Calling up the Emoticode Window 

Similar to the color-coding function in MAXQDA, where segments can be highlighted and 

color-coded, the emoticode function must first be activated. In order to activate emoti-

codes, right-click on a text or an image in the “Document Browser,” then select Show 

emoticodes. Or, for easier access, use the corresponding button in the “Code” toolbar: 
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Activate emoticode function 

Note: With a screen resolution of 1,024 x 768, which is standard for projectors, the emoti-

code icon is often reduced to a smiley after restarting MAXQDA. 

After being called up, the window containing the collection of emoticons appears and can 

be moved anywhere on the screen. 

 

The emoticode window 

Note: Each emoticon or symbol is assigned a name. This is visible when the mouse moves 

over an emoticon or symbol in the emoticode selection window. After coding, it will be 

listed as a code name in the code system. 

If more symbols are included in a thematic section than can be displayed in the window, 

you can scroll through all symbols in the section using the blue arrows at the bottom of the 

window. 

When you click on the clock icon, MAXQDA displays the most recently used symbols and 

emoticons. In addition, you can add frequently used symbols to favorites. To do so, right-

click the symbol and select Add to favorites. The symbol is then shown additionally in the 

2nd tab from the left, marked with a star. Symbols can be removed from the favorites list 

using the same method. 
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Add and remove symbols from favorites 

Tip: You can customize symbol order in the Favorites tab using Drag & Drop. 

Options for the emoticode Window 

Window and symbol size can be customized. Click on the Properties  button at the top 

of the window. 

 

emoticode properties window 

Coding with Emoticons 

Coding segments with emoticons is just like color coding or coding with the toolbar. The 

segment is selected in the “Document Browser” or “Multimedia Browser,” then you can 

subsequently click on the desired symbol or emoticon in the emoticode window. If the 

emoticon has already been used in the existing “Code System,” the reverse is also possible 

– meaning the selected segment can be dragged into the code, or the code into the seg-

ment. 

Coding Display in the “Document Browser” 

In the “Document Browser,” the selected emoticon appears in the middle of the coding 

stripe, in the place of the code name. All segments coded with emoticons are displayed in 

the default coding color (green); it is not possible to assign a different color. 
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Coding stripe with emoticode in the “Document Browser” 

In the selection window for the displayed coding stripe (which can be called up with a 

right-click on the mouse in the visualization area), you can hide or show coding stripes with 

emoticodes in the “Document Browser.” 

 

Select “Display emoticodes” to emoticodes on the coding stripe 

emoticodes in the “Code System” 

When the “Code System” is displayed in the normal tree structure, the emoticodes appear 

in the place of the usual code symbols. The display of codes in the code system can, if de-

sired, be restricted to emoticodes by clicking on the corresponding button in the window's 

toolbar. 
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emoticode display in the “Code System” 

The figure shows the emoticode symbols “laughing,” “eye” and “ambulance” in the code 

system. The names, just like code names, can be replaced by another term. 

Emoticons in the “Retrieved Segments” and “Overview of coded segments” 

Emoticons, in most cases, replace code symbols, and are therefore found in the yellow-blue 

source list in the “Retrieved Segments.” In the first column of the “Overview of coded 

segments” the emoticons are are displayed instead of the code colors, allowing the entire 

table to be sorted by emoticons. 

 

Emoticons in the “Retrieved Segments” and in the “Overview of coded segments” table 

Emoticons in MAXMaps and Visual Tools 

In MAXMaps, the appropriate emoticon will appear in the place of the code symbol. In the 

Code Matrix Browser, Code Relations Browser, and Codeline, the emoticon will also be dis-

played in the place of the code symbol. 

In the Document Comparison Chart each code that is present in the paragraph is repre-

sented by a colored section of the bar. Code colors, not emoticons, are used, with the color 

green indicating emoticodes. 

The Document Portrait is displayed with emoticodes rather than code colors if the “Mix” 

feature is turned off. When the “Mix” feature is turned on, it mixes the code colors where 

codes overlap. In this case the color green is used to indicate emoticons. 
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7.10 Assigning Colors  

Every code and subcode can be assigned a color. This color attribute is used for the display 

of coding stripes in the “Document Browser” and for visualizations. The colored coding 

stripes make it especially easy to find certain coded segments in documents in the “Docu-

ment Browser.” 

 

Coding stripes of various colors in the Document Browser 

The color is also seen in the bottom right of the icon next to each code in the “Code Sys-

tem.” 

 

Codes of various colors in the Code System 

The color attribute is also displayed in all MAXQDA tables that contain codes, e.g. in the 

“Overview of coded segments” table that is available for each document group and each 

document. There, the color attribute may be used as a criterion for sorting the table. This is 

done by clicking on the column header of the column containing the colored icons. Unless 
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you have changed the order of the table’s columns, this column will be the first one in the 

table. 

 

Color attribute in the first column of the “Overview of coded segments” 

The color attribute plays an important role in all visual tools of MAXQDA. For instance, the 

Document Portrait is based completely on the colors of the codes that are assigned to a 

particular document. Thus, the selection of colors is an important step: colors should be 

assigned according to the kind of analysis that you plan to conduct. For instance, a psy-

chologist could assign red colors to aggressive statements and green colors to friendly 

statements. When analyzing documents in regard to the topics mentioned a meaningful 

association of topics and codes is recommended. Thus, you are able to identify topics and 

combinations of topics with one glance. When working with focus groups, you should as-

sociate the speakers with the different colors, in order to quickly find out when a person is 

speaking. 

7.11 Displaying Code Frequency in the “Code System” 

If and how many coded segments are assigned to a specific code, can be extracted from 

the “Code System.” The total number of segments coded with a code will be displayed 

after each code in the code frequency column. You can suppress the code frequency dis-

play by selecting Project > Options. 

In the following figure, the number 15 appears after the code “Day-to-Day Is-

sues/Interests.” This indicates that up until this point, a total of 15 segments have been 

coded in this category. 
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Information on the number of coded segments 

Caution: If a display indicating the number of coded segments does not appear in your 

“Code System” the display of code frequencies is likely suppressed. To activate the display, 

go to Project> Options. 

7.12 Visualization of Coded Segments in the “Document 

Browser” 

As soon as you have coded a document segment, a coding stripe appears in the gray area 

next to the document in the “Document Browser.” The standard color for this symbol is 

green, but you can choose another color for any code, causing all the code symbols for this 

code to appear in this color. The column for the coding stripes can be made bigger or 

smaller by clicking on the separator between the column headers and dragging to the right 

or left. Double-clicking on the column separator makes the column the optimal size. This 

optimal view can be impractical, though, if you have too many coded segments. In such 

cases, the text will be made so small that you won’t be able to read it easily. 

 

Visualization of coding stripes on the left side of the “Document Browser" 

You can also choose whether code names should be shown in the coding stripe column. By 

right-clicking in the gray area of the column, you will call up a window with various setting 

options. One of those options is to Show code name. 
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You will always be able to see the code name in the tooltip that appears if you hover your 

mouse over the coding stripe. The tooltip also shows you the assigned weight, the author 

of the coded segment, and the date that the segment was coded. 

 

Tooltip appearing from the coding stripe 

This tooltip always displays the complete code name, even if it is a subcode. This is signifi-

cant, because the coding stripes in the column only show the name of the codes, rather 

than including the codes that they are subcodes of. In other words, the code “Interests” is 

a subcode of “Day-to-Day Issues,” but that is only visible in the tooltip, not in the coding 

stripe column (see above). In the tooltip, it is shown as “Day-to-Day Issues\Interests.” 

If there are many coded segments, it can also be difficult to figure out exactly which code-

name belongs to which coding stripe. This can be immediately identified when you move 

the mouse over a coding stripe, at which moment the code name will appear brighter and 

the code assignment will be displayed. 

Often you will want to know which codes are assigned to a specific text or image segment. 

To do so, select the segment and choose Display assigned codes from the context menu. 

 

"Display assigned Codes” for selected text in the context menu 
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This will display a menu in which all assigned codes are listed. Click on an entry in the list to 

highlight the code in the “Code System.” 

 

List of assigned codes for a segment 

7.13 Coding Stripe Column Visualization Options  

By right-clicking in the coding stripe column, you can call up a window with various settings 

for the visualization of coded segments in the coding stripe column: 

 

Option menu for the visualization of coding stripes 

Here you can adjust the following settings: 
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 You can choose to only visualize activated codes. 

 You can choose to visualize coded segments created by certain users. 

 You can choose to only visualize coded segments of a certain color. 

 You can choose whether to change the text color of the text in the document to match 

the color of the code it was coded with. 

 As mentioned before, you can choose whether the code name should be shown or not. 

 Finally, you can choose whether the tooltips should include the information about the 

author and date of creation. 

The option to switch off codes with selected colors is particularly useful when you are 

working in a team with independent coders. In this case, the coders should be defined as 

codes on the highest level of the code hierarchy and the different coders should use the 

same code tree organized as subcodes of the coders. Now, while the training the coders, 

you can hide the visualization of other coders’ work. Later on, they can compare their cod-

ing with the coding done by the others. 

The option to color the text according to code colors only makes sense if you do not have 

many overlapping codes. Overlapping codes cause the color of the text to be a mix of those 

overlapping codes, which can make it very difficult to interpret. 

7.14 Deleting Coded Segments: The Undo Function  

Clicking on the code symbol with the right mouse button causes a context menu to appear, 

with which the coding of the text segment can be removed. Choose Delete and confirm 

the deletion by clicking Yes in the confirmation window that appears. 

If you need to first find the location of a coded segment in a document, deleting the code 

in this way may not be very convenient. A better way is to use MAXQDA’s Undo function. 

In the “Code” toolbar on top of the “Document Browser” window there is an Undo 

button. Clicking on it opens a list containing the last codes assigned. 

 

Undo function in the “Code” toolbar 

Note: The most recent coded segments are shown at the top of the list. 
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Through certain functions, such as “Move coded segments” or autocoding, you may code 

dozens or even hundreds of segments at one time. In such cases, the Undo function can be 

very helpful. 

Codes can also be cleared through the “Retrieved Segments” window: Right-click on the 

yellow information box and select Delete in order to delete the selected code. 

Note: If a code is deleted from the Code System, the code is removed from all segments, 

that were code with that code. 

7.15 Deleting Codes  

Deleting a code from the “Code System” is somewhat like cutting of a branch of a tree. By 

deleting that code, you are also deleting any subcodes, which are like smaller branches at-

tached to the bigger one you cut off. At the same time, all coded segments that had been 

created with those codes are deleted. 

You can delete codes in the “Code System” either in the classic tree structure view or in 

the table view: 

 In the tree view, right-click on the code to be deleted and select Delete code(s) from 

the context menu. Alternatively, you can left-click on a code and press the Del key. 

 

Deleting a code from the context menu 

 Alternatively, you can switch to the table view of the “Code System” (by clicking on the 

Change to table view icon on the toolbar), then delete the code via the context menu 

or by pressing the Del key. 

Attention: When deleting a code, you are also deleting all coded segments that were cre-

ated with this code. 
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If you want to delete more than one code at a time, it is necessary to switch to the table 

view of the “Code System.” To do so, click on the Change to table view icon in the 

“Code System” toolbar. You can now select as many codes as you wish by clicking on 

them while holding the Ctrl key and then right-clicking and selecting Delete code(s) from 

the context menu. 

7.16 Modifying Coded Segments  

There are three ways to modify coded segments: 

1. A code can be “un-assigned” or removed from a segment – when, for example, you 

assigned the code to the segment by mistake. 

2. A different code can be attached in place of the other. 

3. The size of the coded segment can be changed (e.g. to encompass paragraphs 5-12 

instead of just 5-10). 

All three of these modifications can be easily carried out in MAXQDA. 

Deleting a Coded Segment 

From the Document Browser: 

1. Right-click on the little circle in the middle of the coding stripe in the column to the left 

of the document in the “Document Browser.” 

2. Select Delete and confirm the deletion by clicking Yes. 

 

Deleting a coded segment in the “Document Browser” window 

From the “Retrieved Segments” window: 

1. Right-click on the yellow info box to the left of the coded segment. 

2. Select Delete and confirm the deletion by selecting Yes in the confirmation box that 

appears. 



Modifying Coded Segments 108 

The segment is then removed from the “Retrieved Segments” window, and the deletion 

can not be undone. 

 

Deleting a coded segment in the “Retrieved Segments” window 

Coding a Segment With More Than One Code 

After having coded a segment, the segment remains selected. It is possible to attach more 

codes to the same segment by simply continuing to drag codes the selected segment or by 

right-clicking on the code in the “Code System” and selecting Code in the context menu 

that appears. 

Another option is to highlight the document segment, activate the codes you want to code 

it with, and then right-clicking on one of the codes and choosing Code with selection. 

The segment will then be coded with all activated codes at once. 

Replacing a Coded Segment 

When reviewing your text analysis, you may decide that the wrong code was assigned to a 

text segment. Or you may decide that the “Code System” is not precise enough, so it is 

necessary to expand the “Code System” and distinguish between different codes. In both 

cases, you will need to replace one code assigned to a text with another. 

1. Click on the coding stripe next to the segment with the left mouse button, thereby high-

lighting the document segment. 

2. Assign the new code to the segment. 

3. Right-click on the older coding stripe and delete it. 

Editing the size of a Coded Segment 

When listed independently from the original text, a coded segment may be difficult to un-

derstand because it is out of context. The segment is probably too small. To extend the 

segment’s boundaries, first click on the code symbol to again select the segment. Then, 

expand the boundaries of the highlighted text by dragging the mouse over the text to be 

included in the segment. Then reassign the code to the text, which you can do by simply 
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clicking on the code button again. The code symbol will change correspondingly. It is also 

possible to use this process to make the coded segment smaller. 

 

Changing the size of the Coded Segment 

7.17 Moving Codes in the “Code System” 

Changing the order and the structure of the “Code System” is not difficult. All codes can 

be moved with the mouse and the drag-and-drop function. 

In the following example, the “Code System” contains four codes (C, B, A, and D). 

 

Moving codes with the mouse 

To move Code D to the top of the list, you would need to do the following: 

Click on Code D and drag it in front of Code A while holding down the left mouse button, 

then, when a line appears, drop the code. 

It is also easy to make a code a subcode of another code. If you want Code B to become a 

subcode of Code A, for example, you would carry out the following actions: 

Click on Code B, drag it to Code A, and release as soon as Code A has a blue background. 

Code B is now a subcode of Code A. 
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Subcodes can also be sorted alphabetically by right-clicking on the code they are subcodes 

of and selecting Sort subcodes. 

7.18 Copying Subcodes 

In some cases, you will be setting up the same subcodes for various codes. You might, for 

example, have the codes “Childhood,” “Teenage Years,” and “Adult Life,” which should 

each have the subcodes “Education,” “Family,” “Friends,” and “Memorable Experiences.” 

So that you don’t have to create these four subcodes three times, you have the option of 

setting them up for one of the main codes, copying its subcodes, and pasting them into the 

other main codes. To do so, you would follow these steps: 

1. Create the three main codes: “Childhood,” “Teenage Years,” and “Adult Life.” 

2. Create the four subcodes for the main code “Childhood.” 

3. Right-click on the Childhood code and select Copy subcodes. 

4. Right-click on each of the other main codes and select Paste subcodes. 

7.19 Moving Code References  

If you move a code from one position in the “Code System” to another, the code refer-

ences move automatically together with the code. This is like moving a drawer from one 

place to another in a cabinet; the drawer’s contents move together. 

To move a complete drawer is something other than to move only its contents. The same is 

true with code references. If you only want to move the code references to another code, 

you cannot use the procedure described above. There is another procedure that leaves the 

drawer in its place and merely shifts its contents. 

In MAXQDA, it is the Move coded segments option that does this job. This option is avail-

able in the context menu of the particular code from which code references are to be 

moved. 

The following figure shows the result of moving coded segments from Code B to Code A. 

Actually, what takes place is the merging of Code A and Code B: 

 

 

To move the coded references from Code B to Code A, follow these steps: 



Codes and How to Code 

 

111 

1. Right-click on Code B in the “Code System.” 

2. Select Move coded segments. This transfers the code references to an internal 

clipboard. (Up to this point, nothing has really changed in the “Code System.” The 

number of coded segments displayed to the right of Code B is still the same.) 

3. Right-click on Code A (the target code) and choose Move coded segments from 

‘Code B.’ MAXQDA asks you to confirm the command before executing it. 

 

Moving coded segments 

Code B remains in the “Code System” until you delete it, but the number of its immediate 

code references is now zero. The contents of the “drawer” have been moved to Code A. 

The subcodes’ references, however, will not have been moved. Be careful when deleting 

Code B now, since all subcodes – if there are any – will be deleted too, along with their 

code references. 

Tip: If you want to delete all code assignments but want to keep the code in the “Code 

System,” it is best to create a code named “trash” and then copy the code references to 

the “trash.” 
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7.20 Copying Code Segments  

The function “Copy coded segments” is similar to the “Move coded segments” function. 

The only difference is that the code references also remain in Code B – that is to say, they 

are duplicated. To do this, follow the steps below: 

1. Move the mouse pointer to the “Code System” and right-click on the code from 

which references are to be copied (Code B in the example above). 

2. Select Copy coded segments from the context menu that appears. 

3. This causes the code references to be moved to an internal clipboard. (Up to this 

point nothing has really happened in the “Code System.” The number of coded 

segments displayed to the right of Code B is still the same.) 

4. Now select the target code (Code A in the example above). Right-click and choose 

Insert coded segments from ‘Code A.’ 

5. MAXQDA then copies the code references to the selected location; no confirmation 

is required. 

7.21 Creating a New Top-Level Code 

A common procedure when working with codes is to group previously defined codes under 

a new, more abstract category, as shown in the next diagram: 

 

 

MAXQDA’s hierarchical “Code System” makes it easy to group existing codes under new 

top-level codes. Reorganizing the “Code System” can be done at any time during the anal-

ysis process: 

1. Create a new code at the top level of the hierarchy (New Code in the example above). 

2. Drag Code B to New Code and release it. 

3. Do the same with Code D. 
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Creating a new code to hold to former codes as subcodes 

7.22 Splitting up a Code 

Often when working with a “Code System,” it is desirable to differentiate between ele-

ments grouped under one code. In MAXQDA this corresponds to dividing a code in two or 

more subcodes. For example, imagine you have created a code named “Family” and have 

assigned document segments, in which an interviewee talks about his family, to this code. 

Then imagine that it becomes necessary to differentiate between “Mother,” “Father,” and 

“Brothers&Sisters.” 

The division of a code into subcodes can obviously not happen automatically, since you 

must decide which references of the code are to be placed in which subcode. You must 

read each coded segment and decide which of the subcodes is appropriate. In this case the 

subcodes will not be exclusive since a person could talk about his father and his mother in 

the same segment. 

 

 

Codes can be divided as follows: 

1. Activate all documents and the code “Family.” 

2. Create three subcodes for “Family”: “Mother,” “Father,” and “Brothers&Sisters.” 
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Splitting up a code 

A convenient way to separate the code references into the new subcodes is to bring all the 

coded segments (in our example with “Family”) into the “Retrieved Segments” window. 

Then, beginning with the first segment, click the information box left of the segment for 

each segment. After having decided which subcode the segment belongs to, you can as-

sign the segment to the appropriate subcode as follows: 

 The easiest option: Click on the information box and drag it to the chosen subcode. 

Tip: During this process, the segment will be additionally coded with the subcode. How-

ever, if you hold down the Alt key during this process, the code will be moved from the 

source code to the new code, meaning the top-level code will be deleted. 

 When you click on the info box, the coded segment will also be selected in the 

“Document Browser.” It can now be coded as usual, for example using Drag & Drop. 

 Alternative Method: Right-click on the selected subcode in the “Code System” window 

(i.e. “Father,” “Mother” or “Brothers&Sisters” in the example above) then select Code 

in the context menu. 

When you reach the end of the list you will all have worked through all the coded seg-

ments and these will have been assigned new subcodes. But all segments will still be coded 

with the original code “Family” too, which is obviously not what you want. To finish the 

job, you have to delete these code references, which may seem tricky, since now deleting 

the code “Family” would also delete its subcodes – including the three subcodes that you 

just created. 

In effect, you need to delete not the code itself but only its references. Since the command 

“Delete Code References” does not exist in MAXQDA’s “Code System,” you have to do a 

work-around to get the desired result: 

1. Create a new code called “trash.” 

2. Right-click on the code whose references are to be removed (in this example “family”). 

3. Select Move coded segments from the context menu. 

4. Move the mouse pointer to the code “trash,” click with the right mouse button, and 

select Move coded segments from ‘Family’. 

5. Delete the code “trash.” 
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7.23 Importing and Exporting the “Code System” 

It is possible to export an entire Code System, and import it into another MAXQDA project 

file. This function is especially useful as it allows you to build a “Code System” in one pro-

ject, then apply it to another. In this case, importing and exporting the “Code System” eli-

minates the need to enter new codes. 

 Right-click on the “Code System” root in the “Code System” window and select Ex-

port Code System. 

 or, select Codes > Export Code System from the main menu. 

The “Code System” will be converted into a specific file format with the extension MTR. 

You can then import the “Code System” into a new MAXQDA project with the correspon-

ding procedure Import Code System. 

7.24 Weight Scores: Indicating Segment Relevance  

When coding a document segment, you are attaching a segment of a text or image to a 

code in the “Document System.” MAXQDA also allows you to assign a weight score to 

each of these coded segments to indicate how important that particular coded segment is. 

It may be that certain coded segments represent a typical argument or theoretical concept 

that you want to be sure and hold on to. In this case, these segments are a sort of signpost. 

MAXQDA allows you to indicate how important or appropriate a segment is for the code it 

is coded with by giving it a weight score between 0 and 100. This weight score could be 

described as a “fuzzy variable,” because it is not meant to give an exact numerical worth 

for the segment. Rather, it is intended to be a guide, so you can later sort your retrievals 

based on the weight assigned. 

Every newly coded segment automatically receives the default weight score, which is 

somewhere between 0 and 100. 

To see what the standard weight score is (or to change it), simply select Options from the 

Project drop-down menu and find the row for “Default weight.” Alternatively, you can 

double-click on the icon in the status bar at the bottom of the MAXQDA screen. 

 

Changing the default weight in the status bar 

The weight of a coded segment is shown in the top right of the yellow info box that ap-

pears next to each retrieved segment in the “Retrieved Segments” window. 
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Weight score 

The “Overview of coded segments” also includes the weight scores for each coded seg-

ment. This weight is saved automatically, so that you can use it later to limit the results of 

your segment retrievals. 

Assigning Weight Scores in the Document Browser 

Right-click on the coding stripe for the coded segment that you would like to alter the 

weight score for. You can then select Modify weight. You can then enter a number be-

tween 0 and 100. 

How the weight scores are used is completely up to you. You could choose to have a sys-

tem where a weight score of 1 is the highest or where 100 is the highest. 

 

Changing the weight score in the “Document Browser” 

Assigning Weight Scores in the “Retrieved Segments” Window 

A weight score can also be assigned and modified in the “Retrieved Segments” window. 

Right-clicking anywhere on the information box left of the coded segment opens the con-

text menu, where you can select Modify weight and enter a number between 0 and 100. 

 

Changing the weight score in the “Retrieved Segments” window 

You will be able to see the newly-entered weight score in the top right of the yellow info 

box directly after you make the change. 
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Updated weight score 

Changing Weight Score in the “Overview of coded segments” 

In the “Overview of coded segments” table, you will find a column for the weight score of 

each coded segment. By double-clicking on a cell in the column, you will be able to enter a 

new weight between 0 and 100. 

7.25 Creating Comments for Coded Segments  

You have the option of creating a short comment (maximum of 127 characters) for each of 

your coded segments. This might be an overview of the coded segment or a comment 

about its significance for your analysis. These comments are then shown in the tooltip that 

appears when you hover the mouse over a coding stripe. 

To create a comment for a coded segment, follow these steps: 

 Double-click on the little circle in the middle of the coding stripe, 

 double-click on the yellow info box next to a coded segment in the “Retrieved Seg-

ments” window, or 

 enter your comment directly into the appropriate row of the “Comment” column in the 

“Overview of coded segments.” 

You can easily see if a comment has been written for a coded segment when you look at 

the code symbol. Normally the inner part of the little square is white in color, independent 

of the color of the code symbol. When a comment is attached, the inner square appears in 

the same color as the outer line of the symbol. 

 

A coded segment comment shown in the tooltip when hovering over the circle in the middle of a coding 

stripe 
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If you import coded segments into MAXMaps, the mapping tool of MAXQDA, the com-

ments are used as labels. Thus, with regard to the creation of maps and models in later 

stages of your analysis, writing meaningful comments can be very important. 

Finding your Coded Segment Comments 

As long as you haven’t changed the standard view, you can find all of your code comments 

in the “Overview of coded segments” table in the second column. You can also insert new 

comments and delete/change old ones from this view. By right-clicking on the column 

header, you will have the option of clicking on the Search function. You can then start typ-

ing the first word in the comment you are looking for. If you want to search for a word that 

appears somewhere in the comment, not necessarily at the beginning, you can simply start 

the search string with the “*” symbol. 

7.26 Creating Code Sets 

With MAXQDA, temporary combinations of codes can be saved as code sets, permitting 

the user to group the same code in different ways, or to group frequently used codes in a 

hierarchical tree structure for increased accessibility. The code sets are linked only to exist-

ing codes, meaning that the removal of a code from a set has no further consequences. 

To create a new code set, right-click on the word “Set” in the Code System, then select 

New set. 

 

Create a new code set in the “Code System” 

Now you can drag and drop selected codes into the new set using the mouse 

Tip: If you activate codes by holding down the Ctrl key before you create a new code set 

MAXQDA places the activated codes directly into the new code set. 

7.27 Frequency of Codes  

It might be of interest to take a look at how many times each code was used. This function 

is called Frequency of codes and can be found in the Codes drop-down menu. 
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Opening the Frequency of codes in the Codes menu 

The following table is opened. It has as many rows as there are codes and subcodes in the 

“Code System.” The column Code-ID contains program-intern sequential IDs given to all 

codes, the column Position shows the actual position in the “Code System,” counting from 

the root of the “Code System.” 

 

Frequency of codes 

The other columns consist of: 

 All coded segments – Number of segments coded with this code (throughout the 

whole project). 

 Activated coded segments – Number of segments coded with this code in current 

activated documents (code needs to be activated). 

 All coded segments % – Relative frequency of “All coded segments.” 

 Activated coded segments % – Relative frequency of “Activated coded segments.” 

 Documents – Number of documents in which the code appears 
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Right-clicking a row opens a context menu with various options, you can open the Over-

view of coded segments or Overview of linked memos, for example. You can also 

change the color attribute of a code from this menu. 

To show the frequency of codes for specific documents or document groups, they have to 

be activated. You can do this while the table is opened, doing so will change the values of 

Activated coded segments on-the-fly. 

 

The number of segments coded with code Emotions 

You have the option to export the table in various formats: 

 As an Excel table in XLS/X format. 

 In TXT tab-delimited format. 

 In HTML table format. 

 You can also simply highlight all or sections of the table, copy it to the Windows clip-

board with Ctrl+C, and paste it into another program (e.g. Microsoft Word). 

7.28 The „Overview of Documents“ for a Code  

To answer the question in which documents or document groups a certain code was used, 

MAXQDA gives you the option to use the “Overview of documents.” To show this over-

view, right-click on a code and choose Overview of documents from the context menu. 
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The “Overview of documents” in the context menu 

A tabular list of all documents that have segments coded with the chosen code will open. 

In the following example, the code “Day-to-Day Issues\Emotions” was used in ten 

documents and two different document groups. The column “Number of coded segments” 

shows how many coded segments were found in each document. 

 

“Overview of documents” for a code 

You have the following options: 

  Show as Excel table – saves and opens a table in XLS/X format. 

  Show as HTML table – saves and opens a table in HTML format. 

  Export – opens a dialog window, so you can save the table in XLS/X, HTML, or tab-

delimited text format. 

The Aggregate to document groups  button allows you to reduce the visualization 

to document groups that segments with the chosen code were found in. Taking the exa-
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mple above, after clicking the button, the table will consist of two rows with the document 

groups “New York” and “Indiana.” The number of coded segments will be added up: 

 

Aggregating to document groups 
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8 Intercoder Agreement 

8.1 About Reliability 

When assigning codes to document segments, it is recommended that certain criteria be 

set. You assume, for example, that coding is not arbitrary or random, but rather that a cer-

tain level of reliability will be reached. The “Intercoder agreement” function makes it possi-

ble to compare two people coding the same document independently of each other. In 

qualitative research, the purpose of comparing independent coders is to discuss the differ-

ences, figure out why they occurred, and learn from the differences in order to improve 

coding agreement in the future. In other words, the actual percentage of agreement is not 

the most important aspect of the tool. This percentage is, however, provided by MAXQDA. 

8.2 The Intercoder Reliability Problem in Qualitative 

Research 

It is always the goal of qualitative analysts to achieve as high a level of agreement as possi-

ble between independent coders. It is not, however, focused on getting to a standard coef-

ficient that is statistically necessary as in quantitative research. Rather, the focus is on a 

practical improvement of the coding quality. For this reason, one doesn’t focus on the coef-

ficient or percentage of agreement. Instead, qualitative researchers want to address and 

edit the coded segments that do not agree, so that they can move on with more accurately 

coded material. 

The Intercoder Agreement tool is set up to compare and contrast a single document coded 

by two independent coders, highlighting the areas where the two researchers’ coded seg-

ments align and do not align. It is then possible for these two coders (or a larger research 

team) to decide which coding variation in each situation is most accurate. 

8.3 The Agreement Testing Concept in MAXQDA  

The Intercoder Agreement function in MAXQDA works as follows: 

1. Two people code the identical text independently of each other with the agreed upon 

codes and code definitions. This can be done on the same computer or on different 

computers. The most important thing is that the two coders can not see how the other 

has coded. It makes sense to name each document in a way that makes it clear, who has 

coded which (e.g. “Interview1_Michael” and Interview1_Jessica.” 
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2. To test the two documents, they must both be in the same MAXQDA project. If they 

were coded on different computers, the two projects can be merged. It is also possible 

to use the teamwork functions to only exchange codes, memos, and variables. 

You can now start the Intercoder Agreement function by selecting it from the Analysis 

drop-down menu. 

 

Starting the Intercoder Agreement function via the Analysis menu 

Caution: If you only want to check the agreement of certain codes, activate those codes 

before starting the test. 

1. Select the first coder’s document from the “Document 1” menu and the second coder’s 

document from the “Document 2” menu. 

2. If you only want to test the activated codes, you can check the box at the bottom left of 

the window next to “Only for activated codes?” 

3. You can then choose between three different analysis criteria for the agreement test: 

Variation 1 – Code existence in the document 

The criterion in this variation is the presence of each code in the document, meaning 

whether or not each code is found at least once in the document. This variation is most 

appropriate when the document is short, and there are many codes in the “Code Sys-

tem.” 

Variation 2 – Code frequency in the document 

The criterion in this variation is the number of times a code appears in each coder’s ver-

sion of the document. 

Variation 3 – Segment agreement in percent 

In this variation, the agreement of each individual coded segment is measured. This is 

the most precise criterion and is used most often in qualitative research. You can set the 

percentage of agreement that is required in each segment for it to be considered in 

agreement (correlation). The tool takes each segment and evaluates the level of agree-

ment between the two documents. 
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Testing intercoder agreement based on segment agreement in percent 

The screenshot above shows the Intercoder Agreement window, which shows that “Inter-

view Mary _ Elizabeth” will be compared with “Interview Mary _ Ian.” The third variation is 

selected, meaning agreement will be tested at the segment level, and the required agree-

ment percentage to be considered “in agreement” or “correlating” is 90. 

Results for Variation 1 

The Code Matrix Browser window will appear only for the two documents that are being 

compared. The Code Matrix Browser is set to visualize whether or not each of the codes 

exists in the two documents. If the code exists, a blue circle or square will be shown in that 

document’s column. 

 

Testing the existence of codes in two documents 

The screenshot shows the results. Codes such as “Day-to-Day Issues” and “Key Quotes” 

exist in both of the documents, but the code “Interview Guide Topics” only exists in the 

document coded by Ian. 

Clicking on one of the blue symbols selects the corresponding document in the “Docu-

ment Browser” and the corresponding code in the “Code System.” Double-clicking on the 

symbol opens the document, highlighting the coded segment. 
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At the top of the results window, you can see the percentage of agreement. In this case, 

there is a correlation of 65%. 

Results for Variation 2 

The results for the second variation are also shown in the Code Matrix Browser for the two 

documents to be compared. Results can be viewed either as symbols or as numbers. It is 

then fairly easy to see where there is agreement between the documents. The correlation 

percentage is shown again in at the top of the results window. For each code, the number 

of times it appears in each document is compared. If the number is the same, there is 

agreement. If the number is not the same, there is disagreement. It makes no difference in 

this case whether the difference between the two numbers is 1 or 100. 

Tip: MAXQDA calculates Intercoder Agreement for the first two variations as follows: 

% Agreement 

   = # of agreements / (# of agreements + # of non-agreements)  

   = # of agreements / # of rows 

Results for Variation 3 

This is the most complication variation, since intercoder agreement is tested on the seg-

ment level. If the first document has 12 coded segments and the second document has 14, 

there will be 26 tests carried out and presented in 26 rows of a table. 

It is necessary to decide how similar the coded segments must be to be considered in 

agreement. This is measured in percent and can be set in the bottom right of the Intercoder 

Agreement window. The default is set at 90%. 

Two results tables are created: the code-specific results table and the detailed agreement 

table. 

a) Code-Specific Results 

 

The Intercoder Reliability results for the individual codes 

This table is made up of one row for each code that was included in the test. It shows the 

level of correlation between the two coders for each code. This can make clear, for exam-

ple, if certain codes are in disagreement more than others. Every code is shown in a row 
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with the number of times its use in the first document correlated with the use of the code 

in the second document, the number of times they did not correlate, and the total percent-

age of correlation. 

b) Detailed Agreement Table 

The second results table allows you to see exactly which coder coded which segment and 

whether the coded segments correlate. A red “x” in the first column shows that the coded 

segments do not agree. Clicking on the column header sorts the rows, showing all the non-

correlating segments first, so the coders can analyze and discuss each of them step-by-step. 

By double-clicking on the box in the “Document 1” column, you can open that document 

and call up the exact document segment in question in the “Document Browser.” Double-

clicking on the square in the “Document 2” column brings up the segment in the second 

document in a new tab, showing the place where the correlating (or non-correlating) coded 

segment is. You can now very easily switch back and forth between the documents in the 

two tabs to analyze which of the coded segment variations is the most accurate. 

 

Results table for all coded segments 



About Memos 128 

9 Memos: Managing Your Ideas 

9.1 About Memos 

MAXQDA makes it possible for you to create “Post-It”-like notes with your ideas, com-

ments, etc. and to attach them to document segments, documents, document groups, im-

ages, or codes. These notes are called memos in MAXQDA. These memos can have various 

functions: they are commonly used, for example, as an integral part of Glaser and Strauss’s 

Grounded Theory analysis method. You can also differentiate between various types of 

memos within MAXQDA that then have different roles in your analysis. It is important to 

recognize the difference between memos and documents: documents are analyzed and 

coded, but they are usually not changed radically once the analysis has begun. 

Memos, on the other hand, are a dynamic form of text. They are created by the user and 

can be modified and integrated at any time during the analysis process. 

In MAXQDA memos can be attached to 

 documents 

 document groups 

 document segments 

 images 

 audio and video files and 

 codes. 

There is also the option of creating a “free memo,” which is not attached to anything other 

than the project. These free memos also come out of Grounded Theory, which has memos 

without a any concrete connection to a part of the data. 

9.2 Memos Attached to Document Segments or Images 

Document segment memos can be attached to any line of a document viewed in the 

“Document Browser.” To create a new memo, double-click in the memo column just to the 

left of the paragraph numbers in the “Document Browser” in the line that you want to cre-

ate the memo. 
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Creating a new memo 

You will then see the memo window: 

 

The memo window 

You can now enter a title for the memo, so that you can easily find it later in the Memo 

Manager. 

The memo title also appears in the tooltip that appears when you hover the mouse over the 

memo symbol in the Document Browser. 

When creating a memo, you can simply move from one field to the next, entering all the 

information that is required. MAXQDA automatically inserts the currently logged in user as 

the “Author,” so that you can later find all memos by author. You also have the option, 

though, of changing the name in this field. 

The memo’s “Creation date” is also inserted automatically and appears in the top right of 

the memo tooltip when you hover over the memo symbol. 
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Ever memo can be given the standard yellow “Post-It”-style symbol or one of the 10 other 

available symbols. These options allow you to indicate what type of memo it is. The follow-

ing visualizations are available: 

 

Memo visualization options 

Choosing different visualizations for differing types of memos is up to each user. Those us-

ing Grounded Theory, for example, might choose to use the visualization with a “T” to rep-

resent theoretical memos, the visualization with an “M” for method memos, etc. 

You can also link each memo to codes from the “Code System.” 

The actual memo can be typed into the large text field at the bottom of the memo win-

dow. Memos can be edited in Rich Text Format, meaning you can set the font style and 

size; use underline, italics, and bold; and change alignment options. You can also keep 

track of your additions to the memo by clicking the  symbol, which automatically inserts 

a date and time stamp. If you want to insert a section of text from another document, you 

can simply copy it and paste it into the memo field. You can also simply highlight the text 

and drag it in. 

When you are finished with the memo, you can close the window by clicking on the x in 

the upper right hand corner or by clicking on the  symbol. The memo will now be visu-

alized in the memo column in the “Document Browser.” 

The actual memo text can be as much as 64 KB, which is about 20-30 pages of text. There 

is no limit to the number of memos you can create in each document. You should remem-

ber, however, that when you open a document in the “Document Browser,” the memos 

are opened as well. If you have 1,000 memos in one document, this document won’t open 

as fast as one without any memos. 

Attention: Document segment memos are assigned to a specific paragraph number. If you 

delete this paragraph of text while in Edit Mode, however, the memo will not be deleted. 

Instead, it will be attached to the new paragraph next to it. The memo is not deleted in 

order to avoid any accidental deletions of important notes that you have made. 

Tip: Memos can be moved from one paragraph to another in the “Document Browser” via 

drag and drop, but must remain in the memo column. 
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9.3 The Memo Window and Toolbar  

Wherever you see a memo, you can double-click on it to open it. In the toolbar at the top 

of the memo window, you have the following functions: 

  Print memo 

  Export memo as an RTF file 

  Delete memo 

  Assign a code from the code quick list 

  Delete code assignment 

If you double-click on several codes in a row, they will be opened in different tabs within 

the memo window. You will probably recognize the tab system from your internet browser 

– it allows you to have various documents (in this case memos) open at the same time and 

quickly switch between them. Clicking on the x symbol in the tab row closes that tab. 

 

The memo window 

9.4 Creating Document Memos in the “Document System” 

Memos can also be attached to aspects of the “Document System.” Right-click on the 

name of the “Documents” icon, a document group, or a document, and select Memo. The 

memo dialog box appears in its usual form. 
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Creating a memo for a document from the context menu 

Once created, the memo icon will appear next to the entry in the “Document System” and 

can be opened and modified by double-clicking on it. You can also create a memo with the 

shortcut Ctrl+M when a document or document group is selected. 

 

Visualization of a memo in the Document System 

A memo attached to the “Documents” icon can be used as a memo or description of the 

entire project. The memos for each document could be used for overviews of those docu-

ments. You can also see the first few lines of a memo by hovering your mouse over it until 

a tooltip appears. It is, therefore, a good idea to have the most important aspects of a 

memo in the first few lines. 

9.5 Linking Codes to Memos  

Similar to document segments, memos can also be linked to a code. You can do this via the 

Code Quick List, which is symbolized by the blue arrow in the memo toolbar. Clicking on 

this symbol opens the most recently-used codes, so you can choose which ones to assign to 

the memo. If the code you are looking for is not in the Quick List, simply click on the code 

in the “Code System” and try again. The code should now be listed at the top of the list. 
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Linking a memo to a code 

The linked code is then displayed with its complete path (code\subcode\subcode) in the 

Codes area in the top right of the memo window. 

If you later decide to remove a linked code, simply click on the code in the memo window 

and click on the toolbar symbol of the blue arrow with a red x on it. 

9.6 Viewing and Editing Memos 

The memos attached to a document are visible when the document is loaded in the “Doc-

ument Browser.” When the mouse cursor is moved over the memo icon next to the docu-

ment, an information box appears with the memo title, author, creation date and time, and 

the beginning of the memo. 

If you double-click on the memo icon, the memo dialog box will open again and you will 

be able to modify the memo. You can also click on the memo with the right mouse button 

and select Open from the context menu to open the memo. 

To delete a memo, click on the Delete button in the memo dialog box. You have to con-

firm the command before MAXQDA removes the memo from the document. 

You can also move memos in the “Document Browser” from one paragraph to another. 

Simply click on the memo and drag it to the new location. Memos in the “Code System” 

and “Document System” cannot be moved. 

Note: Changes to a memo will be saved when the memo is closed. It is therefore recom-

mended to close memos periodically during the editing process if major changes are being 

made. 
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9.7 Creating Code Memos in the “Code System”  

MAXQDA also allows you to attach memos to codes. These memos often contain the defi-

nition of a code or are used to organize the codes. Since code memos are part of the 

“Code System,” they are managed in the “Code System” window, and can be created by 

right-clicking on a code. 

Example 

Let’s say that you wanted to create a memo with a code definition – and later for an an-

chor example – for the code “Insurance.” You would just need to right-click on the code in 

the “Code System” and select Code memo. The memo window then appears. 

 

Creating a code memo 

After closing the memo, you will see it visualized next to the code in the “Code System.” 

For code memos, you will often want to insert an anchor example or explanation of when 

the code should be used. 

As with other memo types, you can choose one of the 11 different visualization options, 

which will then be displayed next to that code. 

9.8 Memos and the Windows Clipboard 

When working with memos in MAXQDA, the Windows clipboard can be used in the same 

way as with text documents. This makes it easy to exchange text between MAXQDA and 

word processing programs. 

The Windows clipboard may be used in two ways: 

 Text can be imported into a MAXQDA memo. Select the text in the word processing 

program, copy it with Ctrl+C to the clipboard, and insert it with Ctrl+V into the memo. 

 Text can be exported from a MAXQDA memo. Select the memo text or a part of it, copy 

it to the clipboard, and paste it into the word processing document. 
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Copying, cutting, and pasting can be done in MAXQDA and with other Windows programs 

with the shortcuts Ctrl+C, Ctrl+X, and Ctrl+V. In some Windows programs, you can also 

perform these actions with the Edit drop-down menu. 

9.9 Printing and Exporting Individual Memos 

Individual memos can be printed or exported. In the memo window, there are icons for 

both: Print  and Export . 

Clicking the Print icon causes the memo to be printed out. The memo title is set as the 

heading, and the author and creation date/time are listed underneath it. You can also 

choose to only print out certain pages. 

It is also possible to export the entire memo as a Rich Text Format document. Clicking on 

the export icon brings up a Windows dialog field, so that you can choose what to name the 

file and where it should be saved. 

NY Interview Notes 

 

Document group  New York 

Author  Marissa 

Creation date 11.02.2011 09:52:38 

 

There were very few interruptions during our interviews in NY. All of them took between 60 and 90 minutes, 

and none of the interviewees seemed overly nervous to be talking to us. 
 

An exported memo 

9.10 The Memo Manager  

Memos aren’t only accessible from their location next to documents, codes, document 

segments, etc. They are also available as an “Overview of memos” in the Memo Manager. 

You can access these overviews in various ways. An overview of all memos in the entire 

project can be called up by selecting Memo Manager from the Memos drop-down menu 

or by clicking on the  symbol in the “MAXQDA standard” toolbar. 

The “Memos” drop-down menu also offers several other options for selecting memos to be 

viewed: 

 All my memos – lists all memos created by the user currently logged in. 

 My code memos – lists the code memos created by the logged in user. 

 My document memos – lists all memos created by the logged in user that are attached 

to documents. 
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 Memos of the opened document – lists only those memos connected to the docu-

ment currently open in the “Document Browser.” 

 New free memo – creates a new memo unattached to any document, group, seg-

ment, or code. 

To see all memos linked to a certain code, right-click on the code and select Overview of 

linked memos from the context menu. 

However you open the Memo Manager or the “Overview of memos,” a table will appear 

with a list of the requested memos. Each row represents one memo. If you click on a 

memo that is attached to a document segment, the appropriate document will be opened 

in the “Document Browser” at the exact location of that memo. Double-clicking on the 

memo opens it for editing. 

The columns in the table contain all important information about the memo, including: 

 The name of the document and document group in which the memo is found (or the 

name of the code in the case of a code memo). 

 For memos attached to document segments, the paragraph number of that segment is 

listed. 

 The author of the memo. 

 The creation date. 

 A preview of the memo text made up of the first 64 characters 

 The origin of the memo (e.g. the document, document group, document segment, or 

code the memo is attached to). 

 

The “Overview of memos" 

As usual in MAXQDA, the columns of the table can be sorted according to any field in the 

table, either in ascending or descending order. Simply left-click on the header of the col-
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umn according to which the table is to be ordered. You can also change the order of the 

columns in the table by dragging any column to another position with the mouse. 

You can also choose which columns should be included in the table. By right-clicking on 

any of the column headers, you will have the option to choose Select fields. You can then 

check the box next to the columns that you wish to view and uncheck the boxes of any 

columns you want to hide. You can also sort the table according to a column by clicking on 

the column header. 

MAXQDA also allows you to search in various columns. Right-click on the column header 

and select Search. You can then enter the word you are searching for into the field. If the 

word you are searching for is not necessarily the first word in the string, you can insert a 

“*” symbol in front of the word. If you enter a search string of “Kennedy,” for example, it 

will not find the entry “John F. Kennedy,” since “Kennedy” is not the first word. A search 

for “*Kennedy,” though, would bring it up. 

9.11 Jumping from a Memo to a Document 

From each memo displayed in MAXQDA’s Memo Manager, you can jump to the position in 

the document that the memo is attached to. You need only click on the desired memo 

with the left mouse button. The source document immediately appears in the “Document 

Browser” positioned exactly at the place where the memo is found. 

This option only works with memos attached to document segments, of course. If you click 

on a code memo, the “Document Browser” remains unchanged, but the code is high-

lighted in the “Code System.” The same happens with memos that are attached to objects 

in the “Document System.” 

 

Jumping from a memo to a document 
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9.12 Searching for Text in Memos  

The Memo Manager allows you to search in each of the columns, but you are limited by 

the fact that the preview only includes the first 64 characters of the memo. Searching the 

complete memo text is only possible with the lexical search function. 

The lexical search procedure is described in detail in Section 13. The only difference is that 

you have to select the option to search In memos so that MAXQDA searches there and not 

in the documents. 

 

Searching for “health” in the project memos 

The results are shown as a list of all memos that contain the search string in the memo text. 

This table can be worked with as described above. You can sort, jump to the document, 

edit the memos, etc. 

9.13 Selecting Specific Memos  

The MAXQDA “Memos” drop-down menu includes the following functions: 

 Memo Manager – opens a list of all memos in the entire project. 

 All my memos – lists all memos created by the user currently logged in. 

 My code memos – lists the code memos created by the logged in user. 

 My document memos – lists all memos created by the logged in user that are attached 

to documents. 
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 Memos of the opened document – lists only those memos connected to the docu-

ment currently open in the “Document Browser.” 

 New free memo – creates a new memo unattached to any document, group, seg-

ment, or code. 

To see all memos linked to a certain code, right-click on the code and select Overview of 

linked memos from the context menu. 

However you open the Memo Manager or the “Overview of memos,” a table will appear 

with a list of the requested memos. Each row represents one memo. If you click on a memo 

that is attached to a document segment, the appropriate document will be opened in the 

“Document Browser” at the exact location of that memo. Double-clicking on the memo 

opens it for editing. 

9.14 Viewing Memos Linked to a Code 

Codes can be linked to memos in order to indicate what the memo is about. Of course, you 

can choose a descriptive title for a memo, based on the content of the memo, but to attach 

codes is a more systematic way to attach more thematic topics than could be formulated in 

a memo’s title. 

To find all memos that are linked to the same code, right-click on the code in the “Code 

System” and select Overview of linked memos from the context menu that appears. 

The result is a table of memos. The table contains all the memos to which the code is at-

tached. As usual, double-clicking on a row opens the memo and a single click brings the 

source document into the “Document Browser” window. 

The table can be sorted according to its columns and it can be exported to other programs. 

9.15 Memos in a Specific Document or Document Group 

The memos belonging to a particular document group, document set, or document can be 

viewed in a table. Right-click on the selection and choose Overview of memos from the 

menu that appears. 

MAXQDA will then open a table similar to the Memo Manager table containing all the 

memos attached to these document(s). As with the Memo Manager, it is possible to sort 

the table, search in the different columns of the table, jump to the source document, and 

export the table or parts of it to an external file or to the clipboard. 
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9.16 Exporting a Selection of Memos  

The result of a search for specific words in memos is a table listing all the memos contain-

ing the words. The same type of result, memos in a table, is obtained through a search for 

linked memos or when viewing the memos attached to a document or document group, as 

described above. 

These tables of memos can be exported, that is saved as a file to be opened with another 

program. You can save the table in XLS/X, RTF, or HTML format. Click on one of the Export 

buttons located in the upper left corner of the dialog box, and choose appropriate the for-

mat. 

The exported RTF file appears as follows: 

 
Title  Life strategy and mental health 
Document New York\Vincent 
Paragraph 9 
Author  Marissa 
Creation date 12.02.2011 
 
 
Again, this touches on Vincent's life strategy. He is able to maintain “strong mental health” and have a positive 
attitude even though he realizes he's “an accident waiting for a place.” Again, it seems like his previous life 
strategy enabled him to successfully deal with the situation. 
 
Is it just Vincent's PMA that enabled him to cope, or is there something more? Other people use religion or a 
support network (friends, family, etc.) to get through tough situations - is that the same sort of thing going 
on??? 

 

Part of an exported memo table in RTF format 

Here you see all the information contained in the memo, such as memo title, creation date, 

and linked codes as well as the memo text itself. The exported RTF file can be opened in 

your word processing program to add layout features like headers and footers. 

If you choose HTML or XLS/X as the export format, MAXQDA creates a table that is imme-

diately opened in your default web browser such as Internet Explorer or Excel. It is also easy 

to print out the list in these formats. 
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Results of a memo export in HTML format 

Tip: The entire table with all of your memos will be exported unless you have selected some 

of the memos, which are then marked yellow. You can select a single menu by clicking on 

it with your mouse. If you want to select more than one, hold the Ctrl button as you click 

on them. If you want to select a number of memos that are right next to each other in the 

list, click on the first one, hold Shift, and then click on the last one. All of the memos in 

between the first and the last will also be included in the selection. 

 

Selected memos are yellow in the memo table 

9.17 Converting a Memo into a Document 

Since memos are used to assist in the development of ideas and hypotheses, it could hap-

pen that they quickly become very important to your analysis. In some cases, these memos 

may be important enough that you would want to convert them into documents, so they 
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could be analyzed and coded. It is only possible to associate an entire memo with codes, 

while every single character of a document can theoretically be coded as many times as 

needed. 

To convert a memo into a document, follow these steps: 

 Open the Memo Manager 

 Select the memo(s) to be transformed 

 Right-click on the memo 

 Select Convert to a document 

The newly-created document will now be listed as the first document in the “Document 

System.” The first lines of the document are the former memo’s title, author, and creation 

date. 



Variables 

 

143 

10 Variables 

10.1 Document and Code Variables in MAXQDA 

MAXQDA differentiates between “document variables” and “code variables”: 

Document Variables  

Document variables are associated with an entire document, (e.g. the person interviewed in 

an interview transcript). In these cases, you can assign socio-demographic information like 

gender, age, education level, etc. that can then be analyzed in conjunction with the actual 

text. 

In the following example, the age and gender of all five respondants was noted, in addition 

to whether they were members of an NGO: 

 

Example of application of Document Variables 

Code Variables  

Since the document variables are always connected to an entire document, it isn’t possible 

to assign several values for each document variable. If a transcript includes various inter-

viewees, as would be the case in a group discussion, document variables are not enough. In 

these cases, one would want to assign variables for each speaker. In these cases, you can 

use code variables, which make it possible to input as many different sets of variables as 

you wish within a single document. The term “code variable” indicates that the variables 

are actually assigned to a code rather than to a document. In a group discussion, you can 

create a code for each speaker and then assign variables for that speaker’s code 

The development of code variables in MAXQDA makes it possible for you to set variables 

for a section of a document rather than the entire document. As with document variables, 

code variables can then be used as selection criteria during the analysis process. 

These sections of a document can, for example, represent a certain speaker in a group dis-

cussion, for whom you would like to assign certain variables, such as age, income, educa-
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tion level, etc. You can then choose to only see what people between the ages of 50 and 

60 with an annual income of $50,000-$75,000 said about a certain theme. 

Working with code variables requires that you have already coded the specific sections of a 

document as having been spoken by a certain person (e.g. things John Smith said would be 

coded as “Smith” or “JS.”) 

It is then necessary to create a top-level code, such as “Participants” as shown below. 

“James,” “Gracie “Riley” and “Lucy” represent the individual people that speak at differ-

ent points in the documents. 

 

Top-level code “Participants” with the individual people as subcodes 

Each participant in the group discussion - each subcode - can now be assigned a variable 

value. As displayed in the image, the age, profession, and “Outlook on life” have been de-

fined: 

 

Example of application of Code Variables 

10.2 The “List of document variables” and the “List of code 

variables”  

MAXQDA allows you to add variables to each document and code. 

Two views are available from which to manage variables: The “List of variables” and the 

“Data editor.“ In the “List of variables,” all variables defined within the project are listed in 

a table. The “Data editor“ presents the data table as a square matrix showing “Rows x Co-
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lumns,” similar to a statistics program. The documents or codes are displayed in the rows of 

the table, with the variables being displayed in the columns. 

The “List of document variables” 

The “List of document variables” can be called up from the menu Variables > List of 

document variables. 

When you open the “List of document variables” in a newly created project, the system 

variables displayed in the image are already defined: 

 Document group – contains the name of the document group that a particular docu-

ment is a part of 

 Document name – contains the name of the document 

 Creation date – contains the date the document was imported/created 

 Number of coded segments – contains the number of coded segments in the docu-

ment 

 Number of memos – contains the number of memos in the document 

 Author – the user that was logged in when the document was imported or created 

 Bytes – the size of the document in bytes 

 

System Variables in the “List of document variables” 

The system variables are indicated with a red symbol in the first column of the list of variab-

les. System-defined variables cannot be modified or deleted. User-defined variables are in-

dicated with a blue symbol in the first column - these variables can be modified or deleted 

as desired. 

The “List of code variables” 

The “List of code variables” can be called up from the menu Variables > List of code va-

riables. 

When you open the “List of code variables” in a newly created project, the system variables 

displayed in the image are already defined: 
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 Code-ID – Unique code identification number in this project 

 Position – Position of the code in the Code System 

 Parent code – Names of the codes at the following (higher) level (if applicable) 

 Code – Code name 

 All coded segments – Number of segments coded with this code 

 Activated coded segments – Number of segments coded with this code in current 

activated documents (code needs to be activated) 

 Author – User who created the code 

 Creation date – Date and time at which the code was created 

 All coded segments % – Relative frequency of “All coded segments” 

 Activated coded segments % – Relative frequency of “Activated coded segments” 

 Documents – Number of documents in which the code appears 

System variables can not be modified here; for example, the name of a participant, if 

misspelled, can be modified only in the “Code System” and not in the “List of variables.” 

 

System variables in the “List of code variables” 

Sorting the “List of variables” 

The list of variables can be sorted in alphabetical or reverse alphabetical order just like any 

other table in MAXQDA. Simply click once or twice on the column header you would like to 

sort by. 
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The Toolbar 

Both the “List of document variables” and “List of code variables” can be managed from 

the toolbar, which contains identical symbols for both lists. 

  Show as Excel table – saves and opens a table in XLS/X format with the rows you 

have selected in the variable table. 

  Show as HTML table – saves and opens a table in HTML format with the rows you 

have selected in the variable table. 

  Export – opens a dialog window, so you can save the selected rows of the variable 

table in XLS/X, HTML, or tab-delimited text format. 

  Import data – allows import of spreadsheets in XLS/X or TXT format. 

  Variable view – switches from variable to data view. 

  New variable – creates a new variable. 

  Delete variable – deletes selected variable. 

  Transform into binary variable – converts selected variables into dichotomous vari-

ables. 

  Transform into string variable – converts selected variables into string variables. 

  Statistic of document-/codevariables – calls up the Statistics and Graphics function 

for the indicated variable. 

10.3 Add new variables 

You can add new variables to both the “List of document variables” and “List of code vari-

ables”: 

1. Select List of document variables or code variables from the Variables drop-down 

menu 

2. Click on the New variable  icon in the toolbar or use the shortcut Ctrl+N. 
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Creating a new variable with the icon in the toolbar 

Es erscheint darauf das folgende Fenster: 

 

Defining a new variable 

You can now insert a name for the variable and choose its type. There are five different 

types of variables to be chosen from: 

 String (text) 

 Integer 

 Floating point (number) 

 Date/time 

 Boolean (false/true) 

When creating an integer variable, you also have the option of defining whether it is a met-

ric or a categorical variable. The variable for age, for example, can be handled in various 

ways: if you want to enter the age in years, you are dealing with a metric variable, for 

which you may want to establish a mean. If you have defined ages into categories (e.g. 1 = 

under 18, 2 = 18-30, 3 = 31-50, 4 = 51+), then you are dealing with a categorical variable, 

for which you would not want to find a mean value. 

You can also select what value should be inserted automatically for those cases where there 

is a missing value. This is especially important if you are planning to later export the data to 

a statistics program. 
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Tip: To avoid confusion, it is recommended that you do not create two variables with the 

same name. Statistics programs do not allow for this, which could cause problems later if 

you attempt to export data from MAXQDA to that program. 

If you are planning to later export the data to such a program, it is recommended that you 

choose integer as your variable type if you aren’t sure which to use. SPSS can now auto-

matically transform a string into a numerical variable, though, which allows you to create a 

more user-friendly string variable. For example, it is easier to avoid confusion, when you see 

“Gender = Male” rather than “Gender = 0.” 

Note: Document variables are created for the entire project, which means you cannot cre-

ate different variables for each document group. 

The number of variables is not limited; you may add new variables or remove them when-

ever you’d like. However, MAXQDA is not designed to be a statistical program, but rather a 

program for qualitative data analysis and mixed methods approaches, where working with 

more than 100 attributes is rather unusual. 

When creating a name for your variable, it is important that you think ahead. MAXQDA lets 

you create a name with up to 64 characters, and there aren’t any syntax rules, meaning you 

can use several words with spaces and special symbols. 

Tip: If you are planning on exporting your variables later to another program, though, you 

should check on this other program’s requirements. Many statistics programs are more re-

strictive; SYSTAT/MYStat, for example, only allows for variable names with eight or fewer 

characters, as was the case with earlier versions of SPSS. The variable names are also often 

used in MAXQDA’s visual tools (usually as column headers), so long variable names can also 

take up more space than you would want them to. 

10.4 Changing Variable Types 

MAXQDA allows for changes in variable types for existing variables: 

 Document variables, which display how often a code exists (their source is acknowl-

edged as “code”) can be transformed into a binary variable by clicking on the  but-

ton. After it is transformed the variable only contains the values 1 and 0, stating if a 

code has been assigned in this document or not. 

 User defined variables “Integer,” “Floating Point,” “Date/Time” and “Boolean” can be 

transformed into string variables (text) by clicking the . 

Transforming a variable to binary or string cannot be reversed. 
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10.5 Renaming and Deleting Variables 

Variables can be given a new name at any time. Double-click on the variable, and enter 

the new name. 

 

Renaming a variable in “List of document variables” 

Renaming a variable has no effect on the values stored in the variable’s column, but it does 

have an effect on the saved specifications for the activation by variable function (Activate 

by document variable and Activate by code variable). This procedure can save logical 

search formulas using variables to a file. These files are not refreshed when you rename a 

variable. Thus, the saved formulas may no longer work when you reload them because the 

variables mentioned in the formula no longer exist. 

Deleting a variable is done in the same way as renaming it. Select the variable you want to 

delete with the mouse. Now the focused variable is highlighted (yellow bar). Then click the 

Delete variable  button in the toolbar. When you delete a variable, the whole column 

including all its values will be removed from the table. 

10.6 The “Data editor”  

When working with variables, two views are available in MAXQDA: the variables view in 

the “List of document variables” or “List of code variables,” and the data view in the “Data 

editor (document variables)” or “Data editor (code variables).” The “Data editor” is similar 

to statistics programs in that the data is displayed as a rectangular matrix with a “rows x 

columns” structure. Variables are displayed in the columns: for documents, document vari-

ables, for codes, code variables. In the example of the group discussion, these refer to the 

participants, meaning the number of rows corresponds to the number of documents in the 

“Document System”; in an interview study this would refer to the number of interviewees. 

With code variables the number of rows corresponds to the number of codes, and their 
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subcodes, for which code variables were queried. The table therefore contains, in the exa-

mple, a row for each participant in the group discussion. 

Calling up the “Data editor (document variables)” 

The “Data editor (document variables)” can be called up in 3 ways: 

1. from the menu Variables > Data editor (document variables), 

2. from the “List of document variables” by clicking on the Variable view  button or 

by pressing Ctrl+O, 

3. in the “Document System” window, by selecting Overview of variables in the context 

menu. When called up at the top level, the table contains all the documents; at the 

document group level, the data table contains only corresponding documents, and at 

the document level, only data. 

Alternatively, you can click on the quick button in the “MAXQDA standard” toolbar: 

 

Quick button for accessing the “Data editor (document variables)” 

A table will appear, in which the selected documents and their corresponding variable valu-

es are listed. System variables can be recognized by the black column heading; this cannot 

be modified in the table. User-defined variables are indicated with a blue heading; their 

values can be adjusted by double-clicking the appropriate cell. 

 

“Data editor (document variables)” 

In the “Data editor (document variables)” it is possible to access a document by right-

clicking the appropriate row. A context menu will appear which lists options for opening 

the document. 
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Context menu in “Data editor (document variables)” 

Calling up the “Data editor (code variables)” 

The “Data editor (code variables)” can be called up in 3 ways: 

1. from the menu Variables > Data editor (code variables), 

2. from the “List of code variables” by clicking on the Variable view  button or by 

pressing Ctrl+O, 

3. in the “Code System” window, by selecting Overview of variables in the context menu 

of a code. If you click on a code which does not contain subcodes, only the variable va-

lues for this code will be listed in the table. If the code contains subcodes, the variables 

of the subcodes will also be listed. 

Alternatively, you can click on the quick button in the “MAXQDA standard” toolbar: 

 

Quick button for accessing the “Data editor (code variables)” 

A table will appear which lists the selected codes and their corresponding variable values. 

For the participants of the group discussion, the individual participants and their back-

ground information will be listed. These values can be adjusted by double-clicking in the 

approapriate row. 
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“ Data editor (code variables)” 

An extensive context menu, similar to the “Code System” context menu, is also available 

for individual codes. 

The “Data editor” Toolbar 

At the top of the “Data editor” there is a toolbar which provides easy access to the follo-

wing functions: 

  Show as Excel table – saves and opens a table in XLS/X format with the rows you 

have selected in the variable table. 

  Show as HTML table – saves and opens a table in HTML format with the rows you 

have selected in the variable table. 

  Export – opens a window, so you can save the selected rows of the variable table in 

XLS/X, HTML, or tab-delimited text format. 

  Import data – allows you to import a table for code variables 

  Variable view – switches from data to variable view. 

Managing Tables 

If you have created a large number of variables, it quickly becomes difficult to see then en-

tire table at one time. You can view more columns at one time by making the columns 

thinner (click and drag the separator between column headers), but eventually even this 

does not suffice. 

You do, of course, have the option of scrolling to the right, but you can also change the 

order of the columns by clicking on a column header and dragging it to the location where 

you would like to have it. It’s easier, though, to simply hide those columns that you aren’t 

working with. To do so, simply right-click on any column header and choose Select fields. 

You can then check the boxes next to the columns you would like to view and uncheck the 

boxes next to the columns you want to be hidden. 
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Variable selection of columns to be viewed 

Besides (un)checking the boxes one by one, you also have the following options: 

 select all fields 

 deselect all fields 

 only system fields (those automatically created by MAXQDA) 

 hide or show variables by checking or un-checking the box in front of the variable name 

10.7 Entering Variable Values in “Data editor” 

To insert variable values into the “Data editor:” 

Double-click on the cell of the table where you would like to insert a value. The values that 

have already been given to any of the cases in the column are in the drop-down list, sorted 

alphabetically. You can view this list and select a value from it by clicking on the triangle to 

the right of the cell you double-clicked on. 

If the value isn’t available in the drop-down list, you can simply type in the value after dou-

ble-clicking in the cell. 

Tip: Drop-down lists are less useful when a variable has many different values (e.g. the ex-

act income of every interviewee). Even if the value was in the drop-down list, it would be 

faster to type it in than to search for it. You can stop the program from displaying a col-

umn’s drop-down list by right-clicking on the column header and selecting (to uncheck) List 

of values. 
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Options for the variable value in the quick list 

10.8 Exporting Document and Code Variables 

MAXQDA provides basic functions for the statistical analysis of variables, and makes it pos-

sible to create frequency tables and diagrams. For further analysis, such as cluster or factor 

analysis, it is necessary to export the document and code variables. 

To export the variables: 

1. Click on the Export button in the toolbar of the “Data editor” or choose Variables > 

Export data (document variables) in the drop-down menu. 

2. Give the exported file a name. You can also select exactly where you want to save the 

file. 

3. For the file format, you can choose between XLS/X, HTML, and TXT (tab delimited). Most 

statistics programs work just fine with XLS/X files. 

4. Select OK. 

The exported file will then be opened in Excel and can be immediately analyzed. 

Note: In many statistics programs, the variable names are much more limited than in 

MAXQDA. Rather than allowing for up to 64 characters (including special characters), some 

programs allow for only 8. It is also not possible to have more than one variable with the 

same name in many of these programs. 
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Exported variable matrix in Excel 

Tip: The variable matrix can also be transferred via the Windows clipboard. Simply highlight 

the section of the table that you want to move and hit Ctrl+C to copy it. Then open Excel 

and hit Ctrl+V to paste. 

10.9 Importing the Variable Matrix into SPSS 

Importing the variable matrix from MAXQDA into SPSS is easiest when you use the Excel 

format: 

 Choose Export data (document variables) from the Variables drop-down menu. 

 Choose the Excel format (XLS/X), give the file a name, and choose where you want to 

save it. 

 The file will then be opened automatically in Excel, so you can check that everything is 

formatted correctly. Close the document, so SPSS will be able to open it. 

 Open SPSS and choose the option to open data. Change the data type to Excel. 
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Choosing the file type in SPSS 

 Navigate to the file you just saved and double-click on it. 

 Make sure the box Read variable names from the first row of data is checked and 

click OK. 

 

Setting the import settings in SPSS 

The results will look as follows: 
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Variable matrix of the document variables imported into SPSS 

10.10 Importing the Variable Matrix for Document Variables 

There are several situations in which you might want to import document variables into 

MAXQDA, such as: 

 If you want to analyze answers to open-ended questions in combination with the quan-

tiative socio-demographic information that you acquired for each of those who filled 

out the survey. Usually, you will already have this quantitative data in a matrix of some 

sort, and re-entering that information into MAXQDA would just cause you unnecessary 

work. 

 If you and others in a research team each entered variable values for various documents 

and now want to bring them all together. 

 If you did statistical analysis on material that you exported from MAXQDA and now 

want to reimport the results of your statistical analysis into MAXQDA. You could, for 

example, have done a culster analysis, and now want to import the information about 

which cluster each document belongs to as a variable into MAXQDA. If you want to 

avoid entering each one of these new values by hand, you can simply use the variable 

import option. 

MAXQDA can import data from XLS/X or TXT (tab-delimited) files. If possible, you should 

always use the Excel format, since it is the easiest to work with. No matter which format 

you use, though, it should be organized as follows: 
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Document group Document name Variable 1 ... Variable N 

Group 1 Text 1 Variable value for 

Text 1 

 Variable value for 

Text 1 

Group 1 Picture 1 Variable value for 

Picture 1 

 Variable value for 

Picture 1 

 

The first two column headers serve as markers for assigning variable values to the docu-

ments and are required for successful import. Every row must have an entry for the docu-

ment group and document name columns. Only if these exact group and document names 

are found in the “Document System” of the MAXQDA project, will the variables and varia-

ble values be imported. You can also use the column headers “textgroup” and “textname” 

in place of “Document group” and “Document name.” You can then include as many dif-

ferent variable columns as you wish. 

Note: The variable values for documents which do not belong to a document group can 

also be imported. In order to do so, the appropriate cell in the “Document Group” column 

must be left empty. 

After preparing the document, be sure to save and close (!) it. You can then start the im-

port procedure by selecting Variables > Import data (document variables) from the 

drop-down menu. Alternatively, you can click on the Import data (document variables) 

 button in the “List of document variables.” 

 

"Import data” button in the “List of document variables” 

A dialog field appears in which you can specify the source and target variables along with 

the type of variables to be imported. 

MAXQDA does the following during the import: 

1. All variables in the import file that did not yet exist in the MAXQDA project are created 

2. Variables that already existed will be updated with the new values in the import file. 

Attention: If you don’t see the new variables in the variable list after import, it may be that 

they need to be toggled on. To do this, right-click on one of the column headers and 

choose Select fields. 
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Tip: An easy way to set up an Excel file for importing new values is to first export the varia-

ble data matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable 

list. An Excel file with all of the current variables will open up, and you can then add new 

columns for new variables and update variable values that you want changed. All you have 

to do after that is save the Excel file and import it into MAXQDA. 

10.11 Importing the Variable Matrix for Code Variables 

MAXQDA can import data from XLS/X or TXT (tab-delimited) files. If possible, you should 

always use the Excel format, since it is the easiest to work with. No matter which format 

you use, though, it should be organized as follows: 

Parent Code Code Variable 1 ... Variable N 

Code 1 Subcode 1 Variable value for 

subcode 1 

 Variable value for 

subcode 1 

Code 1 Subcode 2 Variable value for 

subcode 2 

 Variable value for 

subcode 2 

The first two column headers serve as markers for assigning variable values to the codes 

and are required for successful import. Every row must have an entry for the parent code 

and code columns. Only if these exact codes and subcodes are found in the “Code System” 

of the MAXQDA project, will the variables and variable values be imported. You can then 

include as many different variable columns as you wish. 

Tip: It is not possible to import variable values for top-level/parent codes. 

After preparing the document, be sure to save and close (!) it. You can then start the im-

port procedure by choosing Variables > Data import (code variables) from the drop-

down menu. Alternatively, you can click on the Import data (code variables)  button 

in the “List of code variables.” 

A dialog field appears in which you can specify the source and target variables along with 

the type of variables to be imported. 

MAXQDA does the following during the import: 

1. All variables in the import file that did not yet exist in the MAXQDA project are created. 

2. Variables that already existed will be updated with the new values in the import file. 

Attention: If you don’t see the newly-imported code variables in the code variable list, it 

may be because they were toggled off. Simply right-click on a column header and choose 

“Select fields” to change which variables are viewed. 
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Tip: An easy way to set up an Excel file for importing new values is to first export the varia-

ble data matrix as an Excel file by clicking on the Excel icon in the toolbar of the variable 

list. An Excel file with all of the current variables will open up, and you can then add new 

columns for new variables and update variable values that you want changed. All you have 

to do after that is save the Excel file and import it into MAXQDA. 

10.12 Display Document Variables as Tooltips 

It is often necessary to call up background information on a document in the “Document 

System” (for example, the age or gender of a participant, or whether this participant works 

for an NGO). To this end, you can choose as many document variables in the “List of 

document variables” as you wish; their respective values will then be displayed as tooltips in 

the “Document System.” 

Double-click on a box in the Display as Tooltip column in order to select the document 

variable to display, or to close the Tooltip display. 

 

Select Tooltip display for document variable 

When you click on a document in the “Document System,” a tooltip showing the value of 

the selected variable will appear. In the following image, the display shows that the res-

pondant “Teresa” is female, over 25 years old and lives in New York. 

 

Tooltip display of variable value in a document 
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The variable value will also be displayed in the blue-yellow source information in the “Ret-

rieved Segments.” 

 

Variable value display in the source information of a coded segment 

When the “Retrieved Segments” is exported, the source information of each segment will 

also be displayed upon demand. 
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11 Searching for Text: The Lexical Search  

11.1 Lexical Search Options 

MAXQDA offers three main ways to search in the texts or within each main window. 

 Each of the four main windows has a toolbar at the top of it that contains a magnifying 

glass icon. Clicking on this opens a field where you can enter text to search for within 

that window. 

 With the lexical search tool (the magnifying glass in the “MAXQDA standard” toolbar), 

you can search within all documents, memos, or coded segments. You also have the 

option of limiting this search to certain activated documents or document groups. 

 The third option is to do an extended lexical search using Boolean operators. 

11.2 Search in the Four Main Windows 

All four main windows in MAXQDA have a magnifying glass icon in their toolbars. Clicking 

on this icon opens a search field. Below you can see the search field in the “Document 

Browser.” 

 

Context search in the Document Browser 

MAXQDA start to search as soon as you type the first character into the field. It carries out 

a classic search, meaning that it looks anywhere for that character combination, even if it’s 

not found at the beginning of a word. Searching for “sic” will bring up words like “musi-

cal” and “sick.” 

MAXQDA also shows you how often that particular search string has been found. In the 

example above, for example, you can see that “health” was found five times in the docu-

ment, and the first hit is currently being shown. The arrow keys next to the numbers let you 

jump from one hit to the next. 
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11.3 The Lexical Search: Options in the Dialog Window  

The lexical search function allows you to research your documents without first coding 

them. You can do searches of either 

 documents, 

 memos, or 

 coded segments, which are currently shown in the “Retrieved Segments” window. 

The search can also be limited to activated documents. You can choose to search in a single 

document, a document group, or all documents that have certain variable values. The lexi-

cal search function can be started by selecting Lexical search from the Analysis drop-

down menu or by clicking on the magnifying glass icon in the “MAXQDA standard” 

toolbar. 

 

Lexical search icon in the “MAXQDA standard” toolbar 

After selecting to do a lexical search, the following window will appear: 

 

The dialog window for the lexical search 

When the dialog box first comes up, the left pane is empty. Click New to enter the word or 

string (called the “search string”) that you want to find. You can specify that you want 

MAXQDA to match the case, or that you want to find only whole words. If the latter is the 

case, click the Find whole words check box. 
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Search strings may consist of one word, multiple words, or only of a part of a word. For 

instance, you can search for “Tom Hanks,” “Hanks,” or only “anks.” Quotation marks are 

not necessary if a search string consists of more than one word. 

Search strings may contain so-called wild card characters. The characters * or ? have the 

same effect as in search procedures well-known from Windows operating system. 

 If the character “?” appears in a search string, MAXQDA finds, for instance, “Hanks” if 

the search string is “H?nks,” but “Hunks” or “Hinks” would also be found. 

 The character “*” stands for multiple characters, e.g. “H*ks” would find “Hanks” and 

also “Hawks.” 

 A certain beginning of a word is found by use of the character “<.” The search string 

“<(inter)” would find “Interest,” “interesting,” but not “winter.” 

 A certain end of a word is found by use of “>.” Thus, the string “(ks)>” would find 

“Hanks,” “Banks,” and “thanks,” but not “Bankside.” 

Click the Delete button to remove search strings from the list. You can also modify your 

search strings at any time. 

In the right pane of the dialog box, a couple of options for the search procedure are availa-

ble: 

 First you need to select where you want to search: in documents or memos. 

 If you choose to search in the documents, options will be accessible that were previously 

grayed out. One of these options is to only search within activated documents, for ex-

ample, or to only search the retrieved segments currently shown in the “Retrieved Seg-

ments” window. 

Other options: 

 Find whole words – Search only for strings that are exactly the same as the search 

string. For example, if you search for “teach,” the string “teacher” will not be included 

in the search results. If you turn this function off, “teach” would also give you the 

strings “teacher” or “teaching” as results. 

 Case sensitive – Search only for strings in which the same letters are capitalized as in 

the search string. 

 Only in activated documents – Search only in activated documents. If no documents 

are activated, there will of course be no results. 

 Only in retrieved segments – Search for the string only in the text in the “Retrieved 

Segments” window. 

 OR/AND combinations – For searches with more than one search string. With OR che-

cked: search for segments containing only one of the search strings. With AND checked: 

search for segments containing all of the search terms (their required position with 

respect to one another can be defined). 

 Within x paragraphs – For searches for segments containing more than one search 

string (AND is checked). The search strings must be found within “x” number of para-
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graphs. If you choose to search within 1 paragraph, only the paragraph in which the first 

string is found will be searched. If you choose to search within 2 paragraphs, and the 

first string is found in paragraph 12, paragraphs 11, 12, and 13 will all be included in the 

search for the second string. 

As soon as you click the Search button, the search will begin. 

In order to spare you the effort of typing in a long list of search strings again and again, 

MAXQDA can save the search settings. To do this, click on Save, enter a name, and click on 

Save again. This creates a search file with the file extension ”.sea,” which you can open 

and continue to use at a later time. 

Depending on how many documents you search and how complex the search is, it could 

take a little time to find all of the results, which are then listed in table form: 

11.4 Search Results  

Your search results will be shown in a table that looks as follows: 

 

Example search results 

The toolbar at the top of the results window gives you access to the following functions: 

  Show as Excel table – the search table will be opened in XLS/X format in the appro-

priate program (usually Excel). If you have selected a section of the results table (marked 

yellow), only these will be included in the new table. 

  Show as HTML table – the search table will be opened as an HTML table in your 

standard internet browser. If you have selected a section of the results table (marked yel-

low), only these will be included in the new table. 

  Export – this function gives you the option to save the table (or the selected section of 

the table) in Excel, HTML, or RTF format 
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  Autocode selected search results – brings up a window to allow you to choose a 

code to code all search results. If you have selected a section of the results table (marked 

yellow), only these will be autocoded. 

  Code selected search results with a new code – brings up a window to allow you 

to code the selected search results with a new code. If you have selected a section of the 

results table (marked yellow), only these will be autocoded. 

  Options – opens the options window, which allows you to change exactly how much 

of the context of each hit is to be coded or exported. 

  Autocode/Export: ignore hit – exclude selected rows from autocoding and exporta-

tion by clicking on this icon. 

Attention: Coding hits in PDFs is limited to the actual string. It is not possible to code the 

sentence or paragraph in which the string was found. 

The table of search results can be handled in the same way as other tables in MAXQDA: 

clicking on any column header will sort the table according to this criterion. For instance, 

clicking on Document will arrange the document names included in the table in alphabeti-

cal order. Clicking here again changes the sequence to descending order. A little triangle 

indicates the sort attribute and order (ascending or descending). 

The entire table or parts of it can be copied to the Windows clipboard (by selecting all or 

part of it and pressing Ctrl+C). 

Below the title bar, you can see how many documents contain the search string and how 

many times the search string appears in those documents. Clicking on a document in the 

“Document” column opens the corresponding document at the position of the highlighted 

search string. 

11.5 The Extended Lexical Search  

The “Extended Lexical Search” function, as with the simple search option, allows you to 

analyze your documents to a certain extent without having to have already done any cod-

ing. The searches can be carried out in: 

 documents, 

 memos, or 

 the coded segments currently called up in the “Retrieved Segments” window. 

The search can also be limited to those documents that are currently activated in the Doc-

ument Browser. 
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The Boolean operator “OR” always has the highest priority. If you do a search, for example, 

for “climate change” AND “atom” AND NOT “war” OR “climate destruction,” MAXQDA 

will focus first on the OR, creating in practice the following formula: (”climate change” 

AND “atom” AND NOT “war”) OR “climate destruction”). The results will be those text 

segments that meet the first criteria or the second criteria. 

11.6 Exporting Search Results  

The table of search results lets you export the results by clicking on the Export button at 

the bottom left of the dialog box. You can choose to export in XLS/X, HTML, or RTF format. 

The file will appear as follows: 

New York\Teresa (24-24) 
family 
to go to college straight from high school in 1964 and become a teacher. I was a good student in high school 
graduating 19th in a class of 403. I really wanted to go to college, but my family couldn't afford it. Unfortunately, 
my mother had the attitude college was a waste for girls, because they got married and didn't put their college 
education to use. So, I never pursued the issue. I know, I shouldn't blame my mother for my not going to col-
lege. I could have been more enterprising and tried to find a way to pay for it on my own. I think never having 
been a teacher will always haunt me. Now it's too late. I'd have to take a large salary cut if I were to change 
professions at this stage in life. 

Section of an exported results table with the option to include the paragraph in which the string was found 

Each search result consists of the name of the document group and document, the para-

graph number in which the search string was found, and the search string itself. The length 

of the retrieved segment can be determined beforehand. Click on Options button. 

 

Options for the export/coding of search results 

When exporting the search results you should select the option Sentence or Paragraph 

instead of Only search string. Otherwise only the search string would be written in the 

export file, which doesn’t make much sense. 

You can decide how many paragraphs to export: 

 Paragraph = 0 – Only the paragraph that contains the search string will be listed. If the 

string occurs in the paragraph more than once, the paragraph will still be listed only 

once. The string will, however, be highlighted wherever it occurs. 

 Paragraph +/- “x” – The paragraph that contains the string will be listed, as well as “x” 

numbers of paragraphs before and after this paragraph. 



Searching for Text: The Lexical Search 

 

169 

If the search string is found several times in the same paragraph and you have chosen the 

option to code only the search string, then it may happen that the same paragraph will be 

listed more than once. However, when you select paragraph as the unit to list, then the 

same paragraph will appear only once in the output file. 

11.7 Autocoding Search Results  

Traditional quantitative content analysis works with the technique of automatic coding 

based on a dictionary. Whenever a word or string is found, an entry is made in a matrix of 

categories. After scanning a text in this way, the matrix is filled with numbers. The text itself 

serves no further purpose; only the quantitative matrix is then analyzed. 

This type of analysis is performed by programs like Textpack or Intext. MAXQDA’s add-on 

module MAXDictio works in the same way. Automatic coding is a very fast and reliable 

procedure, but unfortunately it is very restricted semantically. This is because the analysis is 

based on single words and strings. Words may, however, have many meanings, and the 

meaning of a sentence or a paragraph is something other than a collection of separated, 

unrelated words. For this reason, automatic coding is not a usual procedure in interpretive 

text analysis. But under certain circumstances, and for heuristic reasons, automatic coding 

procedures may be useful in an interpretive analysis, particularly when analyzing open-

ended questions. 

In MAXQDA this automatic coding procedure is possible in conjunction with the document 

search procedure. You begin with a document search as described above. 

To code the results displayed in the table, you only need to click on the button Code. The 

following dialog window is then opened: 

 

Options for autocoding search results 

In the options window that appears, you can: 

 Select a code from the quick list (if the code you wish to use is not displayed here, just 

click the code in the “Code System”). 

 Choose the size of the segment to be coded (the search string, sentence, the whole 

paragraph, or even more). 

 Assign a weight to the coded segments. 



Autocoding Focus Groups 170 

As soon as you click on the Autocode button, MAXQDA will start the coding procedure. If 

more than one hit is located in the same segment, this segment will of course only be cod-

ed once. 

The size of the automatically coded segments depends on the properties chosen in the dia-

log box. 

Here you may choose between the options Only search string, Sentence, and Para-

graph. 

”Only search string” means that only the string will be coded (this is similar to coding with 

the manual In-vivo button). 

”Sentence” means that you code the sentence surrounding the search string. 

”Paragraph” means that the paragraph(s) surrounding the search string are also coded. The 

exact number can be specified: 

 Paragraph = 0 – only the paragraph that contains the search string will be coded. If the 

string occurs in the paragraph more than one time, the paragraph will still be coded on-

ly once. 

 Paragraph +/- “x” – the paragraph that contains the string will be coded, as well as “x” 

numbers of paragraphs before and after this paragraph. 

When you view the result in the “Document Browser,” the string will be highlighted wher-

ever it occurs. 

Note: Automatic coding operations are added to the “Undo” list, allowing you to correct 

any mistakes easily, no matter how many segments are coded in one operation. 

11.8 Autocoding Focus Groups 

When working with focus groups the automatic coding functions can be used to assign the 

name of the speakers automatically. This only works in a fast and reliable way if you respect 

some rules for your transcription: 

Whenever the speaker changes, start a new paragraph and always use the same notation 

for the same speaker, for instance “JOHN SMITH.” Make sure that this string never occurs 

in the text itself. Do not use the Return key inside a speaker’s turn; every turn should be 

one paragraph! 

The automatic coding of speakers will work as follows: 

1. Start the lexical search procedure. 

2. Type in the search string “JOHN SMITH.” 

3. Choose the option Case sensitive. 

4. Start the search by clicking the button Run search. 
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5. Define a new code “John Smith” in the “Code System.” 

6. Code all hits, select paragraph = 0 as the context to code. 

11.9 Keyword in Context (KWIC) 

MAXQDA creates a list of the search results obtained as described in the preceding sec-

tions. This “KWIC” list can be saved as a file, in which not only the line of text in which the 

sought-after word, or “hit,” is found, but also the surrounding text is saved, in the form of 

expanded KWIC listings. The position of every hit in the document, i.e. the paragraph that 

contains the hit, is also listed. The amount of surrounding text, defined as a certain number 

of paragraphs can be determined. The procedure is as follows: 

1. Type in the search string(s) as described in the previous section. 

2. Select the number of paragraphs to be listed in the Options dialog field. 

3. At this point, you have three ways of forming your KWIC listing: 

i.) Click on the Export icon in the toolbar. This will save the results in a file in XLS/X, 

HTML, or RTF format. This file can then be printed, edited, or imported into other 

programs. 

ii.) Click on the Show as HTML table or Show as Excel table icons in the toolbar. This 

will display the results in the chosen format. This file can also subsequently be print-

ed, edited, or imported into other programs. 

iii.) Create a new code in the “Code System,” left-click on the code to transfer it to the 

quick list, and autocode the search results with this code. 

The third method is more flexible, since you can then load the KWIC list into the “Retrieved 

Segments” window, check the list, and remove any undesired segments (by right-clicking 

on the information box on the left of the segment and selecting Delete from the context 

menu). 

The final result, the corrected KWIC list, can be printed by selecting the menu option Print 

> Retrieved Segments from the Project drop-down menu. It is also possible to export or 

copy the KWIC list to the clipboard as well. 

The KWIC list has the following structure: each hit starts with the information on the doc-

ument source (document group, document name, and the paragraph number containing 

the hit). The next line indicates the search word or search string that has been found in that 

paragraph. Finally the text segment itself is listed. 
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New York\Milly (23-23) 
family 
family 
Family, 09 : My family my parents, my children, are very close. We share dreams and holidays and have much 
warmth with each other. 
 
New York\Mary (7-7) 
family 
I am pretty happy with my health situation. I get sick very rarely and when I do, it is only for a short amount of 
time. I think this can be attributed to the fact that I eat right and exercise semi-regularly. However, my family 
has a history of breast cancer and diabetes and I worry very much about contracting them. 

Printout of search results from a file 

11.10 Autocoding Answers to Open-Ended Questions  

11.10.1 General Problems Analyzing Open-Ended Questions 

MAXQDA doesn’t only offer special functions for entering and analyzing answers to open-

ended questions. There aren’t any general rules or regulations for analysis strategies for 

open-ended questions. It depends a lot on the amount of material, the sample size, and the 

depth of the analysis. 

Example 

Anthropologist Kate Mac Queen reported on an AIDs research project at the U.S. Center 

for Disease Control and Prevention. The epidemiological study was conducted in four phas-

es with a total of 1,267 test subjects. Every phase of the study include open-ended ques-

tions. 

Regardless of the method, it is likely that you would want to be able to connect the cate-

gorical and the quantitative data. 

You would be dealing with the following situation: 

 

 

At the beginning you would use a quantitative data matrix and transcribed answers, which 

will be analyzed categorically and transformed into a standardized data matrix. This first 

connection between the quantitative data matrix and the transcribed answers is easy to 

make in MAXQDA: the quantitative data matrix can simply be imported via the Import 

function in the Variables drop-down menu. If you entered the text of the answers to the 
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open-ended questions as described above, no further steps are necessary for descriptive 

and group-specific analysis. 

11.10.2 Analysis Techniques Without Categorization of the Answers to 

Open-Ended Questions 

Creating an Overview of the Answers 

You can get an overview of the answers given by all the test subjects to a particular ques-

tion with the standard retrieval function. Simply activate all documents representing the 

test subjects you wan to include, and activate the code in the “Code System” for that ques-

tion. You will then see all of the answers to that question in the “Retrieved Segments” 

window. 

Comparing Answers to Various Questions 

Let’s say that you wanted to compare the answers to two questions – question 2 and ques-

tion 4: 

You would activate the two codes that represent these questions in the “Code System” 

along with all of your documents. Check to make sure that the retrieval mode is set to the 

standard OR in the “Analysis” drop-down menu, and set the “Retrieved Segments” win-

dow to order according to document. This will give you the following results in the “Re-

trieved Segments” window: 

 Interview 1 answer to question 2 

 Interview 1 answer to question 4 

 Interview 2 answer to question 2 

 Interview 2 answer to question 4, etc. 

Selective Listing of Answers According to Subject Group 

This form of analysis requires the quantitative data matrix and the sorted answers to the 

questions. The matrix of quantitative data must first be imported into MAXQDA as docu-

ment variables. This is possible via the import function in the “Variables” drop-down menu. 

Once the matrix has been imported, you can use it for standard activations by variable. 

With this form of selective retrieval, documents will be activated based on their assigned 

values for certain variables, and only answers from these documents will be listed in the 

“Retrieved Segments” window. The only additional requirement is that you also activate 

the appropriate code(s) in the “Code System.” 

11.10.3 Categorizing Answers to Open-Ended Questions with Au-

tocoding 

When categorizing answers to open-ended questions, is necessary to differentiate between 

the methods autocoding and manual coding. The advantages of autocoding are clear when 
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working with over 1,000 subjects, as in the example above. The process is quick and relia-

ble, so you save time and money. Unfortunately, there are also drawbacks: only words and 

phrases are coded, which could have several meanings, so the actual meaning of the coded 

segment can’t be ensured. In addition, it is obviously impossible for the autocoding func-

tion to “read between the lines.” 

Opinions, attitudes, and beliefs are therefore difficult to autocode, although pragmatic con-

siderations may push you to do so in certain cases. 

Autocoding is a special focus of quantitative text analysis programs like Textpack and Intext. 

There the coding is almost always dictionary-based. The dictionaries are usually made up of 

single words, but can also include word orders. MAXQDA offers an add-on tool MAXDictio, 

which can be used for such dictionary-based coding. 

Example 

Bos/Tarnai (1996, S. 39f., Computerunterstützte Inhaltsanalyse in den Empirischen Sozi-

alwissenschaften) did a content analysis of the Association of Students and Teachers for 

Academic Education, creating a total of 18 categories. Category 5, for example, was de-

fined as follows: 

”K05 – Academic Orientation 

Sections that show academic interest, specifically in a specialization, or refer to an aspect of specialized 

training/education. 

Code example: comments about excellent researchers, research focuses” 

 

The dictionary is made up of single words and phrases that obviously connect to a certain 

category (and only this category). The following phrases, for example, would obviously 

connect only to category 5: 

 ”good research raises the standard of learning” 

 ”must be grounded in research” 

The documents are searched through for any of these words or phrases in the dictionary. 

As soon as one is found, it is automatically coded. You will then get a table like the one 

showed below, which contains a row for each coding that was made. 

Document Case Variable Category 

Interview 1 M 25 single 5 

Interview 1 M 25 single 6 

Interview 1 M 25 single 5 

Interview 2 W 31 married 1 

Interview 2 W 31 married 5 

Matrix Type A: Category of Coded Segments 
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This matrix can also be then aggregated in a table as seen below with documents on the y-

axis, and variables on the x-axis. Each cell then contains the number of times each category 

was found in each document. 

Document Case variable C01 C02 C03 C04 C05 C06 

Interview 1 M 25 single 0 0 0 0 2 1 

Interview 2 W 31 married 1 0 0 0 1 0 

…        

Interview n        

Matrix Type B: Number of coded segments per category in each document 

This matrix allows for a number of analysis techniques, such as: 

 Descriptive category statistics: which categories occur? How often? And which occurs 

the most often? 

 Creation and comparison of category means (on average, C05 occurred 1.3 times per 

document, C06 2.5 times per document, etc.). 

 Comparison of means (e.g. Educators mentioned C05 significantly more than the stu-

dents). 

 Cluster analysis, multiple correspondence analysis (MCA), and latent class analysis 

(search for patters and category correspondence) 

 Cluster correlation analysis with case variables (gender, age, education, etc.). 

Content analysis based on autocoding – as described above – can be performed very well 

with quantitative research programs like Textpack, Intext, and others. Automatic coding is 

actually a process outside of the qualitative method spectrum and outside of the focus of 

MAXQDA. It is, however, possible to apply such methods in MAXQDA with autocoding 

functions. 

Process for Autocoding 

 Activate all documents. 

 Activate the code that represents a question number. 

 Choose Lexical search from the Analysis drop-down menu and enter the search string. 

In the following example, “friends” and “family” were entered as the strings. 
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Dialog window for the lexical search 

It is necessary that you check the boxes next to Only in active documents and Only in 

retrieved segments, so that you won’t be including the entirety of all of your documents. 

Whether you want to Find whole words, make the search case sensitive, or use the OR or 

AND options is up to you. 

After clicking on the button to Run search, a table with a list of hits will appear. Now you 

would just need to code these segments that were found. In order to do that, the code that 

you want to code with must be in the quick list. Simply click on that code in the “Code Sys-

tem” to add it to the list. 

This new category could be name “People,” for example. Before you choose to carry out 

the coding, though, it is necessary to choose how much context should be included in the 

coded segment. 

 

Options for autocoding search results 

You can choose to code … 

 only the search string, 

 the sentence in which the string was found, 
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 the paragraph in which the string was found, or 

 the paragraph plus a number of paragraphs before and/or after it. 

If you click now on the Autocode button, all of the search results will be coded with the 

code shown in the quick list field. All of these new coded segments will be added to the 

“Retrieved Segments” window. Later, you can export this table of coded segments to SPSS 

for quantitative analysis. 

The Coded Segments Table can be aggregated in SPSS to a document like in Matrix B 

above (cases x categories). The display of the file is similar to the way it looks in Excel. In 

SPSS, you also have the option of merging this Coded Segments Table with the quantitative 

data matrix and analyze them together. 

The aggregated matrix can be created an exported by choosing Reports & export > Ma-

trix of code frequencies from the Project drop-down menu. You can save the file in 

XLS/X or TXT (tab delimited) format. The file is set up as follows: the first column shows the 

document group, and the second column shows the document name. The next columns 

show the code names in their complete form (code\subcode with a backslash separating 

codes and subcodes). The individual cells then show the number of times each code was 

assigned in each document. 

 

Exported Matrix of code frequencies in Excel 

MAXQDA handles these coded hits from the lexical search exactly like any other coded 

segments. In this way, you can search for code combinations and do focused selective anal-

ysis based on certain variable values. 

11.11 Categorizing Answers to Open-Ended Questions with 

the Help of the Variable Table 

The standard way to code open-ended survey questions as often described in literature on 

methods starts with a systematic analysis of a section of the data set, out of which a cate-

gory system can be developed. Coders are then trained and set to work on the rest of the 

data set with these categories. 
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Example 

Subjects in a study were asked to describe their visions for life as it would be in the year 

2020. The answers were transcribed and imported into MAXQDA. In the first step, five cat-

egories were created, which came out of the initial analysis: 

 Vision of technology 

 Vision of communication 

 Vision of self 

 Vision of health 

 Vision of the environment 

We can set these five categories as variables with a simple dichotomous 0/1 scale (instead 

of 0/1, we could also just y/n): 

 Code 1 – the topic was mentioned in the answer 

 Code 0 – the topic was not mentioned in the answer 

The steps in MAXQDA are as follows: 

 The texts to be analyzed must be in the “Document System.” 

 Select the List of variables from the Variables drop-down menu and create the varia-

ble for each category with the New variable button in the toolbar. The variable type 

should be set as integer. 

 Now switch to the data view by clicking on the appropriate icon in the toolbar. 

 It is recommended that you right-click on a column header and select to only view those 

variables in the table that are currently needed before you begin coding. 

Now you can set up your screen in a practical way with the “Document Browser” at the 

top of your screen and the variable matrix on the bottom half. 
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Optimal window layout with the “Retrieved Segments” and the document variables table 

In the above text “Mary,” communication is mentioned. So, we need to change the value 

of “V of Comm” (vision of communication) for Mary from 0 to 1. We can do this as fol-

lows: 

Clicking once on the coding stripe for “Visions” in the coding column of the “Document 

Browser” will highlight the corresponding row in the variable matrix. You can now double-

click on the appropriate cell (Mary x V of Comm) and enter “1.” You can then proceed 

with all of your “Visions” coded segments in the same way. You can also split up this work 

between people in your team. Every inputted variable value is saved immediately. 

Another option for this process is with the help of the “Overview of coded segments.” You 

can then go from row to row, systematically viewing each coded segment. The rest is as 

described in the previous example. 
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Optimal screen layout with the “Overview of coded segments” and the variable matrix 

One advantage of using this approach rather than applying codes is that the results are al-

ready together with other quantitative information in a table. You can also use these varia-

ble values to do automatic activations. 

Tip: It is also possible to create codes out of the five categories, code the segments, and 

then transform the codes into variables. 

The entire data matrix can be exported by selecting Variables > Export data (document 

variables) from the drop-down menu. You can then open this matrix for further quantita-

tive analysis in a program like SPSS. 
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12 Retrieval: Finding Coded Segments  

12.1 Activation: The Principle of Segment Retrieval 

In MAXQDA, you can search for information in your documents in a variety of ways. One 

method is to search for particular words or character strings with the lexical search func-

tion. You may be familiar with this search method from text-processing programs. The 

principle is basically the same in MAXQDA, with the advantage that you can search many 

documents simultaneously for the words. A lexical text search finds only those terms that 

actually appear in the text. Searching with theoretical concepts and subject categories, such 

as “Helper Syndrome” in a study of volunteers in social work, will naturally not provide any 

results. 

By assigning codes to appropriate document segments, you be able to find segments that 

relate to a certain theme. This finding of coded segments, also known as retrieval, requires 

only that you have created codes and assigned them to those document segments. After 

you have assigned codes to the document segments, you will be able to call up all seg-

ments that were coded with the same code. MAXQDA offers various ways to do this re-

trieval, but it is all based on activation of documents and codes. 

The following explanation applies not only for texts, but also for coded segments of images 

and PDFs. The more complex retrieval functions – which show, for example, the proximity 

of codes to one another – can only be used for text documents. 

The retrieval principle in MAXQDA is very simple: 

All document segments from activated documents that were coded with any of the activat-

ed codes will be called up and shown in the “Retrieved Segments” window. 

Activating Documents 

First the documents: All documents and document groups are listed in the “Document Sys-

tem.” When you import a document, it appears in the “Document System,” but it isn’t at 

that point opened or activated. 

The starting point, then, is an inactivated document. The status of the document – whether 

activated or not – can be seen by its color. Inactivated documents are blue-green, and acti-

vated documents are red. 

 

An inactivated (left) and an activated (right) document 

And how do you activate a document? There are two ways to activate documents: 
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1. Activation via the Context Menu 

The first way to activate a document is with the context menu. Simply right-click on the 

document and select Activate. 

You will know that the document is activated, because it will turn red. 

In the same way, you can activate entire document groups. Right-click on the document 

group and select Activate all documents. 

You can even activate all documents in your entire project at one time by right-clicking on 

the Documents icon at the top level of your “Document System” and selecting Activate 

all documents. 

2. Activation with the Ctrl Key 

Tip: There is an even easier way to activate than via the context menu: simply hold the Ctrl 

key on your keyboard and click on a document, document group, or the “Documents” 

icon. 

Activating Codes 

Activating codes works in the same way as for documents. Either right-click on a code and 

click to activate or hold the Ctrl key and click on the code. 

 

Activating a code via the context menu 

Activated codes are also visualized in red. 
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Activation Status in the Status Bar 

The status bar at the bottom of the MAXQDA window gives you information about the 

number of activated documents, activated codes, and the number of document segments 

that are being called up based on those activations. 

 

Activation information in the status bar 

When you activate a parent code, your settings will determine whether the subcodes are 

automatically activated with it. You can change this setting by right-clicking on a code and 

clicking on Activate codes together with subcodes. If a checkmark was showing next to 

that line, selecting it will remove this checkmark, and subcodes will not automatically be 

activated with the parent code. Your settings for that code will be saved until you change 

them again. 

All of the document segments that were found based on your activations are called re-

trieved segments or coded segments and are shown in the “Retrieved Segments” window. 

 

Called up document segments (coded segments) based on activated documents and codes 

You also have the option of automatically activating documents based on their variable val-

ues. This is known as “Activation by variable” in MAXQDA. 

Attention: If you are working with an extraordinarily large data set, your computer’s 

memory could be overwhelmed by retrievals that pull from every single document in your 

“Document System.” For this reason, it is recommended that you do not activate all codes 

and all documents at once when doing retrievals in unusually large projects. 
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Example 

Let’s say that you wanted to know what certain interviewees (e.g. Joanna, Kim, and Vin-

cent) said about other people in their lives. You would start by activating the appropriate 

documents in the “Document System:” 

 Hold the Ctrl key 

 Left-click on the document “Joanna” 

 Left-click on the document “Kim” 

 Left-click on the document “Vincent” 

Next, you will need to activate the appropriate code. In this case, the code is called “Peo-

ple.” If there are subcodes for this parent code, those subcodes will be activated as well 

(assuming you have not changed the default settings). 

You can now see some basic information about your activations in the status bar. It shows 

that you have activated three documents and five codes (this includes the four subcodes of 

“People”). You can also see that 27 document segments were retrieved based on those 

activations: 

 

Activation information found in the status bar 

12.2 Activation by Color  

Documents and codes can be activated manually (by clicking on them), automatically (via 

activation by variable), and also by color. There is a symbol  in the toolbars in the 

“Document System” and the “Code System” that lets you select the colors to be activated. 

After clicking on this button, a dialog field appears with all the colors that have been used 

for documents/codes so far. You can then check the box next to the colors to be activated. 

The two radio buttons at the top also let you check or uncheck all of the colors with a sin-

gle click. 
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The colors representing codes or documents to be activated 

12.3 Removing Activations (Deactivation) 

When you want to start a new retrieval, but already have documents and codes activated 

from a previous retrieval, the easiest way to proceed is to automatically deactivate all of 

those documents and codes. 

In the “MAXQDA standard” toolbar, you will find a button that resets all activations, both 

document and code activations. It is right between the buttons for opening a project and 

activation by variable. 

 

Button to “Reset activations” 

If you want to reset activations for only the documents or only the codes, you can do so 

with the button available in the “Document System” or “Code System” toolbars. 

 

Button to “Reset activations” for all documents in the Document System 

 

Button to “Reset activations” for all codes in the “Code System” 
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It is also possible to deactivate all codes or documents by right-clicking on the Documents 

icon in the “Document System” or the Codes icon in the “Code System” and selecting 

Deactivate all documents or Deactivate all codes. 

12.4 The “Retrieved Segments” Window 

The “Retrieved Segments” window is a results window – it shows you all of the coded 

segments that were coded with any of the activated codes in any of the activated docu-

ments. 

 

The “Retrieved Segments” window 

Next to each retrieved segment (default is on the left side), you will find a yellow info box 

about each retrieved segment and a memo column, showing any memos that were at-

tached to the retrieved section of the document. 

Tip: If you want, you can also move the info boxes to the right side of the “Retrieved Seg-

ments” window, but the memo column always remains on the left. 

 

Info box for a retrieved segment 

The info box above can be read as follows: the segment came from paragraphs 20-24 in 

the document “Joanna,” which is in the Document Group “New York.” The segment was 

coded with the code “Friends,” which is a subcode of the code “People” and the weight 

score for the coded segment is “100.” 
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Tip: If you click on any part of the info box, the associated document will automatically be 

opened in the “Document Browser” window at that part of the document where the 

associated coded segment can be seen (paragraphs 20-24). This segment is also high-

lighted. The associated code is also highlighted blue automatically in the “Code System” 

window. 

If you right-click on the info box, you will see the following context menu: 

 

Context menu for the yellow info box 

It is possible here to delete the particular coded segment, but that does not delete the ac-

tual code from the “Code System” or the document segment from the document. You will 

have to confirm your deletion. You can also change the weight score for the coded seg-

ment. If you select Modify weight, the following window will appear: 

 

Modifying the weight score of a coded segment 

Sorting of “Retrieved Segments” 

You can also carry out other functions by right-clicking on a gray area of the “Retrieved 

Segments” window in which the yellow info boxes appear. These same functions are 

also available in the Analysis drop-down menu. 

 

Context menu that appears when you right-click in a gray section of the column 
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The next few functions in the context menu affect the sorting of the retrieved segments. 

There are three possible variations: 

 Ordered by Document System – this means that the segments are listed in the same 

sequence as in the “Document System.” The list starts with the segments of the first ac-

tivated document in the “Document System,” then those of the second activated doc-

ument are given, and so on. Search results in this order would let you compare what 

one respondent said to different selected topics. For example, given that the first re-

spondent’s answers were contained in one document or interview, followed by a sec-

ond respondent’s answers in a separate second interview, all of the retrieved segments 

from the first interview would be listed before those from the second interview. 

 Ordered by Code System – this means that the segments are listed in the same se-

quence as the codes in the “Code System.” All of the segments assigned the same code 

are listed one after the other. 

 Ordered by weight – This sorts the segments according to the weight that has been 

assigned to them. 

12.5 Hierarchy of Codes in Retrieval 

A hierarchical system of codes can be constructed with MAXQDA. The program offers an 

easy way to make use of the hierarchical structure. 

Example 

Imagine you want to check if there are co-occurrences of Code A and Code B, and Code B 

has two subcodes, B1 and B2. If you activate these codes, in total four codes would be acti-

vated: A, B, B1, and B2. Now, when selecting the Intersection or Overlapping options, 

MAXQDA will search for text passages where all of the four codes are present. Obviously 

this is not what you want, since it is very unlikely that there are segments to which all four 

codes are attached. (Code B1 and Code B2 are likely exclusive: either B1 or B2 is attached 

but not both of them.) To get the desired result, you would have to split the analysis in 

three parts: 

1. Search for co-occurrences of Code A and B1. 

2. Search for co-occurrences of Code A and B2. 

3. Search for co-occurrences of Code A and B. 

This is obviously a very inconvenient way of getting results, particularly if a code has many 

subcodes or even different levels of subcodes. MAXQDA does, however, offer an easier 

way. Simply click to include subcodes in the context menu. 
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Subcodes will be included 

It is also shown in the status bar, whether or not the subcodes (or “code children”) are in-

cluded. If the symbol is crossed out, the subcodes are not included. You can also change 

this setting by double-clicking on this icon. 

 

Subcode inclusion shown in the status bar 

Going back to the example above: if both Code A and Code B are active, and include sub-

codes is selected, MAXQDA will find all co-occurrences of Code A (or any subcode of Code 

A) and Code B (or subcodes of Code B) 

12.6 Finding Coded Segments Using Weight Scores  

The context menu also lets you choose whether or not weight scores should be used to 

filter your results. You will see the weight score of each retrieved segments at the top-right 

of the corresponding yellow info box. 

 

Weight score in the info box next to each retrieved segment 

These weight scores can be used for the retrieval process. The user can define a range for 

the weight scores in order to retrieve only those document segments with scores inside of 

that range. 

If you choose to activate the weight filter, the following window will appear. You can enter 

any numbers between 0 and 100. 
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Weight filter 

This will cause only those segments to be displayed in the “Retrieved Segments” window 

that have a weight score within the defined range. The weight filter affects all retrieval 

functions, including complex functions like “Intersection.” 

 

Display of weight filter in the status bar 

The status bar at the bottom of your screen contains information about the document and 

codes that are currently active as well as the weight option, symbolized by the paper-

weight. This icon tells you if the weight filter is active or not, and its range, if it is. In the 

figure above, the weight filter is active with a range from 1 to 75. This means that only 

those codes that have been given a weight score between 1 and 75 will be displayed. 

12.7 The Coding Query Tool  

The Coding Query tool facilitates the retrieval process and the compiliation of coded seg-

ments. This tool allows you to control all essential settings from within a dialog window. 

Before calling up the Coding Query tool, you should activate the selected documents and 

codes. You can call up the Coding Query tool: 

 From the menu Analysis > Coding Query 

 By clicking on the Coding Query  button in the “MAXQDA standard” toolbar 

 By double-clicking on the Coding Query  button in the status bar at the bottom of 

the screen; or 

 By right-clicking in the left-hand column of the “Retrieved Segments” window and se-

lecting Coding Query (in this case, you must click in the grey area, not on the infor-

mation boxes indicating the origins of the retrieved segments.) 
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Accessing the Coding Query tool via the context menu in “Retrieved Segments” 

The following window will then appear: 

 

Coding Query window 
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When using the Coding Query tool for the first time, enter a query name in the <New> 

field. All subsequent selections within the project will now be saved under this query name 

and can be called up later. 

Tip: To create more queries, open up the drop down menu with the list of query names 

and click on the top entry <new>. 

You can determine various settings for the query from the dialog window: 

Documents – Select whether all documents, or only activated documents, should be con-

sidered in the query. The number in brackets indicates how many documents are currently 

activated. 

Codes – Same options as for Documents. 

Subcodes – If selected, subcodes of codes will be included in the query. 

Weight Score – The output of coded segments can here be limited to segments of a spe-

cific weight range. 

User – The output of coded segments can here be limited to segments that were created 

by a specific user. 

Cod. Segments ordered by – Specify the order in which coded segments will appear in 

the “Retrieved Segments” list. 

Kind of view – Instruct MAXQDA as to whether the retrieved segments should be dis-

played in a list, or in a table view. 

Query Type – The “Simple” query type is activated by default, resulting in the output of 

the retrieved segments of all activated codes (and their subcodes). There is also an option 

for complex queries, in which it is possible to e.g. search for overlapping or nearby codes. 

Find more information on complex queries in Complex Retrievals. 

12.8 Jumping from Retrieved Segment to the Original 

Document 

It is possible at any time to jump from a coded document segment in the “Retrieved Seg-

ments” windows to the original source document. 

To the left of each segment, you can see from which document and paragraph the seg-

ment was taken, and which code was assigned to it. 

If you click anywhere in this box, the original document from which this segment was taken 

will be opened in the “Document Browser” window at the position of the segment in the 

document. 

When examining the results of a retrieval, you should arrange your desktop as shown be-

low. The source document is in the upper window, and the “Retrieved Segments” window 
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is below it. Then, whenever you click on a segment’s information box, the source document 

will appear in the “Document Browser” window directly above it. 

 

Optimal view for jumping between retrieved segments and the source documents 

12.9 “Overview of retrieved segments”  

An easy way to get an overview of the retrieved segments is by calling up the Overview of 

retrieved segments by clicking on the appropriate icon in the toolbar at the top of the 

“Retrieved Segments” window. 

 

Opening the “Overview of retrieved segments” in the toolbar 

This display combines a list view and a detailed view of the retrieved segments. The upper 

half of the window shows the segment that is currently selected in the lower part of the 

window. The lower part works in the same way as the other overview tables in MAXQDA. 

Clicking on the column’s header will result in sorting the table corresponding to the values 

of the selected column. You may also switch the different columns on and off. Just right-

click on a column header and select Choose fields. You can then specify which columns 

should be shown (box checked) and which should not (box unchecked). This kind of dis-

play makes it easy to browse through retrieval results. Just click on a line in the table and 

then view the segment in the upper part of the window. 
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The two windows in the “Overview of retrieved segments” 

The option to display the retrieved segments in a table in XLS/X or HTML format is particu-

larly helpful. This gives a very good overview: not only the segment in plain text but all the 

information around it is listed, for instance the date when the segment was coded and the 

name of the person who did the coding. 

Tip: The overview table is also the best place to write comments on your coded segments. 

You read the segment in the upper window and write your comment below. Just double-

click the field for comments in the matrix and type in your annotation. 

The toolbar in this view includes the following functions: 

  Show as Excel table – opens a table in XLS/X format with the retrieved segments and 

associated information. 

  Show as HTML table – opens a table in HTML format with the retrieved segments 

and associated information. 

  Export retrieved segments – allows for export of the retrieved segments in RTF, 

HTML, or XLS/X format. 

  Overview of retrieved segments – opens a table view of the retrieved segments. 

  Code retrieved segments – the selected coded segments (marked in yellow) from the 

list will be assigned to an existing code. It is possible to select multiple rows by holding 

down the Ctrl key. If no rows are selected, the entire table will be coded. 

  Code retrieved segments with a new code – the selected coded segments (marked 

in yellow) from the list will be assigned to a newcode. It is possible to select multiple rows 

by holding down the Ctrl key. If no rows are selected, the entire table will be coded. 
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Calling up the “Overview of retrieved segments” 

The “Overview of retrieved segments” can be accessed in a number of ways. For an over-

view of coded segments currently displayed in the “Retrieved Segments” windows, the foll-

lowing options are available: 

 from the menu Analysis > Overview of retrieved segments 

 with the Overview of retrieved segments  button in the “Retrieved Segments” 

window 

 with the keyboard shortcut Ctrl+Shift+L. 

For an overview of all coded segments in a project, right-click on the root in the 

“Document System” or the “Code System” and select Overview of coded segments. You 

can also access the overview via the document group or document. 

From the context menu of a specific code, you can call up the “Overview of coded seg-

ments” for this code, including its subcodes. 

Tip: When you double-click on a code, the “Overview of coded segments” for this code, 

including its subcodes, will be displayed automatically. 

What information can be found in the columns of the overview? 

Regardless of the document type, the following columns of the coding overview have the 

same signification: 

 Document group – document group from which the coded segment originates 

 Document – document from which the coded segment originates 

 Weight – weight of the coded segment (can be modified directly in the overview!) 

 Comment – comment on the coded segment (can be modified directly in the over-

view!) 

 Code – the code with which the segment is coded 

 Created – the date on which the coded segment was initially created 

 Author – user who initially created the coded segment 

 

Depending on the document type, the following columns have different significations: 

Text Documents 

 Start – paraphraph in which the coded segment begins 

 End – paragraph in which the coded segment ends 

 Preview – the first 64 characters of the encoded text (when exporting the output con-

tains the entire coded segment) 
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 Text segment – always “yes,” (checkmark displayed in box) 

 Area – number of characters in the coded segment 

 Coverage – number of characters in the coded segment in relation to the number of 

characters of the text as a whole 

 Page – always “1,” as no distinction is made in MAXQDA pages 

PDF Documents 

 Start – horizontal position at which the coded segment begins 

 End – horizontal position at which the coded segment ends 

 Preview – the first 64 characters of the coded text. For images, <IMAGE> will be dis-

played (upon exportation the entire coded text and image segment will be displayed) 

 Text segment – for text encoding “yes”; for image encoding “no” 

 Area – for coded text segment, the number of codes; for a coded image segment, the 

encoded area as measured in PDF units 

 Coverage – for text, the number of coded characters in relation to the total number of 

characters in the text; for images, the area of the encoded image in relation to the total 

area of the PDF 

 Page – page number oft he PDF on which the coded segment appears. 

Image Documents 

 Start – horizontal position at which the coded segment begins 

 End – horizontal position at which the coded segment ends 

 Preview – always displayed as <IMAGE> (coded image segment will be displayed upon 

exportation) 

 Text segment – always “no” (no checkmark displayed in box) 

 Area – coded area 

 Coverage – coded area in relation to the total area of the image 

 Page – always “1” 

Table Documents 

 Start – row in which the coded segment is found 

 End – identical to “Start,” as coded segments are always inside a row 

 Preview – displays the first 64 characters of coded text (when exported, will include the 

entire coded segment) 

 Text segment – always “yes,” box is checked 
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 Area – Number of characters in the coded segment 

 Coverage – Number of characters in the coded segment in relation to number of cha-

racters in the whole text 

 Page – Column in which the coded segment is found 

Audio and Video Files 

 Start – horizontal position at which the coded segment begins 

 End – horizontal position at which the coded segment ends 

 Preview – always displayed as <IMAGE> (coded image segment will be displayed upon 

exportation) 

 Text segment – always “no,” box is not checked 

 Area – length of coded media clips 

 Coverage – length of coded media clips in relation to total length of the file 

 Page – always “1" 

Sort, Hide and Reveal Columns 

As with all tables, you can also organize the “Overview of retrieved segments” as you wish: 

 Drag & Drop columns to change their order. 

 Sort a column by clicking on the column heading. 

 Hide or reveal columns by right-clicking on the column heading. 

12.10 Table view of the “Retrieved Segments" 

The “Retrieved Segments” can be displayed in a table view. Click the Change to table 

view  button at the top of the window. MAXQDA will then display the coded segments 

in the same manner as the “Overview of retrieved segments” in the preview window. This 

display is interactive: Click on a row to show the corresponding segment in the “Document 

Browser." 
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The “Retrieved Segments” in table view 

12.11 Printing and Exporting “Retrieved Segments”  

You may wish to continue to work with the retrieved segments that you have called up. 

MAXQDA makes it possible for you to print out these segments, copy them to the Win-

dows clipboard, or to export them as a file. 

To print out the retrieved segments, you have two options: 

 Select Print > Retrieved Segments from the Project drop-down menu. 

 Click on the Print retrieved segments icon in the “Retrieved Segments” window 

toolbar. 

You will then see the standard Windows option for selecting your printer. The information 

will be printed in your printer’s standard font. The window that appears will also let you 

choose to print out only certain pages. 
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Printout of the “Retrieved Segments” window 

The layout of your printout cannot be changed from your printer’s standard formatting. If 

you have a color printer, the retrieved segments may be printed out in color. If you want to 

be able to edit aspects of the formatting, it is recommended that you first export the re-

trieved segments, open them for edit in a word processor, and then print them out. 

To export the retrieved segments, choose Reports & export > Retrieved Segments from 

the Project drop-down menu. You can then give the file a name and choose the format 

that you want the document to be saved in. Alternatively, you can click on the Export re-

trieved segments icon in the “Retrieved Segments” window toolbar. The results are the 

same. 

12.12 Coding “Retrieved Segments”  

MAXQDA makes it possible for you to code some or all of your retrieved segments in the 

“Retrieved Segments” window. In this way, you can search and code quickly within specific 

segments that have been called up. 

Let’s say you did a retrieval of the intersections between the codes “Health” and “Home 

life” for all the women in your interview sample. You can then choose to code all of these 

segments with a code called “Health + Home life + women.” 
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To do this, you can … 

 select Code retrieved segments from the Analysis drop-down menu, 

 click on the icon in the “Retrieved Segments” window toolbar to Code retrieved seg-

ments, or 

 click on the icon in the “Retrieved Segments” window toolbar to Code retrieved seg-

ments with a new code, if the code you wish you code with hasn’t been created yet. 

You will then see the following window: 

 

Autocoding the retrieved segments with a new code 

You can then choose a code from the quick list. The most recently-used code is listed at the 

top of the list. To open the quick list, simply click on the small triangle on the right. If the 

code you are looking for is not in the quick list, simply click on that code in the “Code Sys-

tem” and open the quick list again – it will be listed at the top. If you selected that you 

wanted to code the selection with a new code, you will be given the option to name that 

code. To complete the operation, click the Autocode button. 

This action will be added to the list of coding actions in the Undo coding menu in the 

“Code” toolbar. When you open this list, you will see the most recent coding actions at the 

top with the number of segments coded in each action in parentheses after the code name. 

If you have coded many segments at one time with the autocoding function, they can all be 

removed at the same time by clicking once on the appropriate line in this list. 

 

Undoing coding actions 

12.13 Copy “Retrieved Segments” with Source Information 

into the Clipboard 

In a research project, citations (e.g. interview passages) are often integrated into the final 

report. It is important to note the source information of these citations - the document and 
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paragraph from which they were taken. MAXQDA simplifies this process with the function 

Copy segment with source information to Clipboard. You can access this function by 

right-clicking on the yellow source information in the “Retrie ved segments” window. 

 

Calling up source information from a context menu 

When you call up the function from the context menu, MAXQDA copies the selected seg-

ment into the Windows clipboard. Now you can paste the citation into your word proces-

sing program by pressing Ctrl+V. At the end of the citation, the document name from the 

“Document System,” as well as the paragraph, will automatically be inserted. 

 

Citation with source information in word processing program 

12.14 Matrix of Code Frequencies  

This matrix has “n” rows (n = the number of documents in the project) and “m” columns 

(m = the number of codes and subcodes). This can be quite a large matrix; if there are 100 

documents and 100 codes, the matrix will include 10,000 cells. Normally you would use a 

statistics program to analyze this amount of data. You can, however, see this information – 

or sections of it – with the Code Matrix Browser. You can select the documents and codes 

that should be included in this visualization by activating them. To view the actual counts of 

how often each code is used in each document, you need to click the Show values button 

in the toolbar. 
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Code Matrix Browser showing the number of times each code was used in each document 

You also have the option of exporting this matrix as an Excel file. 

If you decide you want to analyze this table with a statistics program like SPSS, it is neces-

sary that the documents (cases) be listed on the y-axis. To export the table with the docu-

ments on the y-axis, go to the Project drop-down menu and select Reports & export > 

Matrix of code frequencies. You can then choose to export it in XLS/X or TXT (tab delim-

ited) format. 

Tip: If you want to create a matrix with only certain codes and documents, simply activate 

those codes and documents before calling up the matrix. 

In principle, the exported file will look as follows: the first column contains the document 

names, but documents that have been assigned to document groups will have that docu-

ment group in the name as well (e.g. “documentgroup\documentname”). The next col-

umns will contain the codes, listed in their full form (e.g. “code1\subcode1”). The backslash 

separates between either the document group and document name or the code and sub-

code. The individual cells of the matrix will then contain the number of times each code 

was used in each document. 

The following screenshot shows an example of this matrix viewed in Excel. 

 

Matrix of code frequencies exported to Excel 
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Tip: With older versions of SPSS, there are a limited number of characters that can be used 

for each document or code name. They will automatically be shortened, which could lead 

to confusion. In this case, it is recommended that you first change the names in the Excel 

file before importing it to SPSS. You can then create names of eight characters or less that 

make sense to you. 
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13 Complex Retrievals 

13.1 Logical Combinations of Codes  

Different than with classic quantitative content analysis, the categorization of data in quali-

tative analysis is not the end of the document analysis; instead it is simply a step toward 

further interpretative analysis. The categories create a structure within the documents, but 

they don’t replace them. MAXQDA’s analysis functions are tools to help you navigate and 

further develop this structure. 

MAXQDA allows you to combine activated codes in many ways. The OR combination was 

already described in the section Coding Retrieved Segments. This section will go over the 

many, more complex combinations that MAXQDA has to offer. 

Tip: The following complex retrieval functions assume you are analyzing text in RTF, 

DOC/X, or TXT format. PDFs cannot be analyzed in the same way, because their paragraph 

formatting is so different than standard text. Functions that look for codes near to each 

other, for example, are therefore no longer helpful. 

To perform a complex retrieval you can call up the Coding Query: 

 select Coding Query from the Analysis drop-down menu, 

 click on the icon  in the “MAXQDA standard” toolbar, 

 double-click on the icon  in the status bar at the bottom of the MAXQDA screen, or 

 right-click on the gray area in the “Retrieved Segments” window where the yellow info 

boxes appear and choose Coding Query from the context menu. 

 

Access to retrieval options in the context menu of the “Retrieved Segments” window 

The following dialog window will open: 
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Coding Query window 

In this dialog you can specify settings for your retrieval, for example whether to include all 

documents or only activated documents. Another option would be to only include coded 

segments from a specific user. At the bottom of the dialog you can select complex as 

Query type, which will open the following dialog window after pressing Next. 
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Complex query window 

The dialog window has the following aspects: 

 The Function field allows you to choose the retrieval function. 

 Just to the right is the  button that lets you set whether subcodes should 

be included. 

 Below that, there are three windows, labeled A, B, and C. 

 Window A is important for almost every retrieval option and holds the selection of 

codes to be included in the selection function. To add codes, activate them in the 

“Code System” and then click the button to add All activated codes. 

Tip: You can add codes directly from the “Code System” by using Drag & Drop to move 

codes to window A. 

 Window B is also for selecting codes, but you can do so from the quick list. Simply click 

on the  symbol to view the list. 

Tip: To make a code appear in the quick list, just click on it in the “Code System”. 

 Window C allows you to set certain parameters (e.g. the maximum distance between 

two coded segments). 
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The “Result” window at the bottom shows how many segments would be pulled up if the 

retrieval were carried out with the current settings in Windows A, B, and C. Under this 

window is a description of the retrieval function that is currently selected, and on the right 

side, there is a visualization of what that function does. 

The retrieval begins when you click on the Execute button. 

The following table gives you an overview of the various functions: 

Name Description 

OR-Combination Lists all coded segments coded with one of the activated 

codes in the “Code System” found in any of the activated 

documents in the Document System. This is the standard form 

of text retrieval. 

Intersection 

(”small picture”) 

Lists all intersections of Window A codes. It only shows the 

section of the segments that have both codes. 

Intersection (Set) Lists all intersections of codes listed in Window A if at least x 

codes from the list intersect. Only the overlapping section of 

the segment is displayed. 

Overlapping 

(”big picture”) 

Lists instances where codes in Window A overlap. Coded 

segments that overlap with each other are shown in their en-

tirety, rather than just that section that overlaps. 

Only one code Lists document segments that are coded with only one of the 

codes in Window A, but none of the other codes in Window 

A. 

Only this code Lists segments that are coded with the code in Window B, but 

not with any of the codes in Window A. 

If inside Lists segments where the code in Window A is completely sur-

rounded by the code in Window B. Results can be the seg-

ments of the inner code (Window A) or the outer code (Win-

dow B). 

If outside Lists segments where the code of Window A is completely 

outside of the code in Window B. Results are the segments 

coded with the Window A code. 

Followed by Lists segments where the code of Window A is followed by 

Window B code within the selected number of paragraphs. 

Near Lists segments where the Window A code is near to the Win-

dow B code, within x number of paragraphs. 

All of the analysis functions are based on the activated documents, but only the simple que-

ry is based on the activated codes. The complex analysis functions are based on the codes 

you insert in the “Complex query” window. 



Detailled Information about Complex Retrieval Functions 208 

Tip: All logical functions are only based on those documents that you have activated. The 

weight filter and subcode inclusion setting are integrated in all 10 functions. 

You can see which retrieval function is currently active in the status bar at the bottom of 

MAXQDA, in this case it is the Near function: 

 

Retrieval function in the status bar 

Caution: If there are no segments shown in the “Retrieved Segments” window, it could be 

because a retrieval function was accidentaly activated. You can quickly check for this in the 

status bar. 

13.2 Detailled Information about Complex Retrieval Functions  

13.2.1 Intersection 

Definition: Lists all intersections of Window A codes. It only shows the section of the seg-

ments that have both codes. 

How it works: 

Activate documents and/or document groups that you want to 

include. Activate the codes in the “Code System” that you want 

and then click on All activated codes in the text retrieval dialog 

window to insert them in Window A. 

No other settings are necessary. The number of segments that 

will be pulled up can be seen in the “Result” window. Or, you 

can simply hit Execute to call up the segments in the “Retrieved 

Segments” window. 

Tip: All codes in Window A must be attached to a text segment 

for it to be called up! 

Changing the activations in the “Document System” immediately 

changes your results. 

It is often helpful for this function to include the subcodes, so 

that all combinations of intersections between each code (and its 

subcodes) are automatically included. The easiest way to include 

the subcodes is to click on the  symbol. 

Example: 
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13.2.2 Intersection (Set) 

Definition: Searches for segments coded with a minimum of x instances of the codes in 

Window A. 

How it works: 

Activate documents or doc-

ument groups you want in-

cluded in the retrieval. Acti-

vate the codes to be includ-

ed in the “Code System.” 

Click on the button All acti-

vated codes to have the 

activated codes inserted in 

Window A. 

Set the minimum number of 

codes that must intersect in 

Window C. 

You can see in the “Results” 

window how many retrieved 

segments would be found 

based on intersections. 

Result: 

The intersecting segments 

are listed in the “Retrieved 

Segments” window. 

Example: 

If Codes 1, 2, 3, and 4 are en-

tered in Window A, and you have 

entered in Window C that at least 

three intersections are required, 

the first two examples to the right 

would not be called up. The first 

doesn’t have any intersections, 

and the second only has two in-

tersecting codes. The third has the 

required three intersection codes, 

though, so it would be listed in 

the “Retrieved Segments” win-

dow. 

Only the section of the coded 

segments that is coded with all 

three codes is displayed. 
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13.2.3 Overlapping 

Definition: Lists instances where codes in Window A overlap. Coded segments that over-

lap with each other are shown in their entirety, rather than just that section that overlaps. 

How it works: 

Activate documents or document groups you want included in 

the retrieval. Activate the codes to be included in the “Code Sys-

tem.” Click on the button All activated codes to have the acti-

vated codes inserted in Window A. 

It is not necessary to change any parameters. The number of 

found overlaps is listed in the “Results” window. 

Attention: Segments will only be listed if they are coded with all 

codes listed in Window A. 

The “Overlapping” function works just like the “Intersection” 

function, except that the results are displayed differently. The 

results of “Overlapping” include the entirety of each coded seg-

ment that overlaps, rather than just showing the section that is 

coded with both codes. 

As with the “Intersection” function, it is often helpful to include 

subcodes in the retrievals. Then all combinations of codes and 

subcodes are included. 

Example: 
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13.2.4 Only One Code 

Definition: Lists document segments that are coded with only one of the codes in Window 

A, but none of the other codes in Window A. 

Tip: Think carefully before using this function as it could pull up a very large number of 

segments. 

How it works: 

Activate documents or doc-

ument groups you want in-

cluded in the retrieval. Acti-

vate the codes to be includ-

ed in the “Code System.” 

Click on the button All acti-

vated codes to have the 

activated codes inserted in 

Window A. 

It is not necessary to change 

any parameters. The number 

of found overlaps is listed in 

the “Results” window. 

 

Example:  

If codes 1 and 2 are in Window A, 

the first two examples on the 

right would be included in the 

retrieval, because they don’t over-

lap each other. The fact that 

codes 2 and 3 overlap makes no 

difference, because code 3 is not 

in Window A. The third example 

would not be included in the re-

trieval because codes 1 and 2 in-

tersect. 
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13.2.5 Only This Code 

Definition: Lists segments that are coded with the code in Window B, but not with any of 

the codes in Window A. 

How it works: 

Activate documents or 

document groups you 

want included in the re-

trieval. 

Choose the code from 

the quick list in Window 

B that you want to call 

up. If the code is not 

there that you want to 

select, left-click on it in 

the “Code System” and 

try again. 

Now activate the codes 

for Window A in the 

“Code System” and click 

on the button All acti-

vated codes to have the 

activated codes inserted 

in Window A. 

Example: 

Code 1 is the selected code (Window 

B). Code 2 and 3 are the codes in 

Window A. When either Code 2 or 

Code 3 intersects with Code 1, Code 

1 is not listed. This is the case in the 

second and third examples on the 

right. Only the first example shows 

an instance of Code 1 that isn’t inter-

sected by Code 2 or Code 3. It would 

be listed in the “Retrieved Segments” 

window. 

This function is similar to the “Only 

one code” function, but it focuses on 

a specific code (Window B). 

 

 

 



Complex Retrievals 

 

213 

13.2.6 If Outside 

Definition: Lists segments where the code of Window A is completely outside of the code 

in Window B. Results are the segments coded with the Window A code. 

How it works: 

Activate documents or document 

groups you want included in the 

retrieval. Activate the codes to be 

inserted in Window A in the 

“Code System.” Click on the but-

ton All activated codes to have 

the activated codes inserted in 

Window A. 

Pick the codes for Window B from 

the quick list. If they are not there, 

left-click on them in the “Code 

System” and try again. 

The number of results that will be 

shown in the “Retrieved Seg-

ments” window is listed in the 

“Results” window. It can also be 

found in the status bar at the bot-

tom of the MAXQDA screen. 

Example: 

This function would be 

helpful if you were looking 

for text segments in which 

people talk about what they 

consider possible, but don’t 

want to include those in-

stances that are in the con-

text of these peoples’ wish-

es. 

Code 1 is in Window A, and 

Code 2 is in Window B. This 

means you are looking for 

instances of Code 1 that are 

completely outside of Code 

2. In the example on the 

right, only the third example 

would be called up. In the 

first example, Code 1 isn’t 

even there, and in the sec-

ond, Code 1 is not com-

pletely outside of Code 2. 
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13.2.7 If Inside 

Definition: Lists segments where the code in Window A is completely surrounded by the 

code in Window B. Results can be the segments of the inner code (Window A) or the outer 

code (Window B). 

How it works: 

Activate documents or document 

groups you want included in the re-

trieval. Activate the codes to be insert-

ed in Window A in the “Code Sys-

tem.” Click on the button All activat-

ed codes to have the activated codes 

inserted in Window A. 

Pick the codes for Window B from the 

quick list. If they are not there, left-

click on them in the “Code System” 

and try again. 

You can then set what you want to 

view as the result of this function; you 

can choose to call up the segments 

coded with the code in Window A, 

those coded with the code in Window 

B, or both. 

The number of results that will be 

shown in the “Retrieved Segments” 

window is listed in the “Results” win-

dow. It can also be found in the status 

bar at the bottom of the MAXQDA 

screen. 

Example: 

Let’s say you are inter-

ested in the things 

people said about crite-

ria for success, but only 

in the context of what 

they consider feasible. 

You could use this 

function, putting the 

“criteria for success” 

code in Window A and 

the “considered feasi-

ble” code in Window B. 

In the examples on the 

right, only the first 

shows a case where 

Code 1 (Window A) is 

found completely inside 

Code 2 (Window B). 

That is not the case in 

the second or the third 

examples. 
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13.2.8 Followed By 

Definition: Lists segments where the code of Window A is followed by Window B code 

within the selected number of paragraphs. 

How it works: 

Activate documents or docu-

ment groups you want included 

in the retrieval. Activate the 

codes to be inserted in Window 

A in the “Code System.” Click 

on the button All activated 

codes to have the activated 

codes inserted in Window A. 

These are the codes that will be 

looked for. 

Pick the codes for Window B 

from the quick list. If they are 

not there, left-click on them in 

the “Code System” and try 

again. These are the codes that 

must follow the Window A 

code(s) within a certain number 

of paragraphs. 

In Window C, you can insert 

the maximum number of para-

graphs to look for the Window 

B code(s) after finding a Win-

dow A code. 

Finally, you can choose what 

you want to view as the re-

sults in the “Retrieved Seg-

ments” window. 

The number of results is 

listed in the status bar at the 

bottom of the MAXQDA 

window. 

Example: 

In the example on the 

right, we are looking for 

Code 1 (Window B) follow-

ing Code 2 (Window A) 

within two paragraphs. 

Code 1 appears four times 

in the example, but only 

the third instance would be 

included in the results, be-

cause it follows an instance 

of Code 2 within two par-

agraphs. 
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13.2.9 Near 

Definition: Lists segments where the Window A code is near to the Window B code, with-

in x number of paragraphs. 

How it works: 

Activate documents or document 

groups you want included in the 

retrieval. Activate the codes to be 

inserted in Window A in the “Code 

System.” Click on the button All 

activated codes to have the acti-

vated codes inserted in Window A. 

These are the codes that will be 

looked for. 

Pick the codes for Window B from 

the quick list. If they are not there, 

left-click on them in the “Code Sys-

tem” and try again. These are the 

codes that must be near the Win-

dow A code(s) within a certain 

number of paragraphs. 

In Window C, you can insert the 

maximum number of paragraphs 

away the Window A code can be 

from the Window B code. 

Finally, you can choose what you 

want to view as the results in the 

“Retrieved Segments” window. 

The number of results is listed in the 

status bar at the bottom of the 

MAXQDA window. 

Example: 

We are looking for plac-

es where Code 2 (Win-

dow A) and Code 1 

(Window B) are found 

within two paragraphs 

of each other (Window 

C). 

Code 1 is found four 

times in the screenshot, 

but only the second and 

third instances are within 

two paragraphs of Code 

2. 

We chose to view the 

Window B code in the 

Retrieved Segments, but 

we could have theoreti-

cally chosen to list the 

Window A code or even 

both of them. 
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14 Visual Tools 

14.1 Code Matrix Browser  

The Code Matrix Browser (CMB) offers you a new way of visualizing which codes have 

been assigned to which documents. The matrix provides an overview of how many docu-

ment segments from each document have been assigned a specific code, and this for each 

existing code. 

The Code Matrix Browser looks like this: 

 

The Code Matrix Browser 

The Code Matrix Browser can be opened in the following ways: 

 Selecting Code Matrix Browser from the Visual tools drop-down menu, 

 using the keyboard shortcut Ctrl+B, or 

 clicking on the CMB symbol in the “Visual tools” toolbar. 

 

CMB symbol in the “Visual tools” toolbar 

Code Matrix Browser options 

After opening the Code Matrix Browser an options window will appear, which allows you 

to change display options. Often, only the activated documents might be of interest, for 

example. 
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Code Matrix Browser options dialog 

First you have to decide whether the results should be grouped or not: 

Documents – No grouping, every document has a column. 

Document groups – The columns are made up of document groups. The coded segments 

of the documents in each group will be summed up. 

Document sets – The columns are made up of document sets. The coded segments of the 

documents in each document set will be summed up. 

Under Type of analysis you can decide how MAXQDA should treat the coded segments: 

Unit of analysis: segments – The Code Matrix Browser counts the coded segments in the 

documents, document groups or document sets. 

Unit of analysis: documents – The Code Matrix Browser only shows whether a code was 

used in a document, document group or document set – it does not matter how often it 

was used. 

Further options allow you to change the data that will be used: 

Only for activated documents – Only the activated documents will be displayed. (If there 

are no activated documents in a document group or document set, the CMB will be 

empty.) 

Only for activated codes – Only the activated codes will be displayed as rows. 

Use weight filter – Only coded segments with a weight within the limits oft he weight 

filter will be used. 

Tip: The settings can be changed later on in the Code Matrix Browser toolbar. 
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Code Matrix Browser Toolbar 

The first thing you will see at the top of the Code Matrix Browser window is the toolbar, 

which gives you access to the following functions: 

  Opens the CMB matrix in Excel. 

  Opens a window to let you choose to export and save the CMB matrix with the values 

(showing values rather than circles/squares) in XLS/X or TXT (tab delimited) format. 

  Allows you to save a snapshot of the CMB as it currently appears in the window. 

  Opens the Quote Matrix in Excel, showing the segments represented in the CMB. 

  Shows small column headers without document names. 

  Shows short document names in column headers. 

  Shows full document names in column headers. 

  Calculates symbol size based on all coded segments. 

  Calculates symbol size based on coded segments in column. 

  Calculates symbol size based on coded segments in row. 

  Switches matrix view between symbols and values. 

  Switches between circle and square visualizations. 

  Switches from counting the number of coded segments in each document to simply 

showing whether there is at least one coded segment (whether or not a each code was 

used at all in the document). 

  Refreshes the visualizations if you’ve changed activations of codes or documents. 

Just to the right of the toolbar, you will find a sliding switch . If documents 

you have chosen do not fit into the CMB window, you may scroll through the diagram. 

Unlike in some other MAXQDA tables, the sequence of the columns cannot be modified 

within the CMB. 

What is actually shown in the Code Matrix Browser? 

The size and color of the clusters in the matrix show how many document segments in 

each document have been assigned each particular code and subcode. The larger the clus-

ter, the greater the number of segments that were assigned this code or category in this 

document. 
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When you move the mouse cursor over a cluster, a screen tip appears: 

 

Tooltip in the Code Matrix Browser 

Tip: The sequence of documents is fixed and will be determined by the sequence of the 

documents in the “Document System.” Thus, if you want a diagram with a particular se-

quence of documents, you have to change their sequence in MAXQDA’s “Document Sys-

tem,” which can be done easily via drag and drop. 

The name of the document, the code or subcode, and the number of coded segments as-

signed to the code are shown in the box. 

The document names in the column headers can be displayed in three ways: 

1.   without document names, 

2.   with short document names, or 

3.   with full document names. 

The number of documents that can be displayed as columns in the matrix depends on this 

setting. In most cases, it is sufficient to use short document names, showing only the first 

few letters, which nevertheless is enough for you to recognize it. If in doubt about a docu-

ment, you can take a look at the screen tip, where the full document name is displayed. If 

necessary, the width of the columns can be adjusted by clicking on a dragging the lines 

between column headers. 

The codes are displayed in the CMB in the same way as in the “Code System,” in a tree 

structure similar to that of Windows Explorer. Subcodes can be collapsed in the usual way, 

by clicking the – symbol. 

Tip: When the subcodes are collapsed, the number of coded segments is aggregated on 

the parent code level. If a parent code (that hasn’t been used in the document) has three 

subcodes with 10 coded segments each, when you collapse the subcodes, the parent code 

will show 30 coded segments. 

Jumping from the Symbol to the Coded Segment 

The document segments that have been assigned a particular code can be called up imme-

diately by double-clicking on the symbol. The relevant document is then activated and the 

coded segments appear in the “Retrieved Segments” window. It is possible to keep the 

CMB open, allowing one to easily view the contents of different symbols. 
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Exporting the CMB as an Image File 

The  button in the toolbar lets you take a snapshot of the Code Matrix Browser as it is 

currently seen in the window. You can save the snapshot as a BMP file for easy import in a 

word processor or Powerpoint slide. 

14.2 Code Relations Browser: Visualizing Overlapping Codes  

A tool similar to the CMB is the Code Relations Browser (CRB). The CRB is a visualization of 

the relationships between codes. A table shows how many document segments any two 

codes are attached to. The representation is similar to the Code Matrix Browser, but in this 

case, the little squares/circles stand for the number of co-occurrences of codes. 

You can open the CRB in different ways: 

 By selecting Code Relations Browser from the Visual tools drop-down menu, 

 with the keyboard shortcut Ctrl+O, or 

 by clicking on the CRB symbol in the “Visual tools” toolbar. 

 

Symbol in the “Visual tools” toolbar for opening the CRB 

The Code Relations Browser looks like this: 

 

An example of the Code Relations Browser visualization 

Code Relations Browser options 

After opening the Code Relations Browser an options window will appear, which allows 

you to change display options. Often, only the activated documents might be of interest, 

for example. 
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Code Relations Browser options dialog 

First you have to decide which codes will be shown as rows: 

All codes – All codes will be shown, the order being the same as it is in the “Code System” 

Activated codes – Only the activated codes will be shown as rows. 

A similiar decision has to be made for the columns in the Code Relations Browser, with the 

added option of Choose top level code. Selecting this option will open another dialog 

window after pressing OK, allowing you to select as many top level codes as you want. The 

selected top level codes and their subcodes will be shown as columns in the Code Relations 

Browser. 

Under Type of analysis you can decide which relations MAXQDA will show, as well as how 

often a code was used in a document: 

Co-occurrence of codes – Only “real” overlaps of codes will be used, which means that a 

segment has to be coded with both codes and the codes need to overlap. 

Near (codes) – Alternatively the Code Relations Browser will show codes that were used 

near each other, with a maximal distance of X paragraphs. 

Note: If you search with function „Near (codes)“ and chose distance „0“ you may find mo-

re hits than searching for Co-occurence of codes. The fucntion „Near (codes)“ only evalua-

tes if two codes are assigned somewhere in the same paragraph – not at the same seg-

ment. 

Unit of analysis: segments – The Code Relations Browser counts the coded segments that 

overlap or are near each other. 
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Unit of analysis: documents – The Code Relations Browser only shows whether codes 

overlap ore are near each other – it does not matter how often this happens. 

The option Only for activated documents will make the Code Relations Browser only 

look for relations in the activated documents. 

Tip: The settings can be changed later on in the Code Relations Browser toolbar. 

Code Relations Browser toolbar 

At the top of the screen, you will find the toolbar with the following functions: 

  Opens the CRB matrix in Excel. 

  Opens a window to let you choose to export and save the CRB matrix with the values 

(showing values rather than circles/squares) in XLS/X or TXT (tab delimited) format. 

  Allows you to save a snapshot of the CMB as it currently appears in the window. 

  Shows small column headers without code names. 

  Shows short code names in column headers. 

  Shows full code names in column headers. 

  Switches from the “Overlapping” function to the “Near” function. 

  Switches between circle and square visualizations. 

  Allows you to change settings for the “Near” function. 

  Switches from counting the number of overlaps to simply showing how many docu-

ments have at least one instance of the two codes overlapping. 

  Refreshes the visualizations if you’ve changed activations of codes or documents. 

To the right of the toolbar, you will find a scroll bar , which lets you scroll 

through all of your y-axis codes without losing sight of the y-axis codes. The order of the 

codes is based on the order in the “Code System.” If you want to change the order in the 

CRB, you must first change the code order in the “Code System” and refresh the visualiza-

tion. 

What is actually shown in the Code Relations Browser? 

Each symbol in the matrix represents the number of intersections of the two codes. The 

bigger the symbol, the larger the number of intersections. If you choose to switch to the 

Near function, the symbols represent the number of times two codes exist near to each 

other (within a certain number of paragraphs, defined in your settings). 
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If you click on the Document based icon in the toolbar, the symbols represent the number 

of documents that have at least one instance of an intersection between the two codes. It 

no longer matters how many times these intersections occur in each document. 

Tip: The order of codes in the Code Relations Browser will be identical to the order in the 

“Code System.” If you want to change the order in the graphic, you have to change the 

order in the “Code System” first. 

Jumping from the Symbol to the Coded Segment 

You can call up the document segments with overlapping codes by double-clicking on the 

symbol representing them. The “Overlapping” retrieval function will automatically be acti-

vated, bringing up the segments in the “Retrieved Segments” window. The CRB can re-

main open, so you can quickly go from one set of overlapping codes to another. 

Exporting the CRB as an Image File 

The  button allows you to take a snapshot of the current CRB window and save it as a 

BMP file, which you can then insert easily into a word processing file or Powerpoint slide. 

14.3 Document Comparison Chart: A Visual Comparison of 

Documents  

This visualization works for a number of documents at one time and offers a sort of mix 

between the Document Portrait and the Codeline. Simply choose the documents and codes 

that you wish to include in the visualization by activating them before calling up the func-

tion. 

The Document Comparison Chart shows the documents on the y-axis and the paragraph 

numbers on the x-axis, making it possible to compare the flow of codes in each document. 

The cells show the codes that exist in each paragraph of each document with a bar as-

signed the same color as the code it represents. Each code that is present in the paragraph 

is represented by a colored section of the bar. If a code is used more than once in a para-

graph, it is still only visualized once. To give you an idea how this works, see the screenshot 

below. In this example, you can see 10 paragraphs for three different documents. You can 

see that there were no coded segments in any of the documents in the first paragraph. In 

“Doc 1,” the first coded segments are in paragraph two, where two blue and one red code 

are visualized. 

 1 2 3 4 5 6 7 8 9 10 

Doc 1           

Doc 2           

Doc 3           
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The principle behind the Document Comparison Chart 

If several codes with different colors appear in the same paragraph, the space available will 

be shared between the codes. Generally, the space is fixed to 50 pixels. These pixels will be 

allocated according to the size of the coded segments. If exactly the same segment is coded 

with a green and a red code, then 25 pixels will be colored red and 25 green. 

Like in Document Portrait, codes and colors must correspond in a meaningful way. Other-

wise the diagram will have no meaning for you. 

You can call up the Document Comparison Chart: 

 by selecting Document Comparison Chart from the Visual tools drop-down menu, or 

 by clicking on the  symbol in the “Visual tools” toolbar. 

The visualization looks like this: 

 

Example of a Document Comparison Chart 

The Document Comparison Chart is particularly useful for the analysis of structured docu-

ments. In this case, all the documents have the same number of paragraphs and allow for a 

direct comparison. You are more or less looking at a Document Portrait for each selected 

document at the same time. 

Active Symbols 

As in all visualizations, the symbols representing the coded segments are active, meaning 

you can jump directly to the coded segments in the original document in the “Document 

Browser” by clicking on the symbol. 

Exporting the Document Comparison Chart as an Image File 

The  takes a snapshot of the visualization as it is currently seen on your screen, so you 

can then save it as a BMP file and import it into a word processing file or Powerpoint slide. 
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14.4 Document Portrait: Visualizing a Document  

This visualization is for a specific document, making it a case-oriented function. The docu-

ment is shown as a picture of all the coded segments based on the order and colors of the 

codes. 

You can access the Document Portrait … 

 by selecting Document Portrait from the Visual tools drop-down menu, 

 by right-clicking on a document and selecting Document Portrait in the context menu 

that appears, or 

 by clicking on the appropriate symbol in the Visual tools toolbar. 

 

Symbol in the “Visual tools” toolbar for calling up the Document Portrait 

The results of this function are only meaningful if you have made use of the opportunity to 

assign colors to codes. The visualization of a document can only be fruitful if this associa-

tion of colors makes sense to you. Here are a few examples: 

 Imagine a psychologist has coded an in-depth interview in a way that categories related 

to aggression have red colors and categories for quiet and friendly behavior have green 

colors. Now a Document Portrait would show with you in a single glance how often the 

interview shows aggressive behavior and when during the interview this happened. 

 In biographical research, the particular representations can be chosen for critical life 

events, thus making it easy to get an idea of the life course of a person and the concen-

tration of critical events. 

 For thematic analysis, it may be useful to associate different colors to different topics. 

Now, you can easily see which topics dominate the discussion and which topics are 

closely related. 

What Does a Document Portrait Display? 

A Document Portrait shows the sequence of codes for a selected document. To better un-

derstand what happens, it is useful to take a look at the “Overview of coded segments” for 

a selected document. All coded segments are listed in this overview. The first column dis-

plays the color associated with the code. This is the material that is used to “paint” docu-

ment portrait. Only those colors displayed in the first column of the overview table will ap-

pear in the visualization. In the overview table, all segments are equal regardless of their 

size. The Document Portrait, however, takes the size of the segments into account and 

“weights” the color according to the segment’s size. 

The color attributes of the codes associated with the document are displayed in a matrix 

with 1,200 little squares (arranged in 30 rows, each one with 40 squares). The representa-

tion starts with the first square on the left in the first line, and ends with the last square on 
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the right of the last line. The picture is set up in the same way as a television screen, where 

an electronic stripe goes along the screen from left to right. All 1,200 squares are divided 

up according to the share of the coded segments. If a document only had segment coded 

with a blue code, then the Document Portrait would be totally blue. If this segment were 

coded with two codes, red and blue, the Document Portrait would consist of 600 blue and 

600 red squares. If two segments were coded (again with red and blue codes) and the first 

segment were twice as extensive as the second, the picture would start with 800 hundred 

red squares followed by 400 blue squares. 

Thus, Document Portrait displays the structure of documents in terms of codes as a colorful 

picture. This helps to immediately identify the basic tone of a document, for instance, if 

emotions have been coded with meaningful colors (aggressive= red, tolerant= green, and 

so on). 

Try out the Document Portrait – right-click on a document of your choice in the “Document 

System” and choose Document Portrait. Of course, meaningful results can only be ob-

tained if you have assigned colors that make sense for your codes. 

 

Example of a Document Portrait 

Document Portrait Visualization Options 

  Visualize entire text document or coded text 

This button lets you toggle back and forth between the two visualization options. If you 

choose to visualize the entire document, the visualization will include white squares for sec-

tions of the document that have no code assigned to them. The other options only visual-

izes segments of the document that were coded. 

  Mixed colors for overlapping codes (yes/no) 
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This setting decides how segments should be visualized that are coded with more than one 

code. If the above option is off, each of the colors of the codes used to code the same 

segment will be listed sequentially, one after the other, similar to how it works in the 

“Overview of coded segments.” If the option is turned on, the colors of each assigned code 

are mixed together. 

  Display nodes as circles (on/off) 

This button lets you switch the symbols in the visualization back and forth between squares 

and circles. 

Active Code Symbols 

The square or circle symbols in the Document Portrait are also directly connected to the 

original data, which means you can double-click on any symbol to call up that coded seg-

ment in the “Document Browser.” (This is not possible if you have chosen to mix colors for 

overlaps.) 

Exporting the Document Portrait as an Image File 

The  button lets you take a snapshot of the Document Portrait, save it as a BMP file, and 

then insert it into a Word document or Powerpoint slide. 

14.5 Codeline: The Sequential Visualization of a Document  

The Codeline is a case-based visual function that displays a sequential view of a document’s 

coded segments. The picture is quite similar to that of a score of a piece of music. The x-

axis displays the paragraphs of the document, starting with §1 and ending with the last § 

of the particular document. The y-axis displays the codes. The cells of the Codeline matrix 

are filled with a colored symbol, if the code has been assigned to the paragraph. 

The basic idea behind the visualization can be seen below. There are 12 paragraphs and 

three codes shown. You can see that nothing was coded in the first paragraph of any of 

the documents. In the second, eleventh, and twelfth paragraph, Code1 is used. In para-

graph five, both Code2 and Code3 were used. This shows you already how you can use 

this visualization. It gives you an overview, so you can quickly identify which codes ap-

peared and overlapped in various phases of the document. 

 Paragraph 

 1 2 3 4 5 6 7 8 9 10 11 12 

Code1             

Code2             

Code3             
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Schematic representation of the Codeline 

The Codeline is called up … 

 by selecting Codeline from the Visual tools drop-down menu, 

 by right-clicking on a document and choosing Codeline from the context menu that 

appears, or 

 by clicking on the appropriate symbol in the “Visual tools” toolbar. 

 

Calling up the Codeline visualization using the symbol in the “Visual tools” toolbar 

Codeline Options 

When you call up the Codeline, you have two options: 

1. Only for activated codes – this limits the codes to be included in the visualization 

to those that you have already activated in the “Code System.” 

2. Aggregate on the 1st level – this option means that only top-level/parent codes 

will be visualized. The subcodes of each parent code will be handled as if they were 

instances of the parent code. 

 

Options for the Codeline visualization 

Codeline Display 

Unlike the Document Portrait, the Codeline tool can be used even if you have not associat-

ed meaningful colors to your codes. The Codeline graphics display the color, but if you have 

not selected colors, only green symbols will be displayed. The function of Codeline is to 

show where in a document the different codes have been applied, and this diagram also 

makes sense and can be interpreted without color differentiation. 

What can the Codeline be used for? 

 Codeline gives a good overview of the coding and can therefore be used universally. 

 The diagram may be of use for exploration – just follow a particular code, see when it 

appears and which other codes appear near it. 

 The opportunity to display only selected codes enables comparing two or more codes in 

the course of an interview. 
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 When analyzing focus groups, you can see at a glance which speakers react to each 

other and what the topics are in relation to the speakers. 

 

Example of a Codeline visualization 

The Codeline creates a table with the codes on the y-axis and the paragraph numbers on 

the x-axis. The coded segments are shown in paragraph sequence, starting with the first. 

This means that the visualization has as many columns as paragraphs. If the code is used in 

a paragraph, the code’s color will be shown in the bar in the appropriate column. If a cod-

ed segment is more than one paragraph, the bar continues from one to the next. 

You can scroll through the paragraphs while keeping the code names visible by using the 

scroll bar at the top of the window. 

Active Code Symbols 

The display of the coded segments is interactive. If you hover the mouse over a symbol, a 

tooltip appears with the code or subcode name and the paragraph number. Double-clicking 

on the symbol opens that document in the “Document Browser” at the appropriate para-

graph(s). The coded segment is also highlighted automatically. 

Exporting Codeline as an Image File 

The  button takes a snapshot of the Codeline as it currently appears in the window and 

lets you save it as an BMP file, which you can then later insert into a Word file or Power-

point slide. 

14.6 Tag Clouds  

Tag clouds offer you a simple way to visualize the most frequently used words in a docu-

ment or group of documents. The size of the font is dictated by the number of times it is 
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found in the selected document(s). MAXQDA puts the words in alphabetical order, starting 

in the top left. 

 

Tag cloud 

The tag cloud function can be called up for a single document, a document group, a doc-

ument set, or all documents in a project. Simply right-click on the document/group/set in 

the “Document System” and choose Tag cloud from the context menu that appears. 

So that you don’t end up with a list of short words that have no meaning for your analysis 

(e.g. and, or, the, but), you can create a stop list, so that such words aren’t included. The 

easiest way to add words to a stop list is from the “Word frequency list.” This list shows all 

the most frequently-used words, sorted from most the most frequent to the least frequent. 

To the left of each word is a green symbol. If you want to add a word to the stop list, just 

double-click on this green symbol next to it. This word will now no longer show up in the 

word frequency list or the tag cloud. You can also add several words at the same time to 

the stop list by holding the Ctrl key, clicking on the words one by one, and then right-

clicking on one of them and choosing Add to stop list from the context menu that ap-

pears. 

In the screenshot above, you can see the Edit stop list button at the bottom left of the tag 

cloud window. This button brings up a list in TXT format of all the words that are currently 
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in the stop list. You can here add or delete words as well, although the double-clicking op-

tion described above is considerably easier. 

The Copy button copies the tag cloud to the Windows clipboard, which makes it easy to 

then paste it into other programs, like Microsoft Word. 

 

Word frequency list: double-click on the green symbol next to a word to add it to the stop list, or right-click 

on the word and choose Add to stop list from the context menu. 
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15 Statistics and Graphics Functions 

15.1 Frequency Tables and Charts for Subcodes  

With the help of the Statistics and Graphics module, MAXQDA can create frequency tables 

and charts which indicate the frequency of subcodes. These functions can be accessed in 

the following ways: 

 From the menu Codes > Statistic of subcodes or Mixed methods > Statistic of sub-

codes, 

 or with the Statistic of subcodes  button in the “MAXQDA standard” toolbar 

The split “Choose Codes,” dialog box: on the left side, all existing codes that have sub-

codes are listed; on the right side selected codes appear. In the middle, arrow buttons allow 

you to transfer codes from one window to the other. Click on the column header of either 

list in order to alphabetize content. 

Note: To select multiple variables at once, hold down the Shift () or CTRL-key. 

 

Statistics and Graphics: Choose codes 

Select Unit of Analysis for Statistical Evaluation 

By default, MAXQDA uses coded segments as the unit of analysis and, as a result, produces 

statistical evaluation of how many coded segments exist in relation to the respective sub-

codes. 

At the bottom of the screen, you will find an option to use the number of documents as 

the unit of analysis. The logic for choosing this unit of analysis is, in this case, the same as 
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with the Code Matrix Browser: MAXQDA takes into account only whether a code is present 

in a document, and not its frequency. 

Depending on how you choose to proceed with the coding, two variants are possible for 

the evaluation of the unit of analysis Document: 

Single: In this case, the calculation is performed under the assumption that the subcodes 

are mutually exclusive, i.e. MAXQDA interprets subcodes essentially as a categorical varia-

bles. MAXQDA calculates the number of documents in which the respective subcode has 

been assigned. Within individual documents, only the most frequently occuring subcode is 

counted. If two or more subcodes are assigned in equal frequency, a new “undefined” cat-

egory is created. 

Multiple: In this case, the calculation will be performed based on the assumption that mul-

tiple subcodes can be assigned within a single document, i.e. that subcodes do not exclude 

each other. MAXQDA calculates the number of documents in which the respective subcode 

has been assigned. Within individual documents, all assigned subcodes are counted. 

Note: Only direct subcodes of the chosen codes are used to perform the calcluations. Sub-

codes of subcodes are not part of the analysis. 

Once you click OK, MAXQDA begins the statistical calculation, after which the results will 

be displayed as frequency tables and diagrams. 

The window shows the table view of the first selected variables: 

 

Frequency Table 

The first column of the table lists the different subcodes of the table; the second column, 

the absolute frequency; the third column, the corresponding percentages. The fourth col-

umn shows the percentages based on valid values, meaning missing values are not taken 

into account. If no missing values exist in relation to the relevant variables, then the per-

centages will be identical in the third and fourth columns. 

Tip: Click on the column headers of the first two columns in order to define row order. For 

example, you can sort in descending or ascending order of category frequency. 
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Table Values 

The relevance of table values depends on the code selection option. 

Unit of Analysis: Coded Segments (default selection, no selection made): The table will 

show how often a subcode was assigned, meaning how many coded segments exist for 

this code. 

Unit of Analysis: Document (Single): The table will show the number of documents in 

which the respective subcode was assigned. The subcodes are considered to be mutually 

exclusive. Within an individual document, only the subcode which occurs most frequently 

will be counted. 

Unit of Analysis: Document (Multiple): The table will show the number of documents in 

which the respective subcode was assigned. Within individual documents, all assigned sub-

codes will be counted.  

Example: In this MAXQDA project, five interviews were analyzed with respect to the issue  

“World Problems.” In total, 14 segments in the five documents were coded, and distribut-

ed among the three subcodes “Scarcity of resources,” “War” and “Egoism.” 

When “Segments” is selected as the unit of analysis (default), MAXQDA generates a table 

which shows how often each of the three subcodes occurs in the five interviews. The basis 

for the calculation of percentages is the total number of segments: In this example, 14: 

 

Unit of Analysis: Coded Segments 

If “Documents” and “single” had been selected as the unit of analysis, the “Frequency” 

column would indicate the number of interviews in which the respective world problem 

was coded most often. As the table below reveals, the subcode “Scarcity of resources” 

was awarded most often in 2 interviews. Note the category “undefined,” which occurs 

when two or more subcodes are present in equal frequency within a document; in this 

case, once. In each document at least one world problem was coded, otherwise a missing 

value would be displayed. The “Total” row indicates the total number of documents ana-

lyzed: In this case, five. 
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Unit of Analysis: Document (Single) 

When “Multiple” is selected, MAXQDA counts the number of documents in which each 

world problem occurs. The bottom row indicates the number of documents included in the 

analysis. 

 

Unit of Analysis: Document (Multiple) 

Toolbars 

You will see a toolbar at the top of the results window. Here you can: 

 call up charts by clicking the  icon 

 flip foward  or back  between main codes 

 print results, or 

 export results as an Excel file. 

Charts 

Once you have switched to the Chart view by clicking on the  icon, a bar chartof the 

selected subcode appears in the place of the table view. 
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Horizontal bar chart representation for the subcodes of the “World Problems” code 

Note: The order of columns, bars and segments is determined by row order in the fre-

quency table. 

You will see two toolbars at the top of this window. The upper toolbar is the same as the 

frequency table, and you can switch at any time to the table view. On the right side of the 

toolbar you will see three buttons, with which you can choose between pie chart, horizon-

tal and vertical bar chart. The chart can be customized using the options in the lower 

toolbar. 

  Display labels – hide or show categorical labels of bar and pie charts on the x-axis. 

  Display data values – hide or show the data label, meaning frequency of variable 

values or subcodes. 

 Display percentages – show relative, rather than absolute frequencies. 

  Display missing values – hide or show missing values category. 

  Display legend – hide or show the legend, which is switched “off” by default in bar 

charts. 

  Display scale – hide or show the scale axis in bar charts. 

  Display title – hide or show diagram title. 



Frequency Tables and Charts for Subcodes 238 

  Display text – hide or show textual description of diagram. 

  One color – use the same color for all pie or bar chart segments. 

  Color gradient – add color gradient to pie or bar chart segments 

  Change color scheme – opens window for color scheme selection. 

Customizing Chart Captions, Color and Font Sizes 

When creating charts, MAXQDA sets an initial color scheme. To customize your charts, 

double-click on the selected segment and choose your desired color. Click on the Change 

color scheme  button to select from among three preset color schemes. 

Double-click on the title or description to customize content. 

Formatting, such as font, font size and font style, can be changed via the dialog window 

that appears when you right-click on the title, description or another label. 

 

Customize color and font size 

Note: When window size is modified, font size will be automatically modified accordingly. 

Printing and Exporting Charts 

Like frequency tables, charts can be printed and exported. Charts will be exported in PNG 

format, or as vector graphics in SVG format. 
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15.2 Frequency Tables and Diagrams for Variables  

With the help of the Statistics and Graphics module, MAXQDA can create frequency tables 

and corresponding diagrams for code variables as well as document variables. These func-

tions can be accessed in the following ways: 

 from the menu Variables > Statistic of document variables and Statistic of code 

variables, 

 or with the Statistic of document variables  button on the “MAXQDA standard” 

toolbar, 

 or with the Statistic of document variables  button in the “List of document vari-

ables” and “List of code variables.” 

The split “Choose variables” window is displayed below: On the left side, all existing docu-

ment variables are listed; on the right, the selected variables. The arrow buttons in the mid-

dle allow you to transfer variables from one window to the other, i.e. for selection for anal-

ysis or removal from the selection list. 

Note: To select multiple variables at once, hold down the Shift () or Control key. 

 

Statistics and Graphics: Choose Variables 

Note: System variables that are created and managed by MAXQDA are marked in red; 

codes that have been transformed into variables are marked in green. 
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Both lists can be alphabetized by clicking on the column headers. When you click OK 

MAXQDA will begin the statistical evaluation and display the results as frequency tables and 

charts. 

The results window displays the results of the first selection of variables in a table. The 

“Frequency” column shows how many of the analyzed documents contain the variable val-

ue in question. 

 

Frequency Table 

Tip: Click on the column headers of the first two columns in order to modify the order of 

the table rows. For example, you can sort the frequency of categories in ascending or de-

scending order. 

The first column lists the various categories of the table; the second column lists the abso-

lute frequency; and the third lists the corresponding percentages. The fourth column shows 

percentages based on valid values, meaning missing values are excluded. If there are no 

missing values among the variables in question, the percentages of the third and fourth 

columns will be identical. 

You can customize the order of the rows within the table by clicking on the column header 

of the first and second columns. For example, you can sort the table in ascending or de-

scending order in regards to catagorical frequency. 

The results window has a toolbar at the top. From here you can: 

 Call up the chart view by clicking the  button 

 Flip forwards  or backwards  between variables 

 Print results, or 

 Export results as an Excel file 
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Charts 

When you switch to the chart view with the  button, a bar chart of the variables in 

question appears in the place of the table view. 

 

Horizontal bar chart of the document variable “Age” 

Note: The order of chart segments is determined by the order of the rows in the table, and 

can be modified accordingly. 

You will see two toolbars at the top of this window. The upper toolbar is the same as the 

frequency table, and you can switch at any time to the table view. On the right side of the 

toolbar you will see three buttons, with which you can choose between pie chart, horizon-

tal and vertical bar chart. The chart can be customized using the options in the lower 

toolbar 

  Display labels – hide or show categorical labels of bar and pie charts on the x-axis. 

  Display data values – hide or show the data label, meaning frequency of variable 

values or subcodes. 

  Display percentages – show relative, rather than absolute frequencies. 

  Display missing values – hide or show missing values categorie. 

  Display legend – hide or show the legend, which is switched “off” by default in bar 

charts. 

  Display scale – hide or show the scale axis in bar charts. 
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  Display title – hide or show diagram title. 

  Display text – hide or show textual description of diagram. 

  One color – use the same color for all pie or bar chart segments. 

  Color gradient – add color gradient to pie or bar chart segments 

  Change color scheme – opens window for color scheme selection. 

Customizing Chart Captions, Color and Font Sizes 

When creating charts, MAXQDA sets an initial color scheme. To customize your charts, 

double-click on the selected segment and choose your desired color. Click on the Change 

color scheme  button to select between three preset color schemes. 

Double-click on the title or description to customize content. 

Formatting, such as font, font size and font style, can be changed via the dialog window 

that appears when you right-click on the title, description or another label. 

 

Modify color and font size in charts 

Print and Export Charts 

Like frequency tables, charts can be printed and exported. Charts will be exported in PNG 

format, or as vector graphics in SVG format. 
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Missing Values in Frequency Tables and Charts 

MAXQDA will treat the following as missing variable values: 

 For numerical variables, values set as “Missing values” in the “List of variables” will be 

treated as missing. 

 For string variables, blank fields will be treated as missing. 
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16 Summary-Grid 

16.1 The Idea behind the Summary Grid 

The systematic analysis of texts or other information is often about analyzing the data sys-

tematically within a structural framework, summarizing it and then grouping it in different 

categories. 

The idea is to look for theoretical explanations for certain phenomena as well as for similari-

ties and differences between texts. In this process, it is important to focus on what the re-

search participants precisely said. But on the other hand, the researcher should also detach 

from the participants own words. His aim is to sum up and express what was said abstract-

ly, and to eventually present it in a way that is understandable for the recipient. During this 

analytical procedure, the “raw data,” that is for example interview transcripts, records, field 

notes etc., should be accessible at all times. 

The Summary Grid function of MAXQDA distinguishes two work stages and offers two in-

dividual working environments for these stages: 

The first stage is creating a summary and the second is creating result tables (so called 

“Grid Tables”) based on the summaries. 

These two functions are accessible from the Summaries drop-down menu: 

 

Menu item “Summaries” 

In order to create summaries, the segments that you want to analyze must already be 

grouped thematically. This might have been done with the use of structured interviews, 

thematic coding, or automatic coding. If the text is already coded with a Code System, a 

structure texts * codes already exists; you can view it using the Code Matrix Browser. 

You can picture the summary level as a thematic grid, i.e. a matrix documents * categories 

(codes). MAXQDA has a matrix like this called the Code Matrix Browser (CMB). It displays 

the texts in the columns and the categories in the rows. 

The Summary Grid is a second analytical level that contains the summaries written by the 

user for every node of the CMB. The user writes individual summaries and can edit them 

later, e.g. by adding or altering the information. The idea is to present the summaries in 

overview tables at a later stage of the analysis. This grid allows every summary to stay 

linked to the original text segment from the raw data. 
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16.2 Creating and Editing Summaries  

To create and edit summaries, 

 Select the menu item Summaries > Create and edit summaries, 

 Or click the correspondent button  in the “MAXQDA standard” toolbar. 

MAXQDA then opens a new window called “Summary Grid.” The window itself is divided 

into three areas: 

 Left window: the thematic grid, the Code Matrix Browser display 

 Middle window: the coded segments, so exactly what is normally listed in the “Retrie-

ved Segments” window after double-clicking a node in the Code Matrix Browser 

 Right window: the summary, this is where the summary is displayed, created and edi-

ted. 

 

Window “Summary Grid” 

You can adjust the content of the columns and rows of the grid on the left with two but-

tons: 

  Only activated documents – only documents that have been activated in the “Doc-

ument System” will appear as columns. 

  Only activated Codes – only Codes that have been activated in the “Code System” 

will appear as rows. 

Additional buttons offer the following functions: 

  Names, columns: none – in the left window, the document names will not be dis-

played in the column header 
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  Names, columns: short – in the left window, the document names will be appear in 

the column header in short form 

  Names, columns: full – in the left window, complete document names will be dis-

played in the column header 

  Display nodes as circles on/off – switches between the display of nodes as circles or 

squares in the left window 

  Grid Tables – opens the window “Grid Tables” (see below). 

On the right side, there is a slider  that you can use to scroll the window 

horizontally, the first column remaining fixed. 

In the right window, you can write and edit a summary for the node you have selected in 

the left window. You can select a node by clicking on it. The summary will automatically be 

saved after selecting a different node or closing the window. 

Tip: You can move text segments from the middle window “Coded segments” to the right 

window via Drag & Drop. This way you can easily insert citations in the summary. 

16.3 Grid Tables  

A “Grid Table” is an overview table of summaries and document variables for selected doc-

uments and codes. It gives you an overview of the summaries for selected topics. Grid Ta-

bles are a useful tool for presentations and publications. 

To create or view Grid Tables, 

 select the menu item Summaries > Grid Tables 

 or click the correspondent button . 

This will open the Grid Tables window. This window is structured similarly to MAXMaps. On 

the left side you find a list of the Grid Tables you have already created and in the window 

on the right you can view the Grid Table that is currently opened. 
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Window “Grid Tables” 

To create a new Grid Table, click the button  at the top left. A dialog window will ap-

pear that offers three options: 

1. You can decide whether to include all documents or only activated documents. This de-

fines the rows of the Grid Table. 

2. You can choose which document variables you would like to display for each row. 

3. You can select any number of Codes, to be displayed in the columns of the Grid Table. 

 

By clicking OK, the table will be created according to the parameters you have chosen: 
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Grid Table 

The Grid Table lists all summaries for the selected codes. 

In the first column of the Grid Table, you can see the document group and document 

name. In addition, the variable values of the variables chosen are displayed underneath 

each document. This enables you to receive further information about a certain case in the 

Grid Table. 

All table functions of MAXQDA are available: 

 You can change the order of columns via Drag & Drop. 

 You can hide or display columns (right-click on the column header and choose Select 

fields). 

 You can order columns alphabetically by clicking on a column header. 

The table is in plain text format, so the entire table is formatted with the same font. 

Note: You can edit any cell of the Grid Table individually, that means you can modify the 

summaries displayed. Changes in the content of the Grid Table will also affect the summa-

ries. This means that the content of the corresponding cell in the Summary Grid also chan-

ges accordingly. 

Each cell of the Grid Table is connected invisibly to the assigned coded segments. These can 

be viewed in the window “Retrieved Segments” by right-clicking in the cell of the Grid Ta-

ble and choosing “Display associated coded segments.” 



Summary-Grid 

 

249 

 

Interactive cells in the Grid Table 

Opening, Deleting, Duplicating and Renaming Grid Tables 

To open an existing Grid Table, double-click on the name of the Grid Table in the left panel. 

You can also right-click on the name of a table to open a context menu that allows you to 

open, rename, duplicate or delete the table. 

 

Context menu on a table name 

Note: The Grid Table is dynamically linked to MAXQDA data. As soon as you open a Grid 

Table, it scans your project for deleted documents, codes or variables, so that they can be 

removed or updated if necessary. 
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17 Mixed Methods Functions  

17.1 General  

MAXQDA is one of the pioneers of method integration. Functionality for working with both 

qualitative and quantitative data was already available in the very first version of the soft-

ware, which came out in the late 1980s. The option to view a matrix of quantitative data 

parallel to the texts has been a keystone of these mixed methods. In the previous version, 

MAXQDA 10, the option to create code variables was added, which makes it possible to 

assign variable values to different sections of a single document (e.g. for various speakers in 

a group discussion). 

Functions that combine qualitative and quantitative data are available in the Mixed Meth-

ods drop-down menu: 

 Activation by document variable – lets you activate documents to be included in re-

trieval based on document variable values. You could, for example, use this function to 

identify what men between the ages of 40 and 50 said about migration issues. 

 Quote Matrix – creates a Word file showing what different groups said about a theme 

based on certain variable values that you specify. Each group’s coded segments for the 

specified codes are in a different column. You could, for example, choose to see how 

those with various levels of education differ on their approach to combating homeless-

ness. 

 Crosstabs – works parallel to the Code Matrix Browser, except that this function 

doesn’t work on the document level. Instead, you can create groups based on your vari-

able values and compare how often each of these groups talks about each theme. You 

could, for example, compare how often men talk about relationships in your life satis-

faction interviews in comparison to women. 

 Typology Table – shows an overview of variable values for qualitative typologies that 

you have created (e.g. for people with various views on combating their own homeless-

ness). You could see, for example, what the mean age, gender breakdown, and average 

time already homeless is for the “apathetic pessimists” in comparison to the “proactive 

optimists.” 

 Configuration Table – This table shows which combinations of codes exist in selected 

documents. 

 Statistic of subcodes – MAXQDA’s statistics and graphics module lets you create fre-

quency tables and charts for subcode frequencies. 
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17.2 Activation by Document Variable: Variables as Selection 

Criteria for Retrievals  

The retrieval function in MAXQDA makes it possible for you to call up segments with se-

lected codes in selected documents. For simple retrievals documents and/or document 

groups you are activated manually in the “Document System.” This activation is done via 

right-clicking on the document or document group and choosing Activate or by holding 

the Ctrl key and left-clicking on the selection. More complex, selective retrievals, however, 

can’t be done as easily with this method. 

In addition to manual activation, there are also automatic activation options. With the Acti-

vate by document variable function, you can choose to activate documents based on the 

variable values that have been assigned to them. If you have defined variables for gender, 

age, and education level, for example, you could choose to select only those documents 

that represent women over the age of 40 that have at least a high school education. These 

activations can be made by entering the appropriate formulas. The formula syntax in 

MAXQDA is similar to that of statistics programs like SPSS. 

The “Activate by document variables” function always processes the entire project. You can 

access the function by choosing Activation by document variables from the Mixed 

Methods drop-down menu or by right-clicking on the Documents icon in the “Document 

System” and choosing Activate by document variables from the context menu that ap-

pears. 

 

Accessing the function from the context menu 

Note: If there are already some documents activated, you should reset these activations 

before starting the automatic activation process. You can do this by clicking on the Reset 

activations  button in the “MAXQDA standard” toolbar. 

After clicking on the appropriate button, a dialog window will appear where you can enter 

the formulas for activation. In the example mentioned above, we would want to activate 

only document with women over the age of 40 with a high school education. The dialog 

window is made up of the following sections: 
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 A section for the logical formulas and the buttons to create a new formula, delete the 

currently selected formula, or delete all formulas. 

 Checkboxes for selecting operators. 

 Buttons for opening or saving formulas. 

 Buttons for carrying out the activations. 

 

Dialog field for activation by variable 

All logical formulas must have the following components: 

variable name / operator / value 

If you have created a variable called “gender” and used the characters “m” for male and 

“f” for female, we would use the following formula in order to activate those documents 

that are interviews with women: 

gender = w 

Example 

Let’s say a study was conducted about the effects of the Gulf Oil spill on the reputation of 

offshore drilling companies, and all documents have already been coded. A variable was 

created based on the presence or absence of a critique of drilling company management 

(”Criticism”). If there was such critique in a document, the variable value was set to “Y.” 

Otherwise it was set to “N.” 

Now, if we only wanted to activate those documents that included critique of company 

management, we would use the following formula: 

Criticism = Y 



Mixed Methods Functions 

 

253 

To do this, you would follow these steps: 

1. Click on the New button. 

2. Choose the variable Criticism from the list of variables by checking the box next to it 

and clicking OK. 

You will now see the following text in the formula window: 

[Criticism] = 

The only thing that is missing at this point is the variable value. On the right side of the 

screen you will see a field where you can enter the value. Here you could enter “Y,” or 

simply click on the arrow to open the drop-down menu and select a value from the list of 

all the values that have been entered for a document up to that point. In our example 

above, both “Y” and “N” would be in the menu. Using this menu helps you to avoid any 

typos. 

Be careful when typing in values: MAXQDA variable values are case sensitive, so it 

makes sense to simply pick the value from the drop-down list. 

Since the “=” operator is used most often, it is automatically selected when you start a new 

formula. If you want to use a different logical operator, simply choose it from the right side 

of the window. 

The operators have the following meanings: 

= Selects variable values that are the same as the formula value. 

<> Selects variable values that are not the same as the formula value. 

< Selects variables values that are smaller than the formula value. 

> Selects variable values that are larger than the formula value. 

In our example, we wanted to activate those documents where the person did include cri-

tique of the company management, so the “=” operator is appropriate. We would want to 

see those documents with the variable value equal to the formula value (”Y”). 

If you are starting a formula with a numerical variable, a “0” is inserted automatically until 

you change it. 

Results of Activations by Document Variable 

Once you have entered the correct logical formulas, you can start the automatic activation. 

Click on the Activate button. 

MAXQDA then checks the variable values assigned to each document to check whether it 

matches the formulated criteria. The automatic activation window is closed, and you will be 

brought back to the standard MAXQDA four-window interface. The documents that 

matched the criteria are now activated (marked red) in the “Document System.” 
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Tip: The status bar at the bottom of the MAXQDA window shows you how many docu-

ments have been activated. 

If you also had codes activated, you will immediately see results of your retrieval in the “Re-

trieved Segments” window. 

Changing and Saving Formulas 

After starting the automatic activation process, the dialog window is no longer seen. The 

formulas, however, will still be in that window the next time you open it. 

You can change the logical formulas (operators and values) at any time: 

 Click on the Formula in the dialog window, and select another operator. 

 If you want to change the value, simply enter the new value or select it from the drop-

down menu. 

After you have changed the formula, click on the Activate button to restart the activation. 

You can also save a formula, so that you can have quick access to it at a later time. Just 

click on the Save button at the bottom of the dialog window. You can then give it a name 

and choose where you want to save it. 

Files for saved logical formulas are saved by MAXQDA as .LOA (logical activation) files. To 

open a saved formula, choose Open and navigate to the place you saved the .LOA file. It 

makes sense to set up a folder for all of your LOA files, so they are easy to find. 

Complex Logical Formulas 

It is also possible to combine various logical formulas. The basic units of these combinations 

are still the formulas in their basic form: 

variable name / operator / value 

Combining formulas just means that you are connecting two of these basic formulas with 

an operator. 

In the above example, we activated documents where the value for the variable “Criticism” 

was “Y.” 

If you want to further limit the results, so that you only see what women that critiqued 

management had to say, we would want to include a second formula where the value for 

the variable “Gender” is “f” for female. 

This second formula would just need to be added and given the AND operator, so that 

documents will be found that have variable values indicating that it is a woman, and the 

woman critiqued management. The second formula, then, would be created as follows: 

 First click New in the dialog window, and then 

 Choose Gender from the list of variables. 

The new formula should now look like this: 
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[Gender] = 

 Now you can select the value f from the drop-down menu. 

 MAXQDA automatically inserts the “OR” operator. In our case, we want to use the 

“AND” operator, so we would need to click on that option on the right side of the 

window. The formulas will now have the “AND” operator between them instead of 

“OR.” 

In this way, you can add as many combinations of logical formulas as you want. You can 

then click Activate to start the activations. 

The combination operators OR and AND have the following affect on the results of your 

activation process: If you choose the OR option, MAXQDA looks for documents that meet 

at least one of the various formulas’ criteria. If you entered the formulas “Criticism = Y” OR 

“Gender = F,” you will get all the documents that included critique of management as well 

as those that were women. For our example, then, the OR option would not be appropri-

ate. We want both formulas to be met, so we would need to use the AND operator, so that 

it looks as follows: 

 

A complex logical formula 

Deleting Formulas 

It is possible to go back and delete a formula at any time: 

 Click on the formula to highlight it. 

 Click on the Delete button. 

Using Code Variables for Activation by Code Variable 

It is not only possible to activate documents based on their document variables; you can 

also activate codes based on their assigned code variables. The Activate by code variable 

function can be accessed by right-clicking on the Code System icon and choosing the ap-

propriate option in the context menu that appears, or by clicking the icon in the “Code 

System” window toolbar. 
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Activate by code variable function in the “Code System” icon’s context menu 

17.3 Crosstabs  

The Crosstabs function has some similarities to the Code Matrix Browser, except that doc-

uments are analyzed grouped by document variable. Social groups, such as men and wom-

en, or people with different personal background, etc. can be compared based on variable 

values. All of the variables that are in your project can be used to set up a group. 

Crosstabs is a visualization of the relationship between document variables and codes. The 

following example displays the number of times each code was assigned woman or men. 

 

Crosstabs example based on gender 

The Crosstabs function can be accessed in the Mixed methods or Visual tools drop-

down menu or in the Visual Tools toolbar as seen below. 

 

Crosstabs icon in the “Visual tools” toolbar 

Tip: In order to have access to this function, you need to have activated at least one code. 

The Crosstabs toolbar at the top of the window includes the following functions: 

  Opens the Crosstabs matrix in Excel. 

  Exports the Crosstabs matrix in either XLS/X or TXT (tab delimited) format. 
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  Saves a snapshot of the window as it is currently seen in BMP format for later use in a 

presentation. 

  Opens a Quote Matrix for the codes and groups of the Crosstab in Word. 

  Changes the unit of analysis for numerical calculations. You can choose to only display 

if a document contains the code or not, rather than the total number of segments coded 

with that code. 

The next four icons set how the values are shown in the matrix cells: 

  Number of segments – meaning the code frequencies for each group are shown as a 

value. 

  Row percentage – meaning the value for each cell is shown as a percentage of the 

frequency of the code in that row (horizontal percentage). 

  Column percentage SUM – meaning the value for each cell is shown as a percentage 

of the frequency of the code in that column (vertical percentage). 

  Column percentages #N – meaning the value for each cell is shown as a percentage of 

the number of documents which contain that code (can only be selected if the option “Unit 

for analysis: documents” is activated). 

  Refresh – recalculates the values in the table. 

Crosstabs are well suited for the analysis of sub-categories and their distribution in sub-

groups of the sample. Imagine you have asked how students prepare for examinations, and 

the different options (e.g. reading books, working together with colleagues, etc.) are de-

fined as codes. With the Crosstabs function, you can compare various groups with each 

other. Are female students participating more in training groups? Do male students read 

more text? The options to view the values as row or column percentages make the inter-

pretation of the data even easier. 

Selection of Codes and Attributes 

You need to select at least one code and one variable (or more precisely, a variable value) 

to create Crosstabs. If no codes are activated, the Crosstabs function is gray and can’t be 

called up. As usual in MAXQDA, the selection of codes is done via activation. The selection 

of variables values is done in a dialog window that pops-up when you start the Crosstabs 

function. The window looks similar to that for the “Activation by variable” function. 

After activating codes and selecting Crosstabs, you will have the option to create logical 

formulas that will be used to assign documents to each column. The window is broken up 

into the following sections: 

 A section for the logical formulas and the buttons to create a new formula, delete the 

currently selected formula, or delete all formulas. 
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 Buttons for selecting operators. 

 A drop-down menu for selecting variable values. 

 Buttons for opening or saving formulas. 

 The buttons for creating the Crosstabs visualization. 

 

The Crosstab dialog window 

All logical formulas must have the following components: 

variable name / operator / value 

If you have created a variable called “Gender” and used the characters “Male” for male 

and “Female” for female, we would use the following formula in order to create one col-

umn of the Crosstabs to represent women: 

Gender = Female 

If you wanted to create one column for women and one for men, you would follow these 

steps: 

1. Click on the New button. 

2. Choose the variable Gender in the window that appears by checking the box next to it 

and clicking OK. 

3. Check the box next to insert all values into the table. 

4. Click OK. 

MAXQDA then lists the formulas that you have set up. In our example, it would look as 

follows: 
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[Gender] = Male 

[Gender] = Female 

The Crosstabs created in this way would look as follows: 

 

Crosstabs comparing the number of coded segments for each code by women and men 

If there are many different possible values for a certain variable, you can choose to delete 

those that you don’t want to include in the visualization. If, for example, you had a variable 

“level of organization” with possible values “very high,” “high,” “medium,” “low,” and 

“very low,” you might only want to compare the two extremes. To do this, you would click 

on the formula for each of the other three values and delete them. 

You can also compare groupings based only on sppecific variable values by not checking 

the box to Insert all values into the table. Instead, you would simply create a formula 

and add single values by following these steps: 

1. Click on the New button. 

2. Choose a variable from the list by checking the box next to it and clicking OK. 

3. Insert the appropriate variable value in the field on the right side of the window or 

choose it from the drop-down list. The drop-down list will have all the values that were 

assigned to the chosen variable. Choosing the value from the list helps you avoid any 

typos that would cause you to get false results. 

4. Repeat the first three steps to set up each column of the Crosstabs. 

5. Click OK to create the table. 

You can also save formulas, so that you can have quick access to them at a later time and 

don’t have to reenter them one by one. Just click on the Save button at the bottom of the 

dialog window. You can then give it a name and choose where you want to save it. 

Files for saved formulas are saved by MAXQDA as .LOA files. To open a saved set of formu-

las, choose Open and navigate to the place you saved the .LOA file. 
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17.4 Quote Matrix  

The Quote Matrix is based on the same idea as the Crosstabs function, i.e. to create a joint 

display of themes and quantitative variables. The Quote Matrix does this on a more de-

tailed, non-aggregated level. Here the coded segments themselves are listed in the cells of 

the matrix, not only the number of coded segments for that particular cell. In the example 

below, we can see a comparison about what married and single people said about certain 

themes. 

Code Family status = married 

 

Family status = single 

emotions  Happiness does not remind me of one 

event. It makes me think of my life.  

Even though there are bad times, 

overall I am very happy with the way 

I turned out as a human being. and I 

like were my life is headed. 

(New York/Joanna, 34-35) 

Sadness reminds me of the death of 

my grandmother (Dec. 90') and my 

grandfather (June 96'). Their deaths 

effected my life greatly.They were like 

my second parents. These two times 

were definately the worst times of my 

life 

(New York/GINA, 12) 

I feel as if I am very healthy and I know that I 

have a firm background on what being 

healthy means because of my interest in Nu-

trition and Exercise. I always to try to eat 

better and make the right choices and exer-

cise on a regular basis. I really think that 

those two components contribute highly to 

health. But, health also means emotionally, 

mentally and even spiritually. I feel like my 

spiritual life really contributes to the rest of 

my health because I take care of my body 

because God tells us to in the Bible and eve-

rything else falls into place. 

(New York/Milly, 11) 

 

education My career now is college. I am gradu-

ating this weekend from my Commu-

nity Health Undergraduate program at 

Hofstra University. I am continuing 

my undergraduate studies at CW Post 

in the fall to get a BS in nutrition. 

Getting my RD is my major career 

choice. My satisfaction level on my 

career is only a 7 because I am not 

looking forward to going back to un-

dergrad college but it is the only way 

I can achieve a license. 

(New York/GINA, 17) 

 

Overall I am pretty happy with my 

mental, social and physical health. I 

would like to improve my dedication 

to working out. I am the type of per-

son who will work out 5 times a week 

for a month staight and then is slowly 

turns into less days a week until it is 

none. I get distracted by school work, 

my job or just being tired. 

(New York/Silvia, 42) 

My major is Dietetics and I am planning on 

working with children at either a center or a 

Children's Hospital and do meal plan counsel-

ing for children that need special diets be-

cause of sickness, or whatever the case may 

be. 

I know that will not be happy in my occupa-

tion unless I work with children. I have a 

heart for kids and I found this out by working 

a summer camp for kids for the past 2 sum-

mers. 

I started taking a Nutrition class last year and 

decided that it interested me and found out 

what kind of jobs that I could get involved 

with by talking with my counselor and it all 

worked out great. 

(…) 

(New York/vincent, 12) 

 

Example of a Quote Matrix with the sources (document, paragraph) highlighted yellow. 

MAXQDA creates a table that shows the same coded segments that would be numerically 

listed in the Crosstab, but here they are dispayed as text. 
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In theory, it would be possible for you to create a Quote Matrix on your own by doing re-

trievals in MAXQDA for each group and copying them from the “Retrieved Segments” 

window into a table in Word, but this would take a lot of time 

The results of your Quote Matrix are opened automatically in whatever program is set to 

open RTF files (e.g. Microsoft Word). The coded segments retain the formatting that they 

had in MAXQDA. If some of your documents are formatted differently than others, this 

could lead to a chaotic-looking document. It is recommended in these cases, that you high-

light the whole table and assign the same font and size to it. 

In order to ensure that the Quote Matrix is readable, it is limited to a maximum of four col-

umns. If you absolutely have to have more columns than that, you can create two different 

ones and bring them together in your word processor. The Quote Matrix assumes that you 

are working with categorical variables. If you want to display metric variables, you need to 

use the Typology Table. 

Note: The number of columns in the Quote Matrix is limited to a maximum of four. 

17.5 Typology Table  

This function offers yet another way to combine quantitative data and your codes or cate-

gorical variables. It is called a Typology Table, because it is able to calculate various variables 

and their percentages (means, standard deviations, etc.) for qualitative typologies. 

The table is set up similarly to the following example from Creswell and Plano’s book “De-

signing and Conducting Mixed Methods Research” (2010: 292): 

 

Example of a Typology Table 

This table shows a comparison between two types of patients, “Depressed” patients (27 

persons) and “Not Depressed” patients (21 persons). The last column p-Value shows the 

statistic significance of the mathemical means. The first row shows the average age of both 

groups and the standard deviation in brackets. 
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The row “Women” contains the number of women and their percentage. This means that 

of the 27 depressed persons 21 are women, which is exactly 79%. 

As we can see, the rows consist of variables, metric variables to be exact, and specific val-

ues of categorical variables – either string or numerical variables. The columns follow the 

pattern of Crosstabs. 

 

Example of a Typology Table 

17.6 Configuration Table  

The Configuration Table is a Mixed Methods tool that shows you at a glance how frequent-

ly a set of codes appears in a document. 

To create a new Configuration Table, go to Mixed Methods > Configuration Table. 

This will open a dialog window. You can pull up to 5 codes from the “Code System” into 

this window via Drag & Drop. You can also insert your activated codes in this window by 

clicking the button Paste activated codes. If you have activated more than five codes only 

the first five of the “Code System” are inserted. You can delete one or more codes with the 

button Delete code(s). 

 

Selecting codes for the Configuration Table 

You can restrict the evaluation to the documents you have activated with the option Only 

for activated documents. 
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Click OK to view the result of the evaluation. It is made up of two results tables: the Con-

figuration Table and the Configuration Table – detail view. 

1. Results Table: Configuration Table 

In this table the columns contain the codes you have chosen aswell as two additional col-

umns containing “Frequency” and “Percent.” Every row contains one possible combination 

of codes. 

Note: A combination of codes that does not occur will not be displayed in the table. 

For example, a results table for the combination of three major global problems could look 

something like this: 

 

An example for a Configuration Table 

Looking at this table, you can see that two documents exist which contain the first code 

“Scarcity of resources” and the code “Egoism.” There is one document with the code 

“War” and none of the other two codes and another document containing the codes 

“Scarcity of resources” and “War.” There is also a document containing all three codes. 

The column “Frequency” tells you how many of the evaluated documents contain a certain 

combination. The sum row also tells you how many documents were evaluated – in the 

example shown it was five documents. 

In the top right corner you see the number of combinations that actually exist in your doc-

uments and – in brackets – the number of all possible combinations. In the example above 

it says 4(8) which means there are four rows for the existing four combinations. And – be-

cause we evaluated three codes – mathematically, there are 2
3
 = 8 possible combinations. 

Note: In the configuration table it does not matter how often a code was assigned in a 

document. The table only shows you if a certain code was assigned in any of the 

documents at all. 

The table is automatically sorted by the frequency. You can also sort it by a different col-

umn by clicking a column header. You can also adjust the order of the columns via Drag & 

Drop. 
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2. Results Table: Configuration Table – detail view 

The second results table lists all evaluated documents and shows whether the selected 

codes appear in these documents or not. So this table corresponds to the (binarized) Code 

Matrix Browser, only that you can also sort it by columns. 

The table has as many rows as documents were included in the analysis. The first two col-

umns contain the document group and the name of the document. Next to these columns 

you see the columns for the selected codes. The column on the far right gives you the sum 

of the selected codes that appear in the respective document – regardless of how often 

those codes appears in the document. 

The following screenshot shows an example of the detail view table: 

 

Example for a Configuration Table 

Looking at this table we see that, in the document “B01 Tyler,” the codes “Scarcity of re-

sources” and “War” appear. In the document “B02 Maria” only the code “War” appears. 

All three codes appear in the “B03 Jennifer” document. In “B04 Michael” and “B05 Gar-

nett” both “Scarcity of resources” and “Egoism” appear. 

The table is automatically sorted in order of the “Document System.” You can adjust the 

order by clicking the header of a column. You can also adjust the order of the columns via 

Drag & Drop. 

17.7 Transform Code into a Document Variable  

A code in the “Code System” can be transformed into a document variable, indicating how 

often the selected code appears in each document. The document variable is dynamic. 

MAXQDA will automatically update the document variable, i.e. increasing the variable value 

if a new segment is coded with the code. This feature is particularly useful as it allows the 

user to export code frequencies along with variables, or activate documents based on cer-

tain code frequencies for analysis. 

To transform a code into a document variable, right-click the code and select Transform 

into a doc-variable. MAXQDA will generate a document variable, with the same name as 
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the code, as a numeric variable. The program will automatically insert the code frequency 

of each document into the appropriate cell of the column. It opens along with the “Data 

editor” of the document variable and positions it in the appropriate column. 

 

Transform a code into a document variable 

In the overview of document variables the code could be binarized using the Transform 

into binary variable button. The variable is thereupon no longer indicated according fre-

quency of an associated code in a given document, but rather whether it occurs in a docu-

ment (= “1”) or not (= “0”). 

 

Transform into binary variable 

17.8 Transform Code into a Categorical Document Variable  

Evaluative Categories in Content Analysis 

In many research projects, forms of evaluative content analysis are used. The standard steps 

are to: (1) define evaluative categories, usually with ordinal variables, (2) code text seg-

ments, and (3) analyze the data descriptively and statistically. A good example of this form 

of analysis process is found in Philipp Mayring’s chapter on qualitative content analysis 

found in “A Companion to Qualitative Research” (Flick, et al., 2004), which describes 

scaled variations of structure content analysis. 
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In one of Mayring’s detailed examples from a study on student teachers, a category called 

“self confidence” is created with three options: “high,” “medium” and “low” (see below). 

These categories were developed from the material – one can see from the following figure 

that the categories are not only precisely defined, but also empirically supported with the 

help of the anchor examples in the material. 
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Coding guidelines for the category “self-confidence” (from Mayring 2000:16) 

The coding process, which is standard procedure for content analysis, has the researcher 

working through the entire data set and assigning evaluative codes to appropriate text 
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segments that have to do with “self-esteem.” This means that every single text segment 

that connects to self-esteem will be assigned the code “high,” “medium” or “low” on the 

basis of the coding guidelines established. 

At the end, each case (in the case of interviews, a case would be an interviewed person) 

can be analyzed as a whole and given a summary characterization as having “high,” “me-

dium” or “low” self-esteem. Cases characterized as having high self-esteem can then be 

compared with those with low self-esteem. Code frequencies can also be compared and 

used in combination with other categories in crosstabs. 

Principles of Application in MAXQDA 

The method for evaluative content analysis can be done in MAXQDA in the following way. 

First, the category “self-esteem” is created as a code with the subcodes “high,” “medium” 

and “low.” The definitions of these codes along with anchor examples can be created as 

code memos. 

Now the material will be analyzed, meaning that each document is read line by line. The 

text segments that have to do with self-esteem are identified and then coded with the ap-

propriate code (e.g. “high” self-esteem). After an entire text has been worked through in 

this way, the researcher will have one of the following situations: 

 Text segments about self-esteem in this document were all coded with the same sub-

code (e.g. “medium” self-esteem). In this situation, the entire case can be said to have a 

medium level of self-esteem. 

 Text segments about self-esteem in this document were coded with various subcodes, 

but one of those subcodes obviously occurs more often (e.g. three with “high” self-

esteem and one with “medium” self-esteem). In this situation it makes sense to give the 

whole case that level of self-esteem that is coded most often. 

 Text segments about self-esteem in this document were coded with various subcodes, 

and none of them clearly occur more often than the others (e.g. two with “medium” 

self-esteem and two with “high” self-esteem). In this situation, a quick categorization 

cannot be made, so the coded segments should be compared to one another by the 

coders, who then make a decision about which categorization is more appropriate. 

 No text segments were coded with self-esteem subcodes, meaning the document does 

not contain any information about this theme. None of the subcodes can be used to 

categorize this document, and will need to be treated as a “missing” value. 

The “Transform into a Categorical Variable” Function 

After coding the appropriate text segments, the “Self-esteem” code can be transformed 

into a categorical variable by right-clicking on the code and selecting the appropriate option 

in the menu that appears. 
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Calling up the “Transform into a categorical doc-variable” function in a code’s context menu 

After this option is selected, MAXQDA performs the following actions: 

1. A new categorical variable is created in the List of document variables with the name of 

the code that it was created from (in this case, “Self-esteem”). 

2. All cases (documents) in the “Document System” are evaluated according to the rules 

explained above. 

a. Each case is assigned the value of the subcode that occurs the most often. 

b. If there are two or more subcodes used the same numbers of time, it is labeled 

“undefined.” 

c. If none of the subcodes are used at all, no value is assigned. If the table is ex-

ported to a statistical software, empty values are usually treated as “missing.” 

 

Variable matrix with the new categorical variable “Self-esteem” 

Dynamic Properties of Categorical Variables 

In MAXQDA‘s List of document variables, the categorical variables have a special status. 

One recognizes them in the list, because they have a green square in the first column and 

are created from a “Code” as seen in the “Source” column; categorical variables are de-

fined as string variables, and the strings are taken from the “Code System” (in this case 

“high,” “mid” or “low”). 
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The newly-created categorical variable “Self-esteem” in the List of document variables 

Categorical variables are dynamic, which means they are updated automatically when new 

segments are coded in the documents. This is also the case for documents that are import-

ed after the categorical variable has already been created; when one codes this new docu-

ment, the variable label changes accordingly. 

Tip: If a subcode has further subcodes, they will not be included for the evaluation of cate-

gorical variable values. Only direct subcodes of the codes that were transformed into a cat-

egorical variable are evaluated. 

Categorical Variables in the Context of Mixed Methods Functions 

Categorical variables lend themselves very well to use with MAXQDA’s mixed methods 

functions. With the activation by document or code variable function, for example, 

one can choose to activate only those documents with a certain variable value. This is help-

ful for answering research questions such as “How do student teachers with low self-

esteem experience their situation in the school system? How do they approach disciplinary 

issues?” 

The Crosstabs function offers an aggregated overview of the number of coded segments in 

certain categories in the “Code System” for each of the three self-esteem variables. The 

self-esteem characterizations are shown in the columns on the x-axis, and the selected 

codes are shown in the rows on the y-axis. Using the self-esteem example, the Crosstabs 

function could count the number of times that student teachers with low self-esteem talk 

about disciplinary issues in comparison to the number of times student teachers with high 

self-esteem talk about the issue. One can then easily call up the document segments 

counted in each cell in the “Retrieved Segments” window. 

One can also use the Quote Matrix to see a detailed table of the document segments, 

each column holding those segments that occur in documents with a specific categorical 

value. In our self-esteem example, one column could hold those statements about a certain 

topic that come from student teachers with high self-esteem, and the other column could 

display those statements from teachers with low self-esteem. 
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The Typology Table uses categorical variables similar to the way the Crosstabs function 

does; a table is created with the categorical variable values in the columns. In this case, 

however, the variables are analyzed rather than the categories. One could look, for exam-

ple, what percentage of people with high self-esteem are men and what percentage are 

women, or whether good grades in teacher certification exams seem to connect in any way 

to self-esteem, etc. 
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18 Teamwork: Using MAXQDA as a Team 

18.1 Exchanging MAXQDA Projects  

People doing qualitative data analysis often do so in a team, which raises the question how 

MAXQDA allows for teamwork. 

Important: MAXQDA is not a multi-user program. Simultaneous use of the same project 

file at the same time is not possible. Various people cannot make changes to the same file 

at the same time. 

The sort of functionality that is currently available in MAXQDA does not blend with the log-

ic of multi-user software. A typical example of a multi-user program is the kind used by air-

lines for flight bookings. Such programs only work when one user’s ability to change some-

thing requires that the other users be given read-only permissions. MAXQDA, though, is set 

up so that a user can write or change a memo, modify coded segments, etc. at any time. 

All of these functions would be limited – if not made impossible all together – with a multi-

user system. For these reasons, one has to accept that simultaneous work by various team 

members on the same project file is not possible. MAXQDA does, though, make it easy to 

separate a project into various files, have team members work on them at the same time, 

and then later bring them together in one file. 

This teamwork is possible in two different forms, depending on how the team members 

want to work together. 

 Type 1 – Different people work with the same master version. They perform online 

searches, text retrievals, and other kinds of analysis with this master version. But, they 

do not perform code and memo procedures simultaneously on the master version. 

 Type 2 – The different members of the group divide their work: Team Member A will 

code text No. 1 through 5, Team Member B will code text No. 6 through 10, and Team 

Member C text No. 11 through 15.. 

Both types of teamwork are supported by MAXQDA. The first type of teamwork is the easi-

er one, since a project file can be exchanged between the different PCs. The research group 

always works with the same database, but coding and memo procedures in MAXQDA are 

not possible on more than one PC at a time. 

The transfer of MAXQDA projects is very easy: MAXQDA saves all aspects of the project in a 

MX5 file. If you name a project “ForumAnalysis,” it will be saved on your computer as “Fo-

rumAnalysis.mx5.” 
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The project file contains all … The project file does not contain … 

 Documents 

 Codes 

 Memos 

 Variables 

 Coded segments 

 Text links 

 External links 

 Diagrams made in MAXMaps 

 External documents 

 Externally saved geographical references (KML 

files) 

 Saved search formulas (SEA files = search fi-

les) 

 Saved logical activation and Crosstabs formu-

las (LOA files = LOgical Activation files) 

 Files with exported coded segments and me-

mos (MEX files = MAXQDA EXport files) 

 Saved Code Systems in MTR format 

 Graphics and photos from MAXMaps dia-

grams 

 Dictionaries in MAXDictio 

These single MX5 project files can be exchanged between the members of the team – 

they’re usually small enough to send by email. 

Tip: If you are planning on sending an MX5 file by email, you can make it even smaller by 

“zipping” it into a ZIP file. This is recommended also because the file ending might not be 

recognized by the receiving email program, and might not be accepted. 

If you want to set up the project, so that various members of the team can work on it at 

the same time, it is recommended that you start by importing all documents into a 

MAXQDA project on one computer, and then sending a copy of that file to everyone in the 

team. This saves you the work of importing the files on each individual’s computer and 

guarantees that everyone will have the exact same data set. 

Sharing Projects that have External or Linked Files 

If you have associated audio or video files to documents or if you did not import very large 

PDF or image files, they will not actually be part of the MX5 project file. Instead they are 

put in a folder for external files (path listed under Options in Project drop-down menu). If 

you want to share these files along with the project file, follow these steps: 

1. Send the project (MX5) file. 

2. Group all the external files together in a ZIP file by selecting the Bundle external data 

files from the Project drop-down menu. A compressed ZIP folder with those files at-

tached to the project will then appear in the same folder as your MX5 file, which you 

can then send to your fellow researchers. 



Exchanging Coded Segments, Memos, and Variables for Documents and 

Document Groups 

274 

Procedure for Receiving the Files: 

1. Open the MX5 file first that you have received in MAXQDA 11. 

2. Select the Unpack bundled data files option from the Project drop-down menu and 

choose the ZIP file that was sent with the external files. MAXQDA unpacks these exter-

nal files and puts them in the appropriate folder, so that they are connected to the new-

ly-opened project. 

18.2 Exchanging Coded Segments, Memos, and Variables for 

Documents and Document Groups 

MAXQDA also supports a second type of teamwork, which allows people in the team to 

work on documents at the same time. It is required that everyone has the same exact data 

set, meaning that each person has a copy of the project on their own computer. 

Tip: Every person must work with an identical form of the texts, meaning that it has the 

same number of paragraph numbers, etc. The formatting, though – text type and size – 

does not need to be the same. 

The following example is set up for only two different PCs, but the same principle works for 

as many PCs as you want. 

PC 1 

Project with documents and codes 

PC 2 

Project with the same documents 

and codes as on PC1 

Tip: It doesn’t matter if there are more documents on one PC than on the other, but those 

that are the same must have the exact same structure on both computers. 

If “Interview 1” was coded on PC 1, how do you make this work available to someone else 

in your team? And what if new codes were created during this process? In this case, it 

doesn’t make sense to send the project file, because the work that the person has done on 

PC 2 would be lost. It is necessary in this case to simply transfer the work done on that sin-

gle document. 

In MAXQDA, you can do this as follows: 

1. The person working on PC 1 right-clicks on the text “Interview 1” in the “Document 

System” and chooses the option Teamwork export. 

2. MAXQDA then exports all the information about this document, including coded seg-

ments information, memos, variables, and external links as a document with the name 

“Interview 1.” 
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3. The file has the ending MEX (Max-EXchange format). You will be able to tell later then 

that this is your document with all the necessary information about your document in 

MAXQDA. 

 

Choosing to export the information for the document “Teresa” 

If you want to document all of the coded segments that you are exporting for the person 

that will be receiving it, you can do so by right-clicking on the document a second time 

and choosing to see the Overview of coded segments. You will then have a list of the 

segments in the following form: 
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List of all coded segments in the document “Teresa” 

You can then export this table and/or copy it to the Windows clipboard and paste it into a 

word processing document, so you can print it out. 

Note: The “Teamwork export” file contains all coded segments, memos, variables, and 

external links for a document regardless of what you may have activated. This means that it 

is not possible to export only those segments coded with a certain code. The rule is: all or 

nothing. 

The MEX file can then be sent as an email attachment or transferred with a flash drive. It is 

recommended here again that you first compress it as a ZIP file, so that the email program 

is sure to be able to read it. 

Import the MEX File 

The exported file can be imported on any PC where the same document with the same text 

structure is present in the “Document System.” This works in the same way as the “Team-

work export.” Right-click on the document in the “Document System” on PC2. Then 

choose Teamwork import and choose the appropriate file in the dialog box. 

Tip: It is recommended that you back up your project before any import of teamwork. You 

can do this by choosing the Backup project option in the Project drop-down menu. 

You will then see a dialog field where you can check the source and target documents. If 

the documents already have the same name, you don’t need to change anything, since 

MAXQDA will already assume this is the document you want to import the MEX file for. If 

the documents have different names, you’ll have to choose the appropriate document in 

the target column. 

You can then decide what exactly you want to import: coded segments, memos, variables, 

and/or external links. You can also choose to view a protocol after the import, so you can 

later document exactly what was imported. The standard settings are to import all aspects 

of the document. 
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Options for importing teamwork 

Important: The document that you are importing the coded segments, memos, and varia-

bles to must have the exact same structure as the document that is receiving the infor-

mation. To make sure you’re not importing a completely different document, MAXQDA will 

ask you once again to confirm the import. 

MAXQDA’s Import Process for Coded Segments and Memos 

MAXQDA proceeds as follows with the imported coded segments: 

 All coded segments existing before the import procedure remain coded. 

 If additional segments in the imported file are coded with a code common to both doc-

uments, these segments in the destination file are also coded. 

 Codes and subcodes that were not found in the “Code System” of the destination file 

will be created. 

 Coded segments that already exist will be ignored to avoid the double-coding of a seg-

ment. 

 Comments for coded segments won’t be imported, if the segment is coded with the 

same code already. 

Document memos within a document are always imported (exception: memos at the same 

position with the same title). The memos that are attached to a document or document 

group in the “Document System” as a document memo or attached to codes in the “Code 

System” as a code memo are handled differently. Since there can’t be more than one of 

each of these memos, one of the versions of the memo has to be kept, and one has to be 
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ignored. If a memo already exists in the project, the memos from the imported project will 

not be included. 

Variables are handled slightly differently. Variables that did not previously exist in the pro-

ject are automatically created, and the variable values are inserted. If the variables already 

exist, just the values will be updated. 

To make sure that the import procedure was carried out correctly, it is recommended that 

you open the document and check the codes. You could also obtain a list of all coded seg-

ments and memos with the “Overview of coded segments” and the “Overview of memos.” 

If you checked the box to create a protocol file, it will contain the following information: 

 

The start of an import teamwork protocol 

18.3 Exchanging Coded Segments, Memos, and Variables for 

Document Groups or the Entire Project 

In MAXQDA, you can exchange coded segments, memos, and variables not only for indi-

vidual documents, but also for whole document groups or even the entire project. You 

should be careful when using this function, since a lot of things will happen and it is diffi-

cult to maintain an overview. It is highly recommended that you backup your project before 

you start the import procedure. 

When exchanging data on the level of document groups, the same rules will apply as with 

individual documents. To start the import function, right-click on the document group 

and choose Teamwork import from the context menu that appears. 
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As soon as the import procedure has been started, a dialog sheet appears. Here you can 

link source and target files. MAXQDA presents a list of correspondences, according to doc-

ument names, that may be modified by the user. Double-clicking the name of the target 

files opens a list where you can choose between all the document names of the selected 

document group. 

 

Options when importing teamwork for an entire project 

18.4 Merging MAXQDA Projects  

Another teamwork feature in MAXQDA is the option to merge two projects. The “Merge 

projects” function causes all elements of a second project to be added to a project you cur-

rently have open. To do this, follow these steps: 

1. Open the larger of the two projects you want to merge. 

2. Choose Merge projects from the Project drop-down menu. 
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3. Select the project to be merged from the dialog window that appears. 

MAXQDA then starts the merging procedure, which may take some time, depending on 

the size of the two projects. 

Project A and Project B must have different project names. The merge function is carried 

out in the following manner: 

 All the document groups and documents of Project B are inserted in the “Document 

System” of Project A. 

 All memos of Project B are inserted in the Memo Manager 

 All the codes of the two projects are merged. In the case that a code or subcode does 

not exist in the “Code System” of Project A, this code is created and inserted in its place 

in the list. 

 All variable and variable values are merged. 

These rules may not seem too complicated. But many questions will arise when you use the 

function, such as: 

 What happens if a document group with the same name already exists in the opened 

project? The document group will be imported, too. You may rename or remove text 

group later. 

 For all variables that exist in Project A but not in Project B, MAXQDA will define new 

variable values for Project B. Numerical values will be set to zero, string values to blanks. 

 All variables existing in Project B but not in Project A will be created and the variable 

values for Project A will be set to zero (numeric variables) or blanks (string variables). 

 If variables with the same name but different variable types exist in the two project files, 

then both variables will be maintained. When the import procedure is complete, two 

variables will exist in the resulting project file. 

 Summaries are not imported. 
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19 The Document Type “Table” 

19.1 Importing or Creating Table Documents 

It is possible to insert and analyze XLS or XLSX with MAXQDA 11 project, especially to code 

the data and attach memos. As with other file types (DOC, DOCX, PDF etc.), you can im-

port table documents in the following ways: 

 Drag & Drop the file from Windows Explorer into the “Document System,” 

 with the menu function Documents > Import Document, 

 with the Import Document(s)  button in the “Document System.” 

What happens when a table document is inserted into a MAXQDA project? 

 The first worksheet in the Excel workbook will be imported. 

 Hidden columns in Excel will also be imported. 

 The columns are numbered according to their order, whereby the contents of the first 

row will be used as the column header. 

 The row order will remain the same when imported. 

 The font will be set to Verdana, size 8. 

 

Imported table document in the “Document Browser" 

Table documents are indicated in the “Document System” with a  symbol. 
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From the menu function Documents > Create document, you can create a new table 

directly in MAXQDA and select the number of columns and rows. 

 

Select the number of columns and rows when creating a new table document 

Note: Once a table is created, new columns cannot be added at a later time. 

19.2 Converting Text into a Table  

It is possible to automatically convert a text document into a table document. To do so, 

double-click on the selected text document in the “Document System” to open it, then 

choose Documents > Convert text to a table from the menu. A menu will appear in 

which you can select the number of columns. 

 

Select the number of columns for the table 

Note: The original text remains after the conversion 

A new table document will appear in the “Document System,” which can be recognized by 

the  symbol, and has the same name as the original document. Each paragraph of the 

original text is placed in an individual row of the table. If the table contains more than one 

column, the text will be placed only in the first column. 
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The original text is placed only in the first column. 

As shown in this image, original text can be easily paraphrased or summarized using this 

function. By switching into Edit Mode you can fill the empty columns of the new table with 

the corresponding summaries. 

19.3 The Table View in the “Document Browser”  

Table documents in MAXQDA will be automatically formatted in “Verdana” font, size 8. It 

is not possible to modify the format. 

You can zoom in to the table from the “Document navigation” toolbar. The font will 

appear accordingly larger or smaller. The height of the rows will be automatically set to the 

height of the largest cell. 

Notes on the Columns 

Columns will be numbered according to their order in the Excel table when imported. The 

column number appears at the beginning of each column header and cannot be modified 

after the import. The column numbers for coded segments, memos and references are as-

signed as page numbers, so there is no risk of ambiguity. 

When the table document is imported, the first row of the imported document will become 

the column header. This column header can be modified by right-clicking on the column 

and selecting Edit: 
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Modify column header 

When you import a table each column will be assigned a type automatically: 

 Text 

 Numeric 

 Date/Time 

To change a column type open the drop-down menu “Type.” 

Note: It is not possible to to modify the column type if the column contains coded seg-

ments. 

The column widths and column positions can be modified using Drag & Drop. Like overview 

tables, table documents in MAXQDA can be sorted by clicking the column header. The ori-

ginal order can always be restored by right-clicking on the column header and selecting 

Reset sorting. Alternatively, you can click on the empty column header just above the row 

number. 

 

Modify table view 

You can access the following opions by right-clicking on the column header: 



The Document Type “Table” 

 

285 

 

Context menu of a column header 

Hide – hides the column. 

Edit – allows the modification of column name and column type. 

Select fields – opens a window in which the columns to be displayed can be selected. 

Reset Sorting – restores original order after import. 

Notes on Table Rows 

The row numbers are fixed when the table is imported into MAXQDA, and cannot be modi-

fied. 

A row in the table corresponds to exactly one paragraph. Within a cell, there is no differen-

tiation between paragraphs. 

19.4 Edit Table Documents 

The contents of individual cells can be modified. In order to do so, click on the Edit mode 

on/off  button in the “Code” toolbar. 

Tip: To insert a paragraph within a cell, hold down the Alt key and press Return. 

The Windows clipboard can also be used with table documents. To copy the contents of an 

activated cell onto the clipboard, right-click on the cell or press Ctrl+C. In Edit mode, you 

can paste the contents from the clipboard into an activated cell by right-clicking the mouse 

or by pressing Ctrl+V. 

19.5 Coding Table Documents 

Any text segment of any cell can be coded. FIrst, double-click on the cell in order to select 

the contents. The cell will then be outlined in yellow, and you can mark a text segment. All 

of the usual MAXQDA coding options, including color-coding and coding with emoticons, 

are now available. It is not possible to code across multiple cells. 
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Coded text in a cell 

Note: When you hide a column, the corresponding coding stripe in the “Document Brow-

ser” will also be hidden. 

19.6 Notes on Retrieval Functions in Table Documents 

The retrieval options are identical to those for text documents. For example, overlap will be 

handled in the same way as it is with normal text. The retrieval functions also include hid-

den columns and are based on the current configuration of the table. Retrieval functions 

for a single row correspond to those for a single paragraph. 

The Near function in the Code Matrix Browser and for complex retrivals applies to columns 

in table documents. This means that only the vertical proximity of two codes, and not the 

horizontal or diagonal proximity, will be taken into account. 

Click on the source data in the “Retrieved Segments” to indicate the coded text in the 

“Document Browser” and display the corresponding column. 

19.7 Memos in Table Documents 

As with all documents in MAXQDA, you can assign memos to table documents. Memos 

can be assigned to individual cells. There are two ways to assign a memo to a cell: 

1. Double-click in the grey memo field next to the table, or 

2. Right-click on a cell or marked text segment within a cell and select New Memo. 
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Inserting memos into a table document 

When you click on a menu symbol, MAXQDA will indicate to which cell this memo is assig-

ned. 

Note: When a column is hidden, the memos assigned to the cells in this column will also be 

hidden. 

19.8 Table Documents and Visual Tools 

In principle, hidden columns in table documents will be taken into account when using Vi-

sual Tools. 

Code Matrix Browser functions as with any other type of document, as only the number 

of coded segments for a particular code will be analyzed. 

Code Relations Browser functions as with overlapping innormal text. Overlap can only 

occur within a particular cell. The “Near” function will search only for coded segments in 

the same column. 

Crosstabs functions as with any other type of document, as only the number of coded 

segments for a particular code will be analyzed. 

Codeline Each row represents a paragraph in the Codeline - the column structure is igno-

red in this case. Hidden columns will be taken into account. Paragraphs will be sorted in 

their original order. 



Printing and Exporting Table Documents 288 

Document Comparison Chart As with the Codeline, each row in the table represents a 

paragraph - the column structure is ignored. Hidden columns will be taken into account. 

Paragraphs will be sorted in their original order. 

Document Portrait This tool operates differently than with regular documents. Columns 

will be more or less ignored; cells will be processed from left to right, then top to bottom. A 

one-dimensional structure is then created, which is displayed as usual in the Document Por-

trait. 

19.9 Printing and Exporting Table Documents 

Table documents can be printed like other documents. Click on the Print document  

button in the “Document Browser” or select Project > Print > Displayed Document from 

the menu. 

MAXQDA will display codes and memos next to the text upon demand. 

Note: Only the first columns of the currently displayed table will be printed, subject to 

space on the page. Only the codes and memos for the displayed columns will be displayed. 

Table documents can be exported as XLS/X files. Click the Export displayed document  

button in the “Document Browser” or select Project > Reports & export > Document 

Browser from the menu. Alternatively, you can right-click on the table document in the 

“Document System” and select Export document. 
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20 Transcribing and Coding Audio and Video Files 

20.1 General Information about the Analysis of Audio and 

Video Files  

MAXQDA 11 allows you to code audio and video files directly without having to provide a 

transcript. The coded segments are treated like any other segments in MAXQDA. You can 

retrieve, comment and assign a weight to these segments in the same way as with other 

segments. Thanks to this improvement of MAXQDA, you are now able to analyze a wide 

range of different types of data – text, tables, PDFs, audio and video files – all within the 

same program. 

MAXQDA 11 also has improved transcription functions for audio and video files. Now, you 

can set a rewind interval and adjust the replay speed and volume. You can also import your 

f4 transcripts as usual. MAXQDA will automatically detect timestamps. You can use these 

timestamps to link your transcripts to the original media files and replay them synchronous-

ly. 

20.2 The “Media player” Toolbar  

To transcribe or code an audio or video file with MAXQDA, you need to work with the 

“Media player” toolbar. This toolbar offers various functions such as playing media files. In 

order to work with it, you should become familiar with this toolbar and understand how it 

works. 

To open this toolbar, go to the toolbars drop-down menu and select Media player. 

 

“Media player” toolbar 

The symbols in the toolbar give you access to the following functions (from left to right): 

  Media Player: switch on/off – turns on the media player and loads the media file into 

the Multimedia Browser. You can compare this to turning on a CD player and inserting a 

CD. 

  List timestamps – opens/closes the timestamp table of the current file. 

  Sync mode – turns on/off sync mode, which causes the text to follow the media file, 

comparable to a teleprompter. 
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  Multimedia Browser – turns on the Multimedia Browser, where you can play videos 

and code media files. 

  Control Panel – opens the Control Panel, where you can adjust the playback options 

for audio and video files. 

  New timestamp F8 – inserts a timestamp in a transcript or a media file. 

  Prev F3 – rewinds the media file to the previous timestamp. 

  Stop – stops playback and jumps back to the beginning of the file. 

  Play/Pause F4 – pauses playback at the current position and resumes playback at that 

same position. You can set a rewind interval to resume playback from an earlier position. 

  Next F5 – fast forwards the media file to the next timestamp. 

On the right next to these icons, you see the time elapsed and total time of the media file. 

You can jump easily to a certain position using the slider on the right. 

20.3 Inserting Audio and Video Files 

Just as before, audio and video files are not imported into MAXQDA but are saved in the 

MAXQDA Externals data files folder and are linked with a text document. Documents with 

an assigned media file are marked with a symbol in the “Document System:” a musical 

note for audio files and a film strip for video files. 

There are different ways of making audio and video files available for use in MAXQDA: 

1. You can either select Import document(s) in the Documents drop-down menu, 

2. Or right-click on the root directory in the “Document System” or a document group 

and select Import document(s), 

3. Or click on the button Import Document(s)  in the “Document System.” 

A dialog window will appear which shows all files that MAXQDA can read. Select a media 

file and click Open. 

Tip: You can also easily insert audio and video files from Windows Explorer into the 

“Document System” via Drag & Drop. 

This creates a new document named like the media file; this document is linked to the me-

dia file. The media file itself is saved in the MAXQDA Externals data files folder which you 

can set in the main menu by selecting Project > Options. If a file with the same name al-

ready exists, MAXQDA will ask you if you want to replace the existing file. 
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Note: When inserting a new file, MAXQDA shows a standard set of the most common au-

dio and video files (MP3, WAV, WMA, MP4, MPG, AVI, FLV, WMV). 

You can, however, assign any media file to a document if the correspondent codec is instal-

led on your computer. If the codec is installed, Windows Media Player will be able to read 

the file. For further information, please follow this link. 

You can also assign a media file subsequently to an existing document. To do so, right-click 

on the document in the “Document System” and select Properties. Here, you can insert or 

change a link to a media file. 

 

Assigning an audio or video file subsequently to an existing document 

Note: When inserting or assigning a media file subsequently, MAXQDA creates a file with 

the suffix DAT in the location where the media file is saved. This file has the same name as 

the media file. MAXQDA needs this file to display the media file rapidly which is why DAT 

files should not be deleted. 

Playing Audio and Video Files in MAXQDA 

To play a media file in MAXQDA: 

1. Double-click on the document containing the media file in the “Document System”. This 

turns on the media player and loads the file for playback. If the “Media player” toolbar is 

not already visible, it will open after double-clicking. If you want to play a video, the 

Multimedia Browser window will appear. 

2. Click on the icon Play/Pause  on the “Media player” toolbar or press the F4 key. 

http://m22.maxqda.de/faq/welche-medienformate-werden-vom-maxqda-media-player-unterstutzt
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20.4 Coding Audio and Video Files in the Multimedia Browser  

The Multimedia Browser 

Using the Multimedia Browser you can easily play and code audio and video files. To open 

the Multimedia Browser, there are various options: 

 Click the icon Multimedia Browser  on the “Media player” toolbar. To do this, the 

Media Player has to be turned on by clicking the icon  (you can only do this when a 

document with a media file assigned to it is displayed in the “Document Browser”). 

 Double-click on a document with a video file assigned to it. These documents are 

marked with the symbol . This opens the document as well as the video file in the 

Multimedia Browser. If the “Media player” toolbar is not visible already, it will open up 

automatically. 

 Select Open document and audio file in the context menu of a document that has an 

audio file assigned to it. If the “Media player” toolbar is not visible already, it will open 

now. 

 

Opening audio files using the context menu in the “Document System” 

The following screenshot shows the structure of the Multimedia Browser: 
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The Multimedia Browser window 

For video files, the Multimedia Browser consists of five panels: 

 The upper panel shows the video. 

 Underneath, there is a toolbar containing the functions to adjust the view and playback 

and the functions for coding. Here, you can also see the current playback position and 

the total time of the media file. 

 Beneath the toolbar, preview pictures are shown. 

 Underneath, you can see the waveform of sound of the media file, and below this, 

there is a time line where you can see the current playback position precise to the sec-

ond. 

 Under the time line there is a bar for the timestamps. 

 At the very bottom is an area where the coded segments are visualized by bars. 

For audio files, the video window and preview pictures are not shown. 
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The blue vertical line and the blue bar underneath the time line indicate the current play-

back position. 

The following functions are available on the toolbar: 

  Control Panel – opens the window with playback options 

  Snapshot – saves a screenshot of the current video picture 

  New memo – creates a new memo in the current playback position 

  New timestamp – inserts a timestamp in the current playback position. 

Note: In order to insert a timestamp directly into an audio or video file, the text document 

associated with this file must contain at least one character because timestamps refer to 

both the transcript and the media file. 

  Set clip start – sets the beginning of a clip segment at the current playback position 

  Set clip end – sets the end of a clip segment at the current playback position 

  Play clip – plays the segment selected on the waveform 

  Remove clip – removes current clip marks from the waveform 

  Go to beginning – jumps back to the beginning 

  Prev – rewinds the media file to the previous timestamp. 

  Stop – stops playback and jumps back to the beginning 

  Play/Pause – starts/pauses playback 

  Next – fast forwards the media file to the next timestamp. 

  Go to end – jumps to the end 

  Slider – helps you jump to a certain position 

  Info – opens Help 

On the far right of the waveform, there are other icons that you can use to adjust the zoom 

for the waveform and for the preview pictures of videos. The icons are hidden in order to 

not cover the waveform. They appear as soon as you move the cursor over this area. 
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  zooms out of the waveform, reduces the number of preview pictures for videos. 

  zooms the view to 100%. This view is configured by default and is usually ideal for 

coding. 

  shows the complete media file in the Multimedia Browser; this gives you an overview 

of the waveform of the complete file. This view is usually not suitable for coding. 

  zooms into the waveform, increases the number of preview pictures for videos. This 

makes it easier to navigate to single pictures and words. 

  hides the preview pictures bar. 

Coding in the Multimedia Browser 

You can code audio and video files in the same way as texts in MAXQDA. You start by 

marking a segment of the waveform (a so called “clip”). Typically, you will want to set the 

beginning and end of a segment in a media file precisely to the split second as the scene 

and content can change completely from one moment to the other. For this reason, 

MAXQDA offers a number of functions that allow you to mark an audio or video clip: 

 To roughly mark a segment, keep the left mouse button pressed and select the segment 

by dragging the cursor over the waveform. The time limits are displayed underneath the 

beginning and end marks. 

 You can easily alter the time limits of the clip by moving the whole blue-marked seg-

ment or by clicking and dragging the outer borders of the segment in the waveform. 

 To play the marked clip, click the icon Play clip or press the F11 key. 
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Marking a clip 

 You will usually play a media file and then pause exactly at a position where you want 

to set a new coding. To do this, use the button Play/Pause  or the F4 key. 

 When the playhead is at the designated position, click the button Set clip start  or 

press the F9 key. 

 Now resume playback and pause at the position where you want to end the coding. 

Click the button Set clip end  or press the F10 key. 

 

Setting the clip limits at the current playback position 

You can now code the selected segments as usual, for example by (a) dragging and drop-

ping the marks on to a code, (b) clicking on an emoticode, or (c) by clicking a color code. 

Right-clicking on a marked segment opens a context menu that contains three options that 

are relevant for coding: 
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Context menu on a marked clip 

When coding is completed, it will be indicated by a horizontal coding stripe in the Multi-

media Browser. Below it, on the left, the code name is displayed. The coding will also be 

indicated by the color of the waveform (green for standard codes, other colors for color 

codes). If various codes are layered on top of each other, the color of the waveform is a mix 

of the colors. Coded segments with an emoticode are indicated by the Emoticon next to 

the coding stripe. 

Clicking on a coding stripe selects the coded segment on the waveform. Double-clicking 

plays the clip. 

 

Visualization of codings in the “Multimedia Browser” 

Right-clicking on a coding stripe opens a context menu containing the usual options: 

 Modify weight 

 Edit comment 

 Delete 

Coded segments which have a comment are marked with a white square on the left hand 

side of the coding stripe. 

Audio and Video Clips in the “Retrieved Segments” 

In the “Retrieved Segments” window, video clips are shown using the first picture of the 

video clip. For audio clips, a picture of a waveform is shown. 

The time indication tells you when an audio or video clip starts and ends. 
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Audio and video clips in the “Retrieved Segments” 

Attaching Memos to Audio and Video Clips 

You can attach memos for notes to any playback position. To attach a new memo, 

 Right-click a position of the waveform 

 Or click the button New memo  in the Multimedia Browser toolbar. 

 

Creating memos 

20.5 Notes on Synchronizing Transcripts and Media Files 

You can use timestamps – which are visualized similar to the way memos and coding 

stripes are seen in the “Document Browser” – to synchronize your transcripts with the orig-

inal audio or video files. These audio and video files can even be played in MAQDA in the 

integrated media player. A timestamp table also lets you insert comments for each section 

of your transcript represented by that timestamp, so you can later search for these com-

ments and go directly to that section of the text or audio and video file. 

There are three different ways to work with text and audio and video files: 
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Option A 

First you do the text transcription with whatever transcription software you want to use, 

import the transcription as a document in MAXQDA, and then link the document to the 

original audio/video file. At this point, there aren’t any connections between specific seg-

ments of the transcript and parts of the external file. These connections have to be created 

with timestamps within MAXQDA. 

Option B 

The first step in this variation is to transcribe the file with the professional software f4 

(http://www.audiotranskription.de/english/home), in which you can create timestamps as 

you transcribe. You can then export the transcript in RTF format and import it into 

MAXQDA, and the timestamps are imported along with the text. You will then already 

have the connection between your text and the audio or video file. 

Option C 

In this variation, you transcribe the file within MAXQDA. 

The second variation is the most efficient, because you have the advantage of a profession-

al transcription software, and – as opposed to in the first variation – you don’t have to cre-

ate the timestamps within MAXQDA. The option to transcribe audio and video files directly 

in MAXQDA doesn’t have as many features as a program that is designed to only do the 

specific task of transcription. It is, however, possible since MAXQDA 10. 

20.6 Importing Transcripts without Timestamps and 

Subsequently Inserting Timestamps (Option A) 

This variation will be explained with a song as an example. Let’s say we wanted to have a 

synchronized connection between the text and the audio for the song “I Want You” by 

Bob Dylan. To save us the time of doing the transcription, we can get the text from Dylan’s 

website. We can then either copy it and paste it into a document in MAXQDA, or we could 

paste the text into an RTF or DOC/X file and import that file into MAXQDA. For this exam-

ple, we’ll name the document “Dylan: I want you.” Once the text is in MAXQDA, we need 

to create the connection to the audio file. 

 Right-click on the document “Dylan: I want you,” and select Properties from the con-

text menu that appears. 

 Click in the field next to the Media file label in the Multimedia section. You will see a 

button with “…” on it just to the right of the field. Clicking on that button will open up 

a window, so you can find the audio or video file (in this case, the Bob Dylan song). 

Click Open. 

 Close the Properties window. 

http://www.audiotranskription.de/english/home
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The MAXQDA document with the Dylan text is now linked to the audio file, but the audio 

file wasn’t actually imported as part of the MAXQDA project. You will now see that the 

symbol next to the “Dylan: I want you” document has changed. This is the symbol for a 

document linked to a media file: 

 

Insert timestamps into a MAXQDA transcript 

Double-clicking on this document opens it in the “Document Browser” (see below). A new 

column has been inserted between the text and the paragraph numbers, which will show 

your timestamps. The document only has one timestamp at this point, representing the very 

beginning of the song, since we haven’t added any yet. To play the song with the internal 

media player, you need to activate the “Media player” toolbar from the Toolbars drop-

down menu. You can then click on the Media Player switch on/off  button in this 

toolbar to activate the media file. 

 

Imported transcript with media file connection 

Next, we would want to put the cursor at the beginning of the actual song text, right be-

fore “The guilty undertaker …” and start playback of the song. We can do this by clicking 

on the Play button or using the F4 key on the keyboard. We would then let the song go 

until right before the singing begins and insert a timestamp by clicking on the New 

timestamp button or by pressing the F8 key. We want to do this same thing for the be-

ginning of each verse. We would then see a timestamp symbol next to the first line of each 

verse. 
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Timestamp in front of the verses 

We can now use the synchronized text and audio together. By clicking on any of the 

timestamps, we will hear the song played from that point. If you do this with an interview 

transcript, you can in a similar way get back to various sections that you may want to hear 

again for tone or emphasis. 

If you turn on the Sync mode in the toolbar and click on the timestamp next to the first 

verse, the text follows the song, meaning the section of text being sung will be highlighted, 

similar to the way karaoke works. You can then follow along with the song text as you hear 

it. 

20.7 Importing f4 Transcripts with Timestamps (Option B) 

When transcribing with f4, it is recommended that you set up a standard structure of 

timestamps. The easiest way to do this is to set the program to automatically insert a 

timestamp every time you hit the Enter/Return key. It is also recommended that you take 

advantage of the shortcut keys to mark which sections are being spoken by different peo-

ple (e.g. in group discussions). This is accomplished selecting Insert time stamp at the 

end of each paragraph in f4. 

 

f4 option for automatically inserting time stamps 

Important: MAXQDA can interpret timestamps in a transcript only when they appear at 

the end of a paragraph. 
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Furthermore, when transcribing, it is useful to make use of f4 keyboard shortcuts in order 

to differentiate between speakers, for example in group discussions or interviews. 

To import the transcript including timestamps and media files into MAXQDA, follow these 

steps: 

1. Save the transcript in f4 as a RTF file. Ensure that the option Save with time stamps is 

selected. Timestamps will then remain in the text, marked with a “#” symbol at the be-

ginning and end. 

2. Insert the file into the “Document System” in MAXQDA by selecting Documents > Im-

port document(s), or with the Import document(s)  button in the “Document Sys-

tem.” 

3. When the file is imported, MAXQDA automatically recognizes that it contains 

timestamps and prompts you to select the appropriate media file. Choose the appropri-

ate file from the dialog window and confirm your selection by clicking OK. 

4. When the file is imported, MAXQDA formats and inserts timestamps into the 

timestamps table, removing them from the text for improved readability. 

Important Note 1: MAXQDA allows only one timestamp per paragraph. If a paragraph 

contains several timestamps, new paragraphs will automatically be created. 

Important Note 2: The timestamps are only imported when a media file is selected. Sub-

sequent automatic linking of transcripts with media is not possible! 

5. Open the imported document by double-clicking it in the “Document System.” 

Note: Documents with associated media files are marked with special symbols:  for 

audio files and  for video files. 

When imported, timestamps from text, audio and video files will appear in the correspond-

ing column before the text in the “Document Browser.” 

 

Timestamp display in MAXQDA 

The audio or video file will not be loaded automatically when you open MAXQDA, but only 

when it is activated in the “Media player” toolbar – the “Media player” toolbar must there-
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fore be displayed first (via the Toolbars drop-down menu). To load the media file click on 

the Media Player: switch on/off  button. 

20.8 Transcribing Directly in MAXQDA (Option C) 

It is also possibly to transcribe audio and video files directly in MAXQDA. To do so: 

1. Right-click on a document group or the Documents icon in the “Document System” 

and select Transcribe audio/video from the context menu that appears. 

2. You will then see a dialog field, in which you can select the file to be transcribed. 

MAXQDA automatically creates an empty document named like the media file, connects it 

with the media file and opens it in the Edit mode in the “Document Browser.” You can 

now play this file in MAXQDA’s media player and start the transcription in the empty doc-

ument. The waveform of the media file will be opened in the Multimedia Browser so that 

you can navigate easily. 

 

Empty transcript and waveform in the Multimedia Browser 

From this point on, you can play data on MAXQDA's built-in Media player, and begin the 

transcription process. You can process media files and insert timestamps using the icons in 

the Multimedia Browser and “Media player” toolbar as well as various keyboard shortcuts: 

  New timestamp F8 – inserts timestamp into the transcript or directly into the media 

file. 

  Prev F3 – jump to previous timestamp in the media file. 

  Stop – stops playback and returns to the beginning of the file. 
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  Play/Pause F4 – stops playback at the current position and continues at the same 

point – using the rewind interval. 

  Next F5 – jump to next timestamp. 

You can also access further transcription options via the Control Panel  icon in the 

“Media player” toolbar. 

 

Set options for playing media files and transcribing 

  Volume – set volume from 0 to 100 percent. 

  Playing Speed – allows adjustment of playing speed from half to one-and-a-half times. 

  Rewind Interval – Sets number of seconds to rewind from 0 to 10 when you start 

playing a media file. 

  Timestamp on enter – If this option is selected, a timestamp will au-

tomatically appear in the “Document Browser” each time you press the Enter key. 

In order to facilitate the transcription process, MAXQDA 11 offers improved foot pedal 

functionality for audiotranskription.de foot pedals: 

 Previous versions of MAXQDA supported only the yellow “Science” switch, whose func-

tion is the same as the F4 key: Press once to play, and a second time to stop. 

 In MAXQDA 11 (and in MAXQDA 10 from Release 111111) the black “Science II” 

switch is also supported. This switch can be held down to play media data, and will stop 

playing when released. 

20.9 Synchronizing Transcribed Text with Audio/Video files 

MAXQDA allows you to play an audio or video file at the same time as the transcript. You 

can view media files synchronized to their transcribed texts, like a teleprompter for a televi-

sion presenter, or karaoke, in which you can read the text on the screen while listening to 

the music. 

http://www.audiotranskription.de/
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To start a synchronized playback, click on the Sync mode button in the “Media player” 

toolbar. 

 

Activate Sync mode from the “Media player” toolbar 

Begin by clicking the Play button or the F4 key. You can also click on a timestamp in the 

document. 

20.10 The List of Timestamps  

The timestamps list has as many rows as there are timestamps in the document, and every 

row has three columns. The first two columns contain the start and end points of that seg-

ment. In the third column, you have the option of writing in a short comment about that 

particular segment. 

 

The list of timestamps 

These columns are set up just like columns in any other MAXQDA table. Clicking on any of 

the column headers sorts the table by that particular column alphabetically (another click 

changes it to reverse alphabetical order). You also have the option to search in a column by 

right-clicking on the column header and selecting Search. If you don’t know if your search 

term is the first word in the column, you can insert a “*” before your term. (A search for 

“*any” would find the word “company,” for example.) 

If you are importing a document with timestamps, you still have the option to add new 

ones once it has been imported into MAXQDA. The option to write your comments in the 

list of timestamps also gives you a new way to find sections of your media file. Double-

clicking on a row takes you to that section of the text in the “Document Browser” and 

starts playback of the media file from that point. 
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21 Admin System for User Management 

21.1 Calling Up and Activating User Management  

MAXQDA 11 supports teams working on projects with an optional user management sys-

tem, in which you can set different rights for different groups of users.  

Note: The admin system is not designed to ensure secure of your projects, just for working 

together in teams. 

To activate user management, select Project > Activate user management from the 

menu. 

 

Activating user management 

The user who activates the user management will automatically become administrator and 

has to set a password for his user name. 
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Set admin password 

Caution: Note your password carefully! Without this password, the MAXQDA project can 

no longer be opened. 

Once the administrator has been established, user management can only be opened with a 

valid administrator name and password. The next time the project is opened a login 

window will appear and you'll be prompted for a valid user name and password. 

 

Login window 

In the default configuration, only administrators are able to open the user management, 

add users or change rights. 

21.2 The Main User Management Window  

In the main user management window, you can create new users, remove existing users, 

and define the rights of individual user groups. 
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Main user management window 

On the left side of the user management window, the various levels (Admin and Levels 1-3) 

are displayed. The right side of the window contains information about each user, which 

can be created or edited here; it is also here that users can be assigned to one of four user 

groups. 

Adding a New User 

Click on the Add user  button to add a new user. The new user settings can subse-

quently be edited: 

User: Here you can set the user name (= Login name), with which the user can log into the 

project. 

Group: Here you can set the level within the hierarchy to which the user is assigned. 

Name: Here you can enter the user's real name. 

Comments: In this field, you can post comments regarding the user. 

The properties of a user can be modified at any time by clicking on the user name in the 

left side of the window. 

Deleting Users 

To delete a user, select the user name in the left side of the window and click the Delete 

user  button. You will be required to confirm your selection. 
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User Passwords 

User passwords can be managed in two ways. If no password has been set by an admin, 

each user must first log in and set his own password. Alternatively, the administrator can 

set an initial password and communicate it to the other users. In order to set the initial 

passoword, click the Set initial password  button. The users can then access the 

MAXQDA project with this password, and set their own passwords upon first use. Only the 

user will know this new password. If a user forgets his password, the administrator can re-

set it by clicking the Reset user password  button. The administrator can also reset the 

initial password in this way. 

Initial Password 

The purpose of the initial password is to act as a barrier to entry into the project. New users 

must enter this password the first time they log into a locked MAXQDA project, before set-

ting their personal passwords. 

Hierarchical Levels 

When you click on a particular level in the left side of the window, the rights of the users at 

this level will be displayed on the right side of the window. Aside from the Admin Level, 

users can be placed in three different groups, from Level 1 to Level 3. In a reseach project, 

the levels can be established, for example, in the following way: 

 Level 1: Project leaders 

 Level 2: Research associates, who can import and delete texts, work with the “Code 

System,” and write, edit and delete memos 

 Level 3: Student associates, who work primarily on the coding of material 

The following image displays the default Level 1 functions. For example, the top three func-

tions are reserved by default for the Admin Level. User rights can be modified at any time 

by clicking on the red or green icon in front each program function. Any number of users 

can be assigned to each level, including the Admin Level. At least one administrator must 

be defined in any case, meaning the last entry in this list cannot be deleted. 
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Define user rights for various levels of the hierarchy 

Modify User Settings 

Click on a user name in the left side of the window in order to modify settings in the right 

side. 

Importing and Exporting the Entire Admin System 

It is possible to export the entire Admin System of a MAXQDA project, including user na-

mes, passwords and user rights. Click on the Export  button on the lower edge of the 

main window. The data will be saved in MXUSR format, which is, of course, encrypted. This 

file can be imported into another MAXQDA project by clicking on the Import  button, 

thus saving the administrator a lot of time. 

Deactivating User Management 

It is possible to deactivate user managment at any time by checking the corresponding box 

at the lower edge of the window, then closing the window. 

 

Option “Deactivate user management” 

All user names and passwords will be saved in the project, so it is possible to reactivate the 

user management at any time. 
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22 Smart Publisher 

22.1 Using Smart Publisher  

Smart Publisher is a convenient report generator. It exports selected retrieved segments in a 

formatted Word document report, including title page and table of contents. The structure 

of the report is determined by the “Code System:” 

 An individual chapter will be created for each top-level code. 

 A subchapter will be created for each subcode. 

 Coded Segments of each code form the content of each (sub)chapter. 

Opening Smart Publisher 

Smart Publisher can be accessed by clicking the icon in the main menu, or Project > Re-

ports & export > Smart Publisher. 

 

 

Opening Smart Publisher 

When Smart Publisher is called up, a dialog window will appear in which you can select the 

codes to be included in the report. When top-level codes are selected, their corresponding 
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subcodes will automatically be included in the report. You can also choose to include coded 

segments only from activated documents. 

 

Selecting top-level codes for Smart Publisher 

When you click on OK, Smart publisher will begin preparing the report. This can take sev-

eral minutes, depending on the number of coded segments to be included. 

Tip: While Smart Publisher is generating your report, you should not use Word. Using Word 

might interfere with the generation of the report. 

22.2 Smart Publisher Settings 

The following dialog window displays the various options available when creating a report. 

For easy navigation, Smart Publisher settings are displayed in seven tabs: 

 

Smart Publisher settings 
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”Title Page” Tab 

 

Title – The title, which will appear on the first page of the report. 

Subtitle – The subtitle, which will appear on the first page of the report. 

Image files 1 und 2 – Selection of up to 2 image files, which will appear on the first page 

of the report. If the field is left blank, no image will appear. 

”Headings” Tab 

 

Table of contents – Heading for Table of contents 

Documents – Heading for listing of relevant documents 

”Header and Footer” Tab 

 

Reports can be formatted to include headers and footers, which will appear on each page 

after the title page. 

Header – Header text 

Footer – Footer text 
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”End Page” Tab 

 

Reports can optionally include an end page, on which to display, for example, a synopsis or 

acknowledgements. 

Title – End page heading 

Text – Text which will appear on the end page 

”Options” Tab 

 

Under the heading “List of sources,” you will find numerous options for the presentation of 

coded segments in the report. 

Quotation Marks – Text segment will be placed in quotation marks. 

Document – Document groups and document names will be displayed in the references 

below the segments. 

Position – The beginning and the end of the coded segment (as well as paragraph num-

bers for textual data) will be included in the list of sources. 

Creation date – The date on which the segments were coded will be included in the list of 

sources. 

Author – The name of the user who coded the segments will be included in the list of 

sources. 

Weight – The weight of the coded segments will be included in the list of sources. 
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The following figure shows an extract from a report that was generated using Smart Pub-

lisher. The displayed segment comes from the paragraphs 35-36 of the document “Jon” 

from the document group “New York.” It was encoded with a weight of 100. The segment 

was assigned the code “Significantly Positive:” 

 

Extract from a Smart Publisher report 

You can limit the output of the report to segments whose weight falls within defined pe-

rimeters. If no upper or lower limit is defined, all segments will be exported. If the fields 

indicating the upper and lower limits are left blank, the minimum (0) and maximum (100) 

will automatically be applied. 

For the order of coded segments, three options are available: 1. by “Document System,” 2. 

by weight score – ascending, and 3. by weight score – descending. 

”Files” Tab 

 

In the last tab, you can indicate which Word template type Smart Publisher should choose. 

The Word template determines the appearance of the report and can be easily modified 

(see below) 

The Finished Report 

The finished report is in the form of a Word document (DOCX format), which includes a 

title page, table of contents, a page which lists of all the documents included in the report, 

and the main section including all of the exported segments. If a header/footer was includ-

ed, it will appear on all pages aside from the title page. If an end page was included, it will 

appear at the end of the report. 
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All elements of the report are formatted using the Word template (DOT format). Formatting 

of the final report can be modified; for example, you can easily insert additional pages or 

content. 

22.3 Alias Names for Codes  

Smart Publisher uses the code names from the “Code System” as headings for the individ-

ual subchapters of the report. However, you may wish to assign an alternate name to some 

or all of the subchapters in the report. This may be the case if the 63 characters per head-

ing allowed by the system are not enough, and you wish to create a longer name, or if, in 

other cases, a shorter heading would be more appropriate. For this reason, MAXQDA al-

lows you to create a “code alias” of up to 225 characters. 

In order to assign a code alias, right-click on the code in the “Code System” and select 

“Code alias for Smart Publisher.” A dialog window will appear, in which you can enter the 

code alias. If a code alias is assigned, Smart Publisher will always use the alias in the place 

of the original code name as the chapter heading in the report. 

 

 

 

Assigning a code alias 

When you click on the root in the “Code System,” a table will appear, in which you can 

conveniently create code aliases for multiple codes. 
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Code Alias Table accessed via the context menu in the “Code System” 

22.4 The Word Template 

Upon installation of MAXQDA, two document templates named “MXReport_A4.dot” and 

“MXReport_Letter.dot” will be installed in the MAXQDA program folder. These templates 

can be opened with Microsoft Word and edited. As the file name indicates, one document 

is set to A4, while the other is set to letter format. You can create multiple versions of the 

Word templates for different occasions and customize them according to your needs. 

Placeholder for Customization of Word Templates 

The Word templates contain placeholders, for example for titles and subtitles written as 

<Title>. These placeholders can be modified just like any other content in a Word docu-

ment. The position of the placeholders can also be modified as desired. 

If a placeholder is deleted, it can no longer be inserted by Smart Publisher. 

The following placeholders can be used: 

 <Date> = Creation date of the report 
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 <Title> = Title assigned on the “Title Page” tab for the report 

 <Subtitle> = Subtitle assigned on the “Title Page” tab for the report 

 <Image 1> = Image file 1 

 <Image 2> = Image file 2 

 <ContentTable> = Table of contents 

 <DocumentList> = Document list 

 <Documents> = List of documents in table form 

 

Placeholders for Word templates 

Format Templates 

The Word templates contain predefined format templates, which should not be deleted: 

 MX_Header1–9 (chapter titles according to the position of codes in the code system) 

 MX_Standard (textual content from coded text segments) 

 MX_Numbering (numbering of individual text segments within the chapter) 

 MX_Table (list of documents in table form) 

The format templates can be customized directly in the Word templates. Formatting of con-

tent can also be customized here. 

Note: The template contains some example text, including headlines and text segment 

presentation, which can be easily adapted to suit your needs. You can modify the sample 

texts, however, when the report is generated, only the tags will be applied and all other 

text will automatically be deleted. 



Project Organization and Data Security 

 

319 

23 Project Organization and Data Security 

23.1 Renaming, Deleting, and Duplicating Projects 

Creating a New Project 

MAXQDA allows you to work with as many different projects as you want. If you want to 

work separately with a secondary data set, you just need to create a new project for it. 

This is how it’s done: 

1. Click on the Project drop-down menu. 

2. Select New project. 

3. Navigate to the folder where you would like to save this new project 

4. Give the project a name and click Save. 

Every project in MAXQDA is given the ending MX5. In order to secure your work, it is rec-

ommended that you back up this file regularly on a CD-ROM, flash drive, or external hard 

drive. Qualitative data analysis is a lot of work, but it only takes a minute to back it up and 

avoid risking a loss of your work if something happens to your computer. 

Deleting a Project 

If you want to delete a project, you can do so in the same way you would delete any other 

file in Windows Explorer. MAXQDA 11 projects always have the file ending MX5, and the 

projects from previous MAXQDA versions have the endings MX4, MX3, MX2, or M2K. It is 

not possible to delete a project directly from the MAXQDA interface. 

Whether or not it is possible to undelete a project depends on your Windows Recycle Bin 

settings, but MAXQDA does not have any control of these operations on the operating sys-

tem level. 

Renaming a Project 

Renaming a project can also only be done from Windows Explorer, not within MAXQDA. 

Right-click on the project file and select Rename from the context menu that appears. 

Duplicating a Project 

MAXQDA projects can easily be duplicated. Simply select Backup project from the Project 

drop-down menu in MAXQDA. This creates a copy of your project file, and it is recom-

mended that you do this on a regular basis, so you can always revert back to older versions 

of your project if you accidentally delete important aspects of it. When you back up the 

project, the backup may be slightly smaller than the original file – this is because the project 

is cleaned up, meaning deleted file associations, for example, are deleted. 



Project Maintenance 320 

This is how it works: 

1. Open the Project drop-down menu. 

2. Click on Backup project. 

3. Choose the folder that you would like to save the file in. 

4. Assign a name for the file and click Save. 

To work with the copy of the project, you will need to open it; unlike the “Save as …” 

function in programs like Word, the newly-created file isn’t opened automatically. 

23.2 Project Maintenance 

Everything that you have deleted in a project is not actually physically removed from the 

MX5 file. This means that the project file doesn’t get smaller when you delete a document 

or document group. These deleted items are only discarded when you duplicate the project 

with the Backup project function. Therefore, if you have deleted many aspects of your 

project as you’ve been doing your analysis, it makes sense to use this function occasionally 

to slim down your project file size. It also makes sense to do this before copying the file to 

an external medium for backup. 

23.3 Manual and Automatic Backups for Projects 

Manual Backup 

It is strongly recommended to make regular backup copies of your project and save them 

on an external device in case of computer damage or failure. Backup copies should be sa-

ved in a different location than your computer in case of theft, water damage, etc. 

You can transfer your MAXQDA data onto an external device with the help of Windows 

Explorer. Alternatively, you can open the project in MAXQDA and select Project > Backup 

project. Then select the destination location and click OK. 

Automatic Backup 

MAXQDA allows you to save projects automatically. Open a project that has a set time limit 

(default 14 days) and is not automatically saved by MAXQDA. A message will appear asking 

if you would like to save the project now. When you accept, MAXQDA will save a copy in a 

selected directory (Default: My Documents\MAXQD11\Backup). MAXQDA provides the 

backup file with a date and time stamp. 

Both the time interval, meaning how often the project will be saved, and the directory for 

the backup files, can be set in Project > Options. There, you can also disable the function 

entirely. 
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Note: Automatic backup is an extra security measure, but by no means replaces the regular 

backup your project files to external media, such as a portable hard drive! 
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24 Documentation and Printing 

24.1 Documentation Options 

If you are working on a project with a large data set and “Code System” – and especially if 

you are working in a team – it can be very important to document the current status of 

your research. MAXQDA is a fairly easy program to get an overview of, but at the same 

time, you might not know how to do so quickly. 

MAXQDA offers the following options for quickly documenting your project: 

In the Project drop-down menu, you will see two options: Reports & export and Print, 

which are both helpful for documentation. Both options give you the opportunity to access 

the contents of the four main windows and save them as a file (RTF- or XLS/X) or print 

them, for example. Here are the various aspects of the project that you can document by 

printing or exporting them: 

 The “Document System” 

 The “Code System” 

 The document currently visible in the “Document Browser” 

 The coded segments currently called up in the “Retrieved Segments” window 

In the “Document System” and “Code System” windows, you will also find various over-

view functions that display information about memos, coded segments, links, and variables 

in table form. Their contents are based on the level of document or code hierarchy that you 

called them up from (e.g. for a document group, for all documents, etc.). These overview 

functions and variable tables also include the option to export them in HTML or Excel for-

mat for documentation purposes. 

In the Codes drop-down menu, you can also call up a table of your codes and coded seg-

ments to be printed or exported. An additional function in the same menu let you view 

code frequencies. 

24.2 Print/Export Settings  

You can adjust various print and export settings by clicking on Print/export settings in the 

Project drop-down menu. The first two options are to add a header and footer and choose 

how you want them to be aligned (right, left, or center). 

If you chose to print or export the “Document Browser” with coding stripes, you also have 

the option to set the maximum width of the coding stripe column. The default is set at 

20%. 
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Print/Export settings 

24.3 How to do Documentation 

This section will give you an overview of the various documentation forms MAXQDA offers 

and how you can use them. 

How many documents, coded segments, memos, etc. are there in the project that is 

currently open? 

 Open the Project drop-down menu 

 Click on the Print option. 

 Choose to print Project information. 

MAXQDA then creates the following report: 

 

Project information report 
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What document and document groups are there in this project? 

 Open the Project drop-down menu 

 Click on the Print or the Reports & export option. 

 Choose Document System. 

If you chose to export it, you will also be asked to assign it a name. 

The printout of the “Document System” looks like this: 

Documents 
 New York 
  Teresa 
  Joanna 
  Jon 
  Kim 
  Milly 
  Mary 
  George 
  Vincent 
 Indiana 
  Jack 
  Kelly 
  Grace 
 Websites & Literature 
  Suikkanen 2011 
  OECD 2009 
  Spector 1997 
  WorldValuesSurvey 
 Images 
  LifeSatisfaction EU 1973-2010 
Sets 

Printout of the Document System 

What documents are part of the project? When were they imported, and how 

many times were they each coded? 

 Open the Variables drop-down menu 

 Click on the Data editor (document variables) option. 

 A variable table appears with each document making up a row. To choose which col-

umns you want to display, right-click on a column header, choose Select fields, and 

check the box next to the columns you want. 

The documentation table then looks like this: 
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Information about each document in the variable table 

You can sort this table by any column, and sections of the table can be highlighted, copied 

to the Windows clipboard, and pasted in other programs, like Microsoft Word. If you 

choose to Reports & export the table in HTML or XLS/X format, a table will be created and 

opened in the appropriate program (an internet browser for HTML files, Excel for XLS/X 

files), which you can then print out if you wish. 

 

Information about each document in the variable table exported in HTML format 

Documentation of Documents in a Certain Document Group: When were the doc-

uments imported and how many times were they coded? 

 Right-click on the document group in the “Document System.” 

 Choose Overview of variables from the context menu. 

 The variable matrix appears with each document of that document group represented 

in a row. If you want to limit which columns are included in the matrix, right-click on a 

column header, choose Select fields, and check the box next to the columns you want. 

This documentation form is set up similar to the one shown in the screenshot above. 

You can sort this table by any column, and sections of the table can be highlighted, copied 

to the Windows clipboard, and pasted in other programs, like Microsoft Word. If you 

choose to Reports & export the table in HTML or XLS/X format, a table will be created and 

opened in the appropriate program (an internet browser for HTML files, Excel for XLS/X 

files), which you can then print out if you wish. 
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Documentation for a Single Document: When was it imported, and how many 

times was it coded? 

 Right-click on the document in the “Document System.” 

 Choose Overview of variables from the context menu. 

 The variable matrix appears with only one row, representing the single document. If you 

want to limit which columns are included in the matrix, right-click on a column header, 

choose Select fields, and check the box next to the columns you want. 

This form of documentation looks exactly like the one for a document group, except that it 

is limited to one row. 

What codes and subcodes are in the project? 

 Open the Project drop-down menu 

 Click on the Print or the Reports & export option. 

 Choose Code System. 

If you chose to export it, you will also be asked to assign it a name. 

The printout of the “Code System” looks like this: 

Code System [307] 
 placement program [2] 

 Insurance [1] 
 analyst [1] 
 satisfaction [0] 

 Challenges [0] 
  Life Strategy [0] 
  Self Growth [0] 
  Pivotal Moments [1] 

 Day-to-Day Issues [2] 
  Emotions [25] 
  Education [19] 

  Interests [15] 
  Hunches [0] 
  Money and Financial Issues [6] 

  Damn [0] 
  Religion and Spirituality [7] 
  Significantly Positive [29] 
 Interview Guide Topics [0] 

  Health [16] 
   Damn I wish I looked like that [2] 
  Overall [8] 

  Recreation [14] 
  Home Life [12] 
  Relationships [25] 

  Work Issues [13] 
 Key Quotes [26] 
 People [17] 
  Friends [21] 

  Parents [18] 

  Partner [20] 
  Siblings [7] 

Sets [0] 

Printout of the Code System 
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If you want to view the codes exactly as they are seen in the “Code System,” you can make 

a screenshot of it when MAXQDA is open. To do this, it makes sense to maximize the 

“Code System” window, so you can see more of the codes at one time. When you have 

the codes looking like you want them, press the PrntScrn button on your keyboard. This 

will save a picture of the screen to the Windows clipboard. You can then open an image 

editing software and paste it in as a new file or paste it into a Word file. 

Which codes are used in each document? 

You can call up a table with an overview of your coded segments for a document as fol-

lows: 

 Right-click on the document in the “Document System.” 

 Select Overview of coded segments from the context menu. 

 A table with all of the coded segments for that document will appear. You can sort this 

however you wish and choose which columns are to be included. 

 

The “Overview of coded segments” for a specific document 

Sections of the table can be highlighted, copied to the Windows clipboard, and pasted in 

other programs, like Microsoft Word. If you choose to export the table in HTML or XLS/X 

format, a table will be created and opened in the appropriate program (an internet browser 

for HTML files, Excel for XLS/X files), which you can then print out if you wish. 

Another option is to use MAXMaps. If you open a new map, you can simply drag the doc-

ument into it, right-click on it, and choose to Import activated codes. Obviously, it is nec-

essary to activate those codes ahead of time in the “Code System” that you want to be 

included. 

Which codes are attached to which segments in a certain document? 

A good overview of this is offered by the Codeline visualization, which shows the use of 

each code in the document by paragraph. You can then view any of the visualized coded 

segments in the “Document Browser” by double-clicking on any of the colored bars. 
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You can also see which codes are assigned to which sections of your document by viewing 

that document in the “Document Browser.” As you scroll through the document, you will 

see the coding stripes just to the left of the text or image. To see exactly where the coded 

segments start and end, simply click on the coding stripe; the coded segment will then be 

highlighted for you. 

Many users will want to have all of this documented on paper, though, which can be ac-

quired as follows: 

1. Open the document in the “Document Browser” by double-clicking on it in the “Docu-

ment System.” 

2. Then select Print > Displayed document from the Project drop-down menu. 

You will then be given the choices whether you want to visualize the coding stripes and 

memos in the printout. Normally, you will indeed want to do this. If you have Adobe Acro-

bat installed on your computer, you can also choose to print the document as a PDF, which 

will then keep your formatting as you see it in the “Document Browser.” The results look 

like this: 

 

Printout of the document in the “Document Browser” 

Which document segments has a particular code been assigned to? 

To see an overview table of the coded segment for a particular code, follow these steps: 

1. Right-click on the code or subcode in the “Code System.” 

2. Select Overview of coded segments from the context menu that appears. 
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3. A table overview of the coded segments for that code will appear. Clicking on any of the 

rows of the table at the bottom will bring up a preview of the coded segment in the top 

window. You can sort the table according to any of the column values and hide the col-

umns you don’t need. You could then, for example, sort the table according to docu-

ment or weight score. 

If you do the above procedure for a code that has subcodes, the document seg-

ments coded with one of the subcodes will also appear in the table. 

You have the option to export the table in various formats: 

 As an Excel table in XLS/X format. 

 In TXT tab-delimited format. 

 In HTML table format. 

 You can also simply highlight all or sections of the table, copy it to the Windows clip-

board with Ctrl+C, and paste it into another program (e.g. Microsoft Word). 

What memos are in the project? 

The Memo Manager offers all of this information. 

1. Select Memo Manager from the Memos drop-down menu. 

2. A table appears with each memo in a row. 

3. You can hide those columns that you don’t need and sort the table according to any of 

the column values (e.g. my memo type, document, etc.). 

 

Symbol for the Memo Manager in the “MAXQDA standard” toolbar 

You have the option of exporting this table in the following formats: 

 As an Excel table in XLS/X format. 

 In TXT tab delimited format 

 In HTML table format. 

 You can also simply highlight all or sections of the table, copy it to the Windows clip-

board with Ctrl+C, and paste it into another program (e.g. Microsoft Word). 

Which memos exist in a document or document group? 

1. Right-click on the document or document group. 

2. Select Overview of memos from the context menu that appears. 

3. A table overview of the memos for that document or document group will appear. Click-

ing on any of the rows of the table at the bottom will bring up a preview of the coded 
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segment in the top window. You can sort the table according to any of the column val-

ues and hide the columns you don’t need. 

You can also export this table: 

 As an Excel table in XLS/X format. 

 In TXT tab delimited format 

 In HTML table format. 

 You can also simply highlight all or sections of the table, copy it to the Windows clip-

board with Ctrl+C, and paste it into another program (e.g. Microsoft Word). 

Which memos are linked to a certain code? 

 Right-click on a code in the “Code System.” 

 Select Overview of linked memos from the context menu that appears. 

 A table overview of the memos for that code will appear. Clicking on any of the rows of 

the table at the bottom will bring up a preview of the coded segment in the top win-

dow. You can sort the table according to any of the column values and hide the col-

umns you don’t need. 
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25 Import/Export Options  

25.1 Overview of Import and Export Options 

MAXQDA offers a variety of options for exporting data to other software programs like 

SPSS or Microsoft Office programs. The following table gives an overview of the different 

options. 

Data Type Option in MAXQDA Format 

Single document Project > Reports & export > 

Document Browser 

Or select everything in the “Docu-

ment Browser” with Ctrl+A and 

copy it to the Windows clipboard. 

RTF, XLS/X for tables, 

PDF for PDF files and 

original image formats 

for images 

Highlighted document 

segment 

Highlight and copy the selection 

with Ctrl+C or by selecting Copy 

from the Edit drop-down menu. 

Windows clipboard 

One or more coded seg-

ments 

Highlight the segments by clicking 

on them while holding the Ctrl but-

ton and choose the export option 

or copy with Ctrl+C 

XLS/X, HTML, RTF, Win-

dows clipboard 

All coded segments in the 

“Retrieved Segments” 

window 

Project > Reports & export > Re-

trieved Segments or from the 

“Retrieved Segments” window, hit 

Ctrl+A to highlight all of them and 

Ctrl+C to copy them to the Win-

dows clipboard 

 XLS/X, HTML, RTF, 

Windows clipboard 

Coded segments for a sin-

gle document (teamwork) 

Right-click on the document and 

select Export teamwork 

.MEX (internal format) 

Memos Export in Memo Manager RTF, XLS/X, HTML 

Memos for a particular 

document (for teamwork 

export) 

Right-click on the document and 

select Export teamwork 

.MEX (internal format) 

Memos for a particular 

document 

Right-click on the document and 

select Overview of memos 

RTF, XLS/X, HTML 

Text of a memo Copy to Windows clipboard with 

Ctrl+C 

Windows clipboard 
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List of variables Variables > List of document var-

iables or code variables and then 

click on the icon in the toolbar for 

HTML or XLS/X table 

.HTML, XLS/X 

Variable table (export) Variables > Export data (docu-

ment variables) or (code varia-

bles) or click on the Export icon in 

the “Data editor” 

.TXT (tab-delimited), 

HTML, XLS/X 

Variable table (import) Variables > Import data (docu-

ment variables) or (code varia-

bles) 

XLS/X or TXT (tab-

delimited) 

Variables and variable val-

ues for a document 

(teamwork) 

Right-click on the document and 

select Export teamwork 

.MEX (internal format) 

Export variable values for a 

document 

Right-click on a document, select 

Overview of variables, and click 

on the Export icons in the toolbar 

TXT (tab-delimited), 

HTML, XLS/X 

Code frequencies table Codes > Overview of coded 

segments and click the Export 

icon 

or 

highlight the cells of the table that 

you want to copy and hit Ctrl+C to 

copy them to the Windows clip-

board  

TXT (tab-delimited), 

HTML, XLS/X or Win-

dows clipboard 

Code frequencies Project > Reports & export > Ma-

trix of code frequencies 

TXT (tab-delimited), 

HTML, XLS/X 

25.2 Exporting the “Overview of coded segments” 

You might also want to export the “Overview of coded segments,” so it can be analyzed in 

other data analysis programs. Unfortunately, there has been very little standardization of 

file formats in data analysis programs, which makes it very difficult to exchange files. This 

matrix, however, includes all the information you would need to move your coded seg-

ments to another software. All that is required, then, is a form of import on the part of the 

other software developer. 

The table can be called up by selecting Overview of coded segments from the Codes 

drop-down menu. It looks like this: 
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“Overview of coded segments” 

The table contains a row for each of the coded segments, so the size of the table depends 

on how much coding has been done in the project. 

Below is an overview of the various columns in the table: 

Document Contains the document name (formatted: document-

group\document name) 

Code Contains the code or subcode (formatted: 

code\subcode) 

Begin The paragraph number where the coded segment 

begins  

End The paragraph number where the coded segment 

ends 

Weight score Weight score value 

Preview The first few lines of the coded segment 

Comment Comments written in by the user 

To start the export, click on the appropriate icons in the toolbar: 

  Show as Excel table – opens a table in XLS/X format with the coded segments 

  Show as HTML table – opens a table in HTML format with the coded segments 

  Export – allows for export of the coded segments in RTF, HTML, or XLS/X format. 

This matrix can be statistically analyzed in various ways. The options range from simply fre-

quency analyses to sequence analysis. It is also possible to aggregate the data on the case 

(document) level and then analyze, for example, correlations between codes. 
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25.3 Importing Projects from Earlier Versions (MAXQDA 10 or 

older)  

Since many new functions such as the Grid Tables & summaries and user managment have 

been implemented in MAXQDA 11, a new file format has been created, which can be iden-

tified by the file extension MX5. 

Projects created in earlier versions can be opened in MAXQDA 11 without any problem. 

MX5 projects can also be saved in the MX4 format for MAXQDA 10. 

Import projects from previous versions of MAXQDA 

To open a project created in MAXQDA 1, MAXQDA 2, MAXQDA 2007 or MAXQDA 2010, 

launch MAXQDA and select Open project. A dialog window will appear, from which you 

can select the file type which corresponds to your project. 

 

Import projects from previous versions into MAXQDA 11 

When you click on Open, the project will be automatically converted into the new format 

and saved as an MX5 file. The old file format will remain in place. 
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25.4 Saving MX5 Projects as MX4 Projects  

MAXQDA 11 projects cannot be opened directly in any previous version. However, they can 

be saved as MAXQDA 10 projects. To do so, select Project > Backup project. In the dialog 

window that appears, select the file type MAXQDA 10 projects (*.mx4). 

 

Save MX5 projects as MX4 projects for MAXQDA 10 

Note: When you convert the file to MX4 format, new functions such as table documents, 

summaries etc. will not be supported. The new functions will nevertheless remain in the 

project file, meaning that they will once again be available if the MX4 file is converted back 

to MX5 format. 

25.5 Importing Projects from MAXApp 

In the main toolbar, you will find the option to Import MAXapp Projects. With this function, 

you can import documents that you created with MAXApp on your mobile device into the 

currently opened MAXQDA project. The documents will be imported into a new document 

group with their document memos, coded text segments precoded with emoticodes, and 

geographical references where it applies. 
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Export project from MAXApp 

 

Exporting projects from MAXApp 

Select the project you want to export and touch the Dropbox icon at the bottom of the 

screen to call up your Dropbox (if you don't have a Dropbox, get one at 

www.dropbox.com). Log in with your Dropbox user name and password and when asked, 

allow MAXApp to copy files into your Dropbox. Once the MAXApp Export Screen comes 

up, hit "Start" and all of the documents of your project will be exported to your Dropbox. 

Import Project into MAXQDA 11 

 

MAXApp project import icon 

In the main toolbar, click on the Import MAXApp Project button and navigate to your 

main Dropbox folder on your computer. In your Dropbox folder you can find your project in 

“Dropbox\Apps\MAXQDA.” Open the folder that is named like the project you just ex-

ported, click on the XML file inside that folder and choose Open. 

The documents will be imported into your project and placed in a new document group 

that is named exactly like your MAXApp project. 

http://www.dropbox.com/
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25.6 Importing ATLAS.ti Projects  

Since version 10, MAXQDA has allowed for the import of ATLAS.ti version 6 projects. 

Step 1: Export the complete ATLAS.ti project in XML format. To do so, select Extras > Ex-

port to > XML in ATLAS.ti 6. 

 

In the export options, select Include Primary Documents and Quotations (meta info 

only). 

 

Select File as output medium. 

 

Choose the folder that contains the HPR6 file as the location for the XML file. 
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Step 2: Import the XML data into MAXQDA. Open MAXQDA and selecte Open existing 

project > Other projects … and click OK. If MAXQDA is already opened, you can alterna-

tively choose Project > Open project. 

 

Select data type Atlas.ti Project (*.xml), then go to the folder containing the saved XML 

file. 

 

Select the XML file and click OK. MAXQDA will create a new project in the same directory 

and begin the import process (this may take several minutes to complete.) MAXQDA will 

transfer the documents, codes, codings and memos of the imported project. 

Please wait until MAXQDA displays a message stating that the import is complete. 

Note: If you want to import Atlas.ti 7 projects it may work if you have integrated the 

documents as linked documents. 

The import procedure will only integrate text documents into the MAXQDA project. PDF 

files, pictures and audio/video files will be ignored. 
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25.7 Importing NVivo Projects  

Since version 10, MAXQDA has allowed for the import of NVivo projects (versions 8 and 9). 

Requirements 

 MS Word and MS SQL-Server 2008 must be installed (SQL-Server 2008 is installed with 

the NVivo 9 trial version and can be used with no time limit). For the import of NVivo 8 

projects only the SQL Server 2005 that is installed with NVivo 8 is required. 

 You must have administrator rights on your computer. 

 There must be sufficient space in the directory containing the NVivo file to import. Dur-

ing the import process, MAXQDA will create several temporary files which will be delet-

ed after the import. 

Import Process 

Open MAXQDA and select Open existing project > Other projects, then click OK. If 

MAXQDA is already open, you can alternatively choose Project > Open project. 

 

Choose the data type NVivo Project (*.nvp) and go to the folder which contains the file to 

import. 
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After selecting the NVP file and clicking OK, MAXQDA creates a new project in the same 

directory and begins the import process (This may take a few minutes to complete.) 

MAXQDA transfers the document groups, documents, codes and codings as well as memos 

of the imported project. The code colors will also be imported. 

Please wait until MAXQDA displays a message stating that the import process is complete. 

Troubleshooting 

 If the NVivo project cannot be opened from the SQL-Server, a message will appear.  

Please copy the NVivo project onto a USB flash drive and try again. The USB flash drive 

should be FAT 32 formatted, the process doesn’t work with an external hard drive. 

 If you try to import an NVivo 9 project, but only SQL-Server 2005 is installed, a message 

will appear.  Please install MS SQL-Server 2008. 

 If MS Word is not installed, a message will appear stating that it is not possible to read 

RTF data.  Please install MS Word. 

 Please check, that the NVivo file hasn’t been renamed after closing in NVivo. 

Note: teaThe import procedure will only integrate text documents into the MAXQDA pro-

ject. PDF files, pictures and audio/video files will be ignored. 
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26 Special Features and General Options 

26.1 The Logbook  

The logbook is a feature in MAXQDA that lets your write a sort of journal to keep track of 

your analysis work. The term “logbook” is usually used in connection with ocean naviga-

tion, which was used to record meaningful happenings and observations, and it can be 

used in a similar way for your project. The logbook is set up to have the newest entries at 

the top. 

You can open the Logbook from the Memos drop-down menu and choosing Logbook or 

by using the shortcut Alt+Q. 

 

Calling up the logbook 

The logbook window is a simple RTF window with a toolbar, which is fairly self-explanatory, 

and lets you format the text as you want. You can, for example, edit the font style and size; 

use bold, underline, and italics; and change the text color. The icons on the far left let you 

create a new entry and print or export the logbook. 

 

Logbook 
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To create a new entry, click on the New logbook entry  button on the far left of the 

toolbar. This automatically inserts a date and time stamp at the top of the page, and you 

can enter your text directly below it. 

26.2 Checking for Updates 

You can check for free updates to MAXQDA at any time by selecting Search for updates 

from the ? drop-down menu. The program will then check to see if there is a version online 

that is more recent than the one installed on your computer. If there is a newer version, you 

will be asked if you want to download it. These updates include improvements and new 

features, and since it takes very little time to download the update, it is worth doing. 

MAXQDA will then restart automatically. 

26.3 General Options  

You will find the Options in the MAXQDA Project drop-down menu. The window that 

appears lets you view and edit your options. Some changes that you make might require a 

restart of MAXQDA. 
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Options window 

The following settings can be changed: 

”General” settings 

Confirm deletions  

The default setting is to require a confirmation for any deletions you make in your 

MAXQDA project. This can be important, since deletions cannot be undone. If you delete a 

document group, for example, you are permanently deleting all of the documents, coded 

segments, memos, etc. that are connected to it. It is therefore recommended that you leave 

this option checked. 

No duplicate code names 

If this option is checked, you will not be able to create more than one code in the “Code 

System” with the same name. This also applies to subcodes. In some cases, you will want to 
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allow for duplications (e.g. if you have the main codes “Theory” and “Praxis,” and want to 

have “Political” and “Economic” as subcodes for each of them). 

Do not display code frequencies in Code System 

The default setting is for MAXQDA to list the number of times each code has been used. 

You will see this number just to the right of each code name in the “Code System.” If you 

do not want or need this, you have the option of hiding these numbers by checking this 

box. 

Include subcodes in matrix of code frequencies 

You can create a matrix of code frequencies in the Project drop-down menu, by choosing 

Reports & export > Matrix of code frequencies. This matrix shows the number of times 

each code or subcode was used in the project and can easily be imported for statistical 

analysis in programs like SPSS. You can calculate correlations between codes or do factor or 

cluster analysis. 

If you activate this option, the codes will all be aggregated to the top level. In other words, 

the frequency for the parent code “Theory” would include the frequencies of the subcodes 

“Political” and “Economic.” 

Import objects in texts (e.g. images and OLE-objects) 

Graphics, especially photos, can be very large and take up a lot of memory. For this reason, 

you have the option in MAXQDA to link to graphics rather than import them as part of the 

MX4 project file. If you actually want these graphics to be part of the project file, you can 

click this option. It is important that you be careful not to let the project file get too big, 

though. 

Activate codes together with subcodes 

If this option is checked, subcodes will automatically be activated when their parent code is 

activated. This also applies then for deactivations. 

Default weight 

The default weight score for newly-created coded segments is 100, but can be changed 

here. 

Max. number of codes in Quick List 

This setting determines the maximum number of codes that can be added to the Quick List, 

which is found in the “Code” toolbar. The default is 20. 

Backup externals 

Here you can set the location for all of your externally-linked files to be stored. These in-

clude audio and video files, for example, that are too big to be included in the project file. 
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Image and PDF files might also be stored here, depending on their size and your settings 

(see below). 

Sum up subcodes in the Code System 

When this option is turned on, code and subcode frequencies of all compressed codes will 

be automatically counted and displayed in the “Code System.” If this option is turned off, 

the displayed code always corresponds to the number of segments that have been encoded 

using this code. Frequencies of compressed subcodes will not be counted. 

”User interface” settings 

Large font (restart of MAXQDA required) 

The size of the text in the “Document Browser” can be adjusted as you wish, but you can’t 

control the exact text size in MAXQDA menus and toolbars. With this option, though, you 

can switch all of these user interface texts to a larger size. MAXQDA will need to restart. 

Reset user settings (restart of MAXQDA required) 

This is an emergency option of sorts that you can use if you have somehow altered your 

settings in a way that makes MAXQDA unusable and can’t figure out how to undo these 

settings. If you check this box, MAXQDA will need to restart, and all of your settings will 

then be reset. 

”Update program automatically” settings 

Search for updates 

The default setting is for MAXQDA to automatically search for updates. If you don’t want 

this to happen, you can uncheck this box. 

Time interval [days] 

This sets the number of days the program should wait between checks for updates. The 

default is 30 days. 

”PDF and image documents” settings 

Do not embed if larger than [MB] 

Images and PDF files can take up a lot of room in your project file. For this reason, you can 

set a maximum size for these types of documents. If the files are larger than the given size, 

they will be linked to instead of imported. The default maximum is 5 MB. 
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”Export” settings 

Apply variable names “Textgroup” and “Textname” 

The default is to use the terms “textgroup” and “textname” as variable names. Otherwise 

they would be switched to “documentgroup” and “documentname,” which can make it 

more difficult to import tables into programs like SPSS and especially SYSTAT. 

Excel Format 

You can set here whether you want to export Excel files in XLS or XLSX format. 

”Automatic project backups” settings 

If this option is turned on, projects will be saved in the Project backup file path after Time 

interval [days]. 
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27 Keyboard Shortcuts  

The following keyboard shortcuts are available in MAXQDA. 

General 

F1 Opens the MAXQDA help system. 

Ctrl+A Highlights the entire text. 

Ctrl+C Copies the selected text to the Windows clipboard. 

Ctrl+X Cuts out the selected text and puts it in the Windows clipboard. 

Ctrl+V Pastes the selection from the Windows clipboard. 

Alt+Q Opens the logbook. 

Ctrl+B Opens the Code Matrix Browser. 

Ctrl+O Opens the Code Relations Browser 

Ctrl+1 Opens and focuses on the “Document System.” 

Ctrl+2 Opens and focuses on the “Code System.” 

Ctrl+3 Opens and focuses on the “Document Browser.” 

Ctrl+4 Opens and focuses on the “Retrieved Segments” window. 

Ctrl+5, 

Ctrl+Shift+5 

Focuses on the next/previous window. 

Ctrl+F Opens the context search for the current window. 

Ctrl+Shift+F Opens the color filter for the current window. 

Alt+double-click Inserts a MAXQDA object (e.g. a document or code) into MAX-

Maps, if MAXMaps is open. 

“Document System”   

Double-click Opens a document. 

Shift+double-click Opens a document in a new tab. 

Ctrl+click Activates or deactivates a document. 

F2 Opens a field for renaming a document. 

Drag & Drop, 

Shift+UpArrow 

Shift+DownArrow 

Moves a document or document group to a different place or up 

and down in the “Document System.” 

Ctrl+Drag & Drop Creates a copy of the document. 

Ctrl+T Creates a new document and opens it for editing in the “Docu-
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ment Browser.” 

Ctrl+Shift+T Opens the dialog window for importing a document at the top of 

the “Document System.” 

Alt+T Opens the dialog window for importing a document into the se-

lected document group. 

Ctrl+M Creates a memo for a document. 

“Code System”  

F2 Opens a field for renaming the code. 

Drag & Drop, 

Alt+UpArrow, 

Alt+DownArrow 

Makes a code into a subcode of another code. 

Shift+Drag & Drop, 

Shift+UpArrow, 

Shift+DownArrow 

Moves a code without it changing levels or becoming a subcode. 

Ctrl+Drag & Drop Creates a copy of a code. 

Ctrl+Click Activates or deactivates a code. 

Alt+N Creates a new code on the activated level. 

Ctrl+Shift+B Opens the code browser. 

“Document Browser”   

Ctrl+Shift+E Toggles Edit Mode. 

Alt+L Codes the selected segment with the most recently-used code. 

Ctrl+W Opens the dialog window for creating a new code, which will be 

used to code the selected segment. 

Ctrl+Q Codes the selected segment with the code shown in the Quick 

List. 

Ctrl+I Codes the selected segment with a newly-created code named 

after the first 32 characters of the selected segment (in-vivo cod-

ing). 

Ctrl+L Inserts an internal link at the location of the selected segment. The 

location it is linked to is set by highlighting another segment in 

that document or another one in the project and hitting Ctrl+L 

again. 

PgUp, 

PgDn, 

Alt+mousewheel 

Move to the next/previous page of a PDF document. 
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Pos1, 

End 

Moves to the first/last page of a PDF document. 

Ctrl+Mousewheel, 

Ctrl+Plus, 

Ctrl+Minus 

Zooms in or out of the document. 

Ctrl+Tab, 

Ctrl+Shift+Tab 

Jumps to the next/previous tab. 

Ctrl+F4 Closes the tab. 

Retrieved Segments Window  

Ctrl+Shift+L Opens the “Overview of coded segments.” 

“Media player” Toolbar  

Ctrl+P Activates/deactivates media player. 

F3 Inserts a time stamp. 

F4 Plays or pauses the media file. 

F5 Jumps to previous time stamp. 

F6 Jumps to next time stamp. 

List of Timestamps 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

“Overview of variables” – “Data editor” 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+O Switches to variable view. 

“Overview of variables” – Variable View  

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+O Switches to “Data editor” view. 

Ctrl+N Creates a new variable. 

Del Deletes a variable. 

Ctrl+B Transforms a variable into a binary variable. 
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Ctrl+S Transforms a variable into a string variable. 

“Overview of coded segments”   

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+Q Opens the autocode window. 

“Overview of memos”  

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+N Creates a new free memo. 

“Overview of links” 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Lexical Search – Search Results 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+Q Opens the autocode window. 

Ctrl+P Opens the options window. 

Intercoder Code-Specific Results Table 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

MAXDictio Dictionary 

Ctrl+T Changes the category system view. 

Tab Changes the entry field between the category system and the 

word table. 

Ctrl+O Opens the dialog window for opening a dictionary. 

Ctrl+I Opens the dialog window for adding a dictionary. 

Ctrl+S Opens the dialog window for saving a dictionary. 

Ctrl+E Opens the dialog window for exporting a dictionary. 

Ctrl+N Creates a new category or search term. 



Keyboard Shortcuts 

 

351 

Del Deletes a category or search term. 

Ctrl+Alt+N Deletes all categories and their contents. 

MAXDictio Word Frequencies 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

MAXDictio Coder 

Ctrl+H Opens the table in HTML format in the standard internet browser. 

Ctrl+E Opens the dialog window for exporting the table. 

Ctrl+Shift+R Transforms the selected entries into variables. 

Ctrl+R Shows the search results. 
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28 Quick Troubleshooting Tips  

If the results of a retrieval don’t match your expectations, the first thing you should always 

do is reset the retrieval functions by clicking the appropriate icon in the “MAXQDA stan-

dard” toolbar. 

 

Icon for resetting the retrieval functions 

This function takes you back to the standard OR retrieval settings, removes any weight fil-

ters, and undoes all activations in the “Document System” and “Code System.” If you are 

still having problems after resetting and starting again, go to the menu entry Project > Op-

tions drop-down menu and check the box next to Reset user settings. You will then be 

prompted to restart MAXQDA, which will have all of its original settings after the restart. 

A selection of other quickly-remedied problems is listed in the following table: 

Problem Solution 

DOC/X documents can't be im-

ported. 

A Microsoft Office Installation for Windows 2003 or later 

is needed for this function. Please save your file as a RTF 

file and import it again. 

A document can’t be imported. Are you sure that it is not open in another program? 

Open it in your word processor, save it as an RTF file, 

close it, and try importing it into MAXQDA again. 

Your imported document isn't 

shown. 

To view the document, you need to double-click on it in 

the “Document System.” It will then appear in the 

“Document Browser.” 

You want to import a document 

into a document group, but 

MAXQDA says that the docu-

ment can’t be imported. 

It could be that the document is still being used by an-

other program (e.g. Word). Make sure to close the doc-

ument in these other programs and then try again. 

 

Your documents aren’t shown 

in the “Document System.” 

It could be that you’ve chosen to collapse certain docu-

ment groups. Click on the + symbol in front of a docu-

ment group to view the documents in it. 

No segments are shown in the 

“Retrieved Segments” window 

even though you’ve activated 

documents and codes. 

Make sure you haven’t accidentally chosen an advanced 

retrieval function (e.g. Near or Followed by). 

Check to make sure you haven’t accidentally turned on a 

weight filter. 

Both of these things can be checked in the status bar at 

the bottom of the MAXQDA window. 
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Some of your codes aren’t 

shown in the “Code System.” 

It could be that you’ve collapsed certain codes, hiding 

their subcodes. Click on the + symbol to show subcodes 

for a code. 

You accidentally coded a seg-

ment incorrectly. 

Click on the Undo button in the “Code” toolbar. A list 

of recent coding actions will appear, with the most re-

cent action at the top. To undo your most recent coding, 

click on the first string in the list. 

Or: Right-click on the coding stripe and choose Delete. 

Tip: If you aren’t able to solve your problem, don’t hesitate to contact our online support. 

You can contact them at www.maxqda.com/support/onlinesupport. 

http://m22.maxqda.com/support/onlinesupport
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29 Technical Data and Information 

29.1 Limitations and technical information 

MAXQDA sets very few limits.  

Note: Please note that several thousand documents, codes and coded segments may re-

duce performance. The size of a document and the amount of coded segments per docu-

ment may influence the performance, too. 

 

Text length: No set limit, but it isn’t recommended that you im-

port texts larger than 1 MB 

Size of a coded segment: max. 64 KB 

Text formats: RTF, DOC/X, PDF 

Image formats: JPG, GIF, TIF, PNG 

Audio- and video formats Everything that can be played on your computer 

Number of projects: No limit 

Number of document groups: No set limit 

Number of documents: 99,999, but check performance before working with 

more than 1,000 documents 

Number of codes: No set limit, but check performance before working 

with more than 1,000 codes 

Number of coded segments No set limit, but check performance before working 

with more than 10,000 segments 

Code System levels Max. 10 

Strings in MAXQDA: Usually 64 characters 

Numerical data: 10 characters 

Number of variables No set limit, but more than 250 is not recommended 

29.2 File Management 

The MAXQDA program file (maxqda.exe) is found in the “MAXQDA11” folder after it has 

been installed, unless you changed the name of the installation folder. 

MAXQDA creates the following file types: 
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MAXQDA.INI  Configuration file 

.MX5 MAXQDA 11 project file 

.MX4 MAXQDA 10 project file 

.MX3 MAXQDA 2007 project file 

.MX2 MAXQDA 2 project file 

.M2K MAXQDA 1 project file 

.LOA Saved formula files (Logical Activation) 

.SEA Saved search files (SEArch file) 

.MEX Teamwork export file (MAX EXport) 

.TXT Exported table file 

.RTF Exported texts, coded segments, and memos 

.MTR Exported “Code System” 

29.3 System Requirements 

 Operating System: Microsoft Windows XP, Vista, 7, 8  

(in Windows XP you need .NET Framework 3.5 to run MAXQDA 11) 

 Processor: 1,5 GHz, recommended: 2 GHz or more with 2 cores or more 

 RAM: 1 GB RAM, recommended: 2 GB or more 

 Monitor: 1.024 x 600, recommended: 1.280 x 800 or more 

Note: If you are working with challenging projects and/or large media files adequate com-

puter hardware is recommended. This also applies for newer operating systems or for the 

use of virtual machines on a MAC. 

For some features of MAXQDA Microsoft Word 2003 has to be installed on the computer 

(Import of DOC/X files, Smart Publisher Export). 


